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1 Overview

Overview of the Server Automation Platform

The Server Automation Platform is a set of APIs and a runtime environment that facilitate
the integration and extension of SA. The Server Automation Platform APIs expose core
services such as audit compliance, Windows patch management, and OS provisioning. The
runtime environment executes Global Shell scripts that can access the Global File System
(OGFS).

Using the Server Automation Platform, you can perform the following tasks:

Build new automation applications and extend SA to improve IT productivity and comply
with your IT policies.

Exchange information with other IT systems, such as existing monitoring, trouble
ticketing, billing, and virtualization technology.

Use the SA Model Repository to store and organize critical IT information about
operations, environment, and assets.

Automate the management of a wide range of applications and operating systems.

Incorporate existing Unix and Windows scripts with SA, enabling the scripts to run in a
secure, audited environment.

Components of the Server Automation Platform

Figure 1 shows the major elements of the Server Automation Platform.
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Figure1l Server Automation Platform Components
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As Figure 1 shows, the platform comprises the following five key elements. Each of these
elements is discussed in more detail in subsequent sections.

e Automation Applications: The applications users write on top of the platform. These
applications can either be SA-Hosted Applications which run in the context of the running
SA or standalone applications running in the context of existing business and
management systems.

¢ Runtime Environment: Provides a set of powerful, out of the box runtime services and
a corresponding language independent programming model explicitly designed to be
easily accessibility to a broad spectrum of programmers, from script writers to Web
developers to experienced enterprise Java programmers.

e Platform Resources: Provide developers easy access to the platform’s rich data objects,
automation actions (such as patching, provisioning, and auditing), and capabilities (such
as remote access to each managed server’s runtime environment).

e SA Management Network: A powerful set of connectivity, security, and caching
technologies which enable the platform to reach any device regardless of its location, IP
address space, bandwidth availability, and so on.

e SA Managed Devices: The managed servers and network devices connected to the
platform by the SA Management Network.
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Automation Applications

As Figure 1 shows, the Automation Applications are at the top of the stack. These are the
applications users write on top of the platform.

Automation applications can either be SA-Hosted Applications, which run in the SA Runtime
Environment, or as standalone applications that run in a completely independent context.
Standalone applications access the platform remotely through Web Services calls.

Simple applications can be written as simple Unix shell scripts in minutes. More complex
applications—such as integration with an existing source control or ticketing system—can
take a little longer and might involve Python or Microsoft .NET or Java coding. In either case,
the platform is designed as a language-independent system easily adopted by a wide variety
of developers.

SA Runtime Environment

Overview

Next down the platform stack is the SA Runtime Environment, which provides a set of
powerful, out-of-the box runtime services and a corresponding language-independent
programming model. SA-Hosted Applications run in the SA Runtime Environment.

The core of the runtime environment consists of two components: the Global Shell and the
Global File System. Together, these two components organize and provide access to all
managed devices in a familiar Linux/Unix shell file-and-directory paradigm.

Global Shell

The Global Shell is a command-line interface to the Global File System (OGFS). The
command-line interface is exposed through a Linux shell such as bash that runs in a terminal
window. The OGFS unifies the SA data model and the contents of managed servers—
including files—into a single, virtual file system.

Global File System

The OGFS represents objects in the platform data model (such as facilities, customers, and
device groups) and information available on platform managed devices (such as the
configuration setting on a managed network device or the file system of a managed server) as
a hierarchical structure of file directories and text files. For example, in the OGF'S, the /opsw/
Customer directory contains details about customer objects and the /opsw/Server directory
has information about managed servers. The /opsw/Server directory also contains
subdirectories that reflect the contents (such as file systems and registries) of the managed
servers.

This file-and-directory paradigm allows administrators familiar with shell scripting to easily
write scripts which perform the same task across different servers by iterating through the
directories that represent servers. Behind the scenes, the Global File System securely delivers
and executes any logic in the script to each managed server.

The contents of devices can be accessed through the Global File System, a virtual file system
that represents all devices managed by SA and Network Automation (NA). Given the
necessary security authorizations, both end users and automation applications can navigate
through the OGF'S to the file systems of remote servers. On Windows servers, administrators
can also access the registry, II metabase, and COM+ objects.
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SA Command Line Interface

The Command Line Interface (OCLI) provides system administrators and platform
automation applications a way to invoke automation tasks such as provisioning software,
patching devices, or running audits from the command line. A rich syntax allows users to
represent rich object types as input or receive them as output from OCLI invocations.

The OCLI itself is actually programmatically generated on top of the platform API, discussed
in the next section. The advantage of this is that as soon as developers add a new API to the
platform API, a corresponding OCLI method is automatically available for it. In other words,
there is no lag time between the availability of new features in the product and the
availability of the corresponding OCLI methods in the platform.

SA Platform API

The SA Platform API is the Win32 API of SA: It defines a set of application programming
interfaces to get and set values as well as perform actions. The SA user interfaces, including
the SA Client and the Command Line Interfaces (OCLI), are all built on top of the SA
Platform API. The API includes libraries for Java RMI clients and WSDLs for SOAP-based
Web Services clients. With Web Services support, programmers can create clients in popular
languages such as Perl, C#, and Python.

SA Platform Resources

SA Platform Resources sit beneath the SA Runtime Environment and give developers access
to a rich set of objects and actions which they can re-use and manipulate in their own
applications.

Inventory Model

The Inventory Model provides all the information gathered by the SA about each managed
devices such as make, manufacturer, CPU, operating system, installed software, and so on.
Inventory information is made available through the SA API and also appears as files (in the
attr subdirectories) in the Global File System. The Inventory Model includes objects such as
Servers and Network Devices.

Administrators can extend the data associated with inventory objects. For example, if users
want to store a picture of the device or a lease expiration date or the ID of a UPS the device is
plugged into, the platform makes it easy to add those attributes to each device record. Users
can then add, delete, and work with those attributes just as they would the attributes that
come out of the box.

Security Model

The Security Model allows developers to leverage the built-in SA authentication and
authorization security systems.

All clients of the platform—management applications, scripts, as well as the end-user
interfaces provided by SA are controlled by the same security framework.

The security administrator — not the developer — creates user roles and grants permissions.
Developers can re-use all of these user roles and permissions in the context of their own
applications. For example, network administrators can write a shell script and share it with
other network administrators with the confidence that those network administrators can only
run that script on network devices they are authorized to manage and no others.
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Overview

The authorization mechanism controls access at several levels: the types of tasks users can
perform, the servers and network devices accessed by the tasks, and the SA objects (such as
software policies).

Environment Model

The Environment Model defines the overall business context in which devices live. In general,
devices belong to one or more customers, are located in a particular facility, and belong to one
or more groups. The platform makes each of these objects — Customers Facilities, Device
Groups, and others — available to application developers.

As with inventory objects, environment objects can easily be extended. This makes it easy, for
example, to define attributes such as the SNMP trap receiver used in a particular data center
or printers only available in a particular facility, or Apache configurations used by only a
particular business unit.

Policy Model

The Policy Model gives developers access to all the best practices defined in SA. Policies
describe the desired state on a server or network device. For example, a patch policy describes
the patches that should be on a server, a software policy describes what software should be on
a server, and so on.

Subject matter experts define these policies which can be used by any authorized system
administrator to audit devices to discover whether what’s actually on a device differs from
what should be on the device. Programmers have access to this complete library of policies to
use in their own applications.

Software policies are organized into folders which can define security boundaries. In other
words, applications will be able to access only those software policies they are permitted to
access based on their user permissions.

Package Repository

The Package Repository gives developers access to all the software and patches stored in SA.
These include operating system builds, operating system patches, middleware, agents, and
any other pieces of software that users have uploaded into SA.

Event Repository

The Event Repository houses the digitally signed audit trails that the SA generates when
actions are performed, either through the user interface or programmatically with the
platform. As with other platform objects, these events are available programmatically.

Automation Actions

Automation Actions allow developers to programmatically launch any of the actions that SA
can perform on managed devices, ranging from running an audit to provisioning software to
applying the latest OS patch.

The platform provides access to the same features available to end-users in the SA Client.
These features include tasks such as installing patches, provisioning operating systems, and
installing and removing software policies. In fact, the SA Client calls the same APIs that are
exposed programmatically through the SA Runtime Environment.
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Remote Access

Remote Access gives developers programmatic access to the managed device’s file system (in
the case of servers) and execution environment (in the case of all devices). Developers can
easily write applications which check for the existence of a file or particular software package,
run operating system commands to check disk usage, or run system scripts to perform routine
maintenance tasks.

SA Management Network

The Management Network is a powerful combination of technologies which enable developers
to securely access any device under management. The Management Network delivers several
key services:

e Connectivity: Allows the platform (and thus automation applications) to reach any
managed device.

e Security: Includes SSL/TLS-based encryption, authentication, and message integrity.

e Address space virtualization: Enables the platform to locate servers across multiple
overlapping IP address spaces. Most complex enterprise networks have multiple private
IP address spaces.

e Availability: Allows system architectures to define redundant paths to any given
managed device so that devices can still be reached despite failures in any given network
path.

e Caching: Enables servers to download software and patches from a nearby server rather
than a distant server, saving both time and network connectivity charges.

e Bandwidth throttling: Lets system architectures determine how much bandwidth SA
and any SA applications can consume as it traverses the network to a particular device.

e Least cost routing: Allows system designers to set up rules governing which paths to
use to reach a particular device to minimize network connectivity costs.

SA Managed Devices

At the bottom of the platform stack are the actual devices under management. The platform
manages over 65 server OS versions and over 35 different network device vendors with
thousands of device models/versions supported out of the box.

The list of supported devices is constantly being updated. Platform developers and script
writers benefit directly from this device list since their automation applications can
consistently reach an ever growing list of managed devices in the same, familiar platform
programming environment.
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Benefits of the SA Platform

The SA Platform has the following key benefits.

Powerful Security

The platform delivers the following comprehensive security mechanisms so developers don’t
have to worry about providing them in their own applications.

Secure communication channels: End-to-end communication from the automation
applications out to the managed devices is encrypted and authenticated.

Role-based access control: The platform respects the role-based access controls built
into the SA so developers can easily share their applications with the con.dence that they
will run just on those devices that an administrator has been granted access to.

Digitally signed audit trail: After an automation application runs, the platform
generates a digitally signed audit trail capturing who ran the application, the time of the
application execution, and the devices on which the application ran.

Comprehensive reach The platform provides comprehensive reach across all devices so
system administrators and developers don’t have to worry about how to get to a device:

Market-leading platform coverage: Supported devices include over 65 server OS
versions and more than 1,000 network devices.

In any physical location: The devices can be located anywhere in the world whether in
a major data center or a retail store or a satellite of.ce.

In any IP address space: The devices can belong to any IP address space, as the
platform supports multiple overlapping IP address spaces.

In DMZs: Devices can be located in DMZs or other difficult-to-access network spaces
without requiring the developer or system administrator to worry about the details of
reaching the device (for example, through a bastion host).

Rich Services

Overview

The platform exposes practically all the relevant data and actions in the underlying
automation system:

Rich data out-of-the-box: Developers have easy access to a rich set of data generated in
part by the platform itself (such as device inventory data and facility information) and in
part by users interacting with the platform (such as device groups customers, best
practices policies, and uploaded software, patches, and scripts). Developers can easily
write applications to read and write this data.

Extensible data store: Developers can easily extend the native platform objects to
include their own data. Device inventory models can be extended to include attributes the
platform does not natively discover. Customer and facility objects can be extended to
include attributes that should guide the provisioning or auditing of devices related to that
customer.

Automation tasks: The platform exposes nearly all the capabilities of the underlying
automation systems to developers: patching, provisioning, auditing, and others. This
enables developers writing complex work flows that span multiple systems to simply call
these actions from the context of an automation application.
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Easily Accessible to a Broad Spectrum of Programmers

The platform is explicitly designed to appeal to a broad range of developers ranging from Unix
shell and Visual Basic script writers to Perl and Python programmers to enterprise .NET or
Java programmers. The platform’s Runtime Services layer makes most platform objects
available in a file-and-directory paradigm and most platform services available from a
command-line interface (the OCLI). This allows system administrators used to writing shell
scripts to instantly use the platform without having to learn a new programming language
and tool. They can get started with their favorite text editor, a familiar Unix shell, and then
quickly develop scripts.

For more complicated applications and integration with existing systems, system
programmers can use whatever programming tools and languages that have Web Services
bindings.

SA Platform API Design

The Platform API is defined by Java interfaces and organized into Java packages. To support
a variety of client languages and remote access protocols, the API follows a function-oriented,
call-by-value model.

Services

In the Platform API, a service encapsulates a set of related functions. Each service is specified
by a Java interface with a name ending in Service, such as ServerService, FolderService,
and JobService.

Services are the entry points into the API. To access the API, clients invoke the methods
defined by the server interface. For example, to retrieve a list of software installed on a
managed server, a client invokes the getInstalledSoftware method of the ServerService
interface. Examples of other ServerService methods are checkDuplex,
setPrimaryInterface, and changeCustomer.

The SA Platform API contains over 70 services — too many to describe here. Table 1 lists a few
of the services that you may want to try out first. For a full list of services, in a browser go to
the URL shown in API Documentation and the Twister on page 21.

Table 1 Partial List of Services of the SA API

Some of the Operations Provided by This

Service Name Service

AuditTaskService Create, get, and run audit tasks.

ConfigurationService Create application configurations, get the
software policies using an application
configuration.

DeviceGroupService Create device groups, assign devices to groups,

get members of groups, set dynamic rules.

EventCacheService Trigger actions such as updating a client-side
cache of value objects. See Event Cache on page
20.

Chapter 1



Table 1 Partial List of Services of the SA API (cont’d)

Service Name

Some of the Operations Provided by This
Service

FolderService

Create folders, get children of folders, set
customers of folders, move folders.

InstallProfileService

Create, get, and update OS installation profiles.

JobService

Get progress and results of jobs, cancel jobs,
update job schedules.

NasConnectionService

Get host names of NA servers, run commands on
NA servers.

NetworkDeviceService

Get information such as families, names, models,
and types, according to specified search filters.

SequenceService Create, get, and run OS sequences to install
operating systems on servers.
ServerService Get information about servers, reconcile

(remediate) policies on servers (install software),
get and set custom fields and attributes, execute
OS sequences (install OS).

SoftwarePolicyService

Create software policies, assign policies to
servers, get contents of policies, remediate
(reconcile) policies with servers.

SolPatchService

Install and uninstall Solaris patches, add policy
overrides.

VirtualColumnService

Manage custom fields and custom attributes.

WindowsPatchService

Install and uninstall Windows patches, add policy
overrides.

Objects in the API

Overview

Although the SA Platform API is function-oriented, its design enables clients to create object-
oriented libraries. TheSA data model includes objects such as servers, folders, and customers.
These are persistent objects; that is, they are stored in the Model Repository. In the API, these

objects have the following items:

e A service that defines the object’s behavior. For example, the methods of the
ServerService specify the behavior of a managed server object.

e An object (identity) reference that represents an instance of a persistent object. For
example, ServerRef is a reference that uniquely identifies a managed server. In the
ServerService, the first parameter of most methods is ServerRef, which identifies the
managed server operated on by the method. The 1d attribute of a ServerRef is the
primary key of the server object stored in the Model Repository.

e One or more value objects (VOs) that represent the data members (attributes, fields) of a
persistent object. For example, ServerVo contains attributes such as agentversion and
loopbackIP. The attributes of ServerHardwareVO include manufacturer, model, and
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assetTag. Most attributes cannot be changed by client applications. If an attribute can be
changed, then the API documentation for the setter method includes “Field can be set by
clients.”

For performance reasons, update operations on persistent objects are coarse-grained. The
update method of ServerService, for example, accepts the entire ServerVvo as an argument,
not individual attributes.

Exceptions

All of the API exceptions that are specific to SA are derived from one of the following
exceptions:

e OpswareException - Thrown when an application-level error occurs, such as when an
end-user enters an illegal value that is passed along to a method. Typically, the client
application can recover from this type of exception. Examples of exceptions derived from
OpswareException are NotFoundException, NotInFolderException, and
JobNotScheduledException.

® OpswareSystemException - Thrown when an error occurs within SA. Usually, the SA
Administrator must resolve the problem before the client application can run.

The following exceptions are related to security:

e AuthenticationException - Thrown when an invalid SA user name or password is
specified.

e AuthorizationException - Thrown when the user does not have permission to perform
an operation or access an object. For more information on permissions, see the SA
Administration Guide.

Event Cache

Some client applications need to keep local copies of SA objects. Accessed by clients through
the EventCacheService, the cache contains events that describe the most recent change
made to SA objects. Clients can periodically poll the cache to check whether objects have been
created, updated, or deleted. The cache maintains events over a configured sliding window of
time. By default, events for the most recent two hours are maintained. To change the sliding
window size, edit the Web Services Data Access Engine configuration file, as described in the
SA Administration Guide.

Searches

The search mechanism of the SA Platform API retrieves object references according to the
attributes (fields) of value objects. For example, the getServerRefs method searches by
attributes of the Servervo value object. The getServerRefs method has the following
signature:

public ServerRef[] getServerRefs (Filter filter)...

Each get*Refs method accepts the filter parameter, an object that specifies the search
criteria. A filter parameter with a simple expression has the following syntax:

value-object.attribute operator value

(This syntax is simplified. For the full definition, see Filter Grammar on page 159.)
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The following examples are filter parameters for the getServerRefs method:

ServerVO.hostName = "d04.example.com"
ServerVO.model BEGINS WITH "POWER"
ServerVO.use IN "UNKNOWN" "PRODUCTION"

Complex expressions are allowed, for example:
(ServerVO.model BEGINS WITH "POWER") AND (ServerVO.use = "UNKNOWN")

Not every attribute of a value object can be specified in a filter parameter. For example,
ServerVO.state is allowed in a filter parameter, but Serverv0.OsFlavor is not. To find
out which attributes are allowed, locate the value object in the API documentation and look
for the comment, “Field can be used in a filter query.”

Security

Users of the SA Platform must be authenticated and authorized to invoke methods on the SA
Automation Platform API. To connect to SA, a client supplies an SA user name and password
(authentication). To invoke methods, the SA user must belong to a user group with the
necessary permissions (authorization). These permissions restrict not only the types of
operations that users can perform, but also limit access to the servers and network devices
used in the operations.

Before application clients can run on the platform, the SA Administrator must specify the
required users and permissions with the Command Center. For instructions, see the User

Group and Setup chapter of the SA Administration Guide. For information about security-
related exceptions, see Exceptions on page 20.

Communication between clients and SA is encrypted. For Web Services clients, the request
and response SOAP messages (which implement the operation calls) are encrypted using SSL
over HTTP (HTTPS).

APl Documentation and the Twister

Overview

The SA Core ships with API documentation (Javadocs) that describe the SA Platform API. To
access the API documentation, specify the following URL in your browser:

https://occ _host:1032/twister/docs/index.html
Or:
https://occ _host:443/twister/docs/index.html

The occ_host is the IP address or host name of the core server running the Command Center
component.

To list the services in the API documentation, specify the following URL:
https://occ _host:443

Also included in the core, the Twister is a program that lets you invoke API methods, one at a
time, from within a browser. For example, to invoke the ServerService.getServervo
method, perform the following steps:

1 Open the API documentation in a browser.

2 In the All Classes pane, select com.opsware.server.

3 Inthe com.opsware.server pane, select ServerService.
4

In the main pane, scroll down to the getServervO method.
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5 Click Try It for the getServervo method.
6 Enter your SA user name and password.

7 In the Twister pane for ServerService.getServerVo, enter the ID of a managed server
in the oid field.

8 Click Go. The Twister pane displays the attributes of the Servervo object returned.

Constant Field Values

Some of the APT’s value objects (VOs) have fields with values defined as constants. For
example, JobInfoVO has a status field that can have a value defined by constants such as
STATUS_ACTIVE, STATUS PENDING, and so forth. The API specifies constants as Java static
final fields, but the WSDLs generated from the API do not define the constants. To view the
definitions for constants, in the API documentation, go to the Constant Field Values page:

https://occ host:1032/twister/docs/constant-values.html

For example, the Constant Field Values page defines STATUS ACTIVE as the integer 1.

Supported Clients

The SA platform supports programmers with different skills, from system administrators who
write shell scripts to .NET and Java programmers familiar with the latest tools and
technologies. All supported clients call the same set of methods, which are organized into the
services of the SA Platform. A developer can create the following types of clients that call
methods in the SA Platform API:

e SA Command-line Interface (OCLI): Launched from Global Shell sessions, shell
scripts can access the SA Platform API by invoking the OCLI methods, which are
executable programs in the OGFS. Each OCLI method corresponds to a method in the
APIL.

e  Web Services: Using SOAP over HTTPS, these clients send requests to SA and get
responses back. The Web Services operations (defined in WSDLs) correspond to the
methods in the API. Developers can write Web Services clients in popular languages such
as Perl and C#.

e Java RMI: These clients invoke remote Java objects from other Java virtual machines.
e Pytwist: These Python programs can run on an SA Core or managed servers.

The Web Services and Java RMI clients can run on servers different than the SA Core or
managed servers. The OCLI methods execute in a Global Shell session on the core server
where the OGFS is installed.
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2 SA CLI Methods

Overview of SA CLI Methods

End-users access SA through the SA Client and the SA Web Client. At times, advanced users
need to access SA in a command-line environment to perform bulk operations or repetitive
tasks on multiple servers. In SA, the command-line environment consists of the Global Shell
(OGSH), Global File System (OGF'S), and Command-line Interface (OCLI) methods.

To perform SA operations from the command-line, you invoke OCLI methods from within a
Global Shell session. An OCLI method is an executable in the OGF'S that corresponds to a
method in the SA API. When you run an OCLI method, the underlying API method is
invoked.

In order to understand this chapter, you should already be familiar with the Global Shell and
the OGFS. For a quick introduction to these features, see the “Global Shell Tutorial” in the SA
User Guide: Server Automation.

Method Invocation

As shown by Figure 2 when an OCLI method is invoked, the following operations occur:
1 In a Global Shell session, the user enters an OCLI method with parameters.

2 The command-line entered in the previous step is parsed to determine the API method
and parameters.

The underlying API method is invoked.

4 An authorization check verifies that the user has permission to perform this operation. SA
then performs the operation.

5 The API method passes the results back to the OCLI method.

6 The OCLI method writes the return value to the stdout of the Global Shell session. If an
exception was thrown, the OCLI method returns a non-zero status.

Figure 2 Overview of an OCLI Method Invocation
Global Shell Session

@ @ SA4 API

§ ./getDeviceGroups selfii=12 @
@ @ getDeviceGroups (ServerRef self)

Accounting App

All Windows Servers
Visalia Vendors @

$

Core Components
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Security

OCLI methods use the same authentication and authorization mechanisms as the SA Client
and the SA Web Client. When you start a Global Shell session, SA authenticates your SA user.
When you run an OCLI method, authorization is performed. To run an OCLI method
successfully, your SA user must belong to a group that has the required permissions. For more
information on security, see the SA Administration Guide.

Mapping Between APl and OCLI Methods

The OGFS represents SA objects as directory structures, object attributes as text files, and
API methods as executables. These executables are the OCLI methods. Every OCLI method
matches an underlying API method. The method name, parameters, and return value are the
same for both types of methods.

For example, the setCustomer API method has the following Java signature:

public void setCustomer (ServerRef self,
CustomerRef customer)...

In the OGFS, the corresponding OCLI method has the following syntax:
setCustomer self:i=server-id customer:i=customer-id

Note that the parameter names, self and customer, are the same in both languages. (The : i
notations are called format specifiers, which are discussed later in this chapter.) In this
example, the return type is void, so the OCLI method does not write the result to the stdout.
For information on how OCLI methods return strings that represent objects, see Return
Values on page 39.

Differences Between OCLI Methods and Unix Commands

Although you can run both Unix commands and OCLI methods in the Global Shell, OCLI
methods differ in several ways:

e Unlike many Unix commands, OCLI methods do not read data from stdin. Therefore, you
cannot insert an OCLI method within a group of commands connected by pipes ().
(However, OCLI methods do write to stdout.)

e Most Unix commands accept parameters as flags and values (for example,
Is -1 /usr). With OCLI methods, command-line parameters are name-value pairs, joined
by equal signs.

e Unix commands are text based: They accept and return data as strings. In contrast, OCLI
methods can accept and return complex objects.

e With OCLI methods, you can specify the format of the parameter and return values. Unix
commands do not have an equivalent feature.
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OCLI Method Tutorial

SA ClI Methods

This tutorial introduces you to OCLI methods with a few examples for you to try out in your
environment. After completing this tutorial, you should be able to run OCLI methods,
examine the self file of an SA object, and create a script that invokes OCLI methods on
multiple servers.

Before starting the tutorial, you need the following capabilities:

You can log on to the SA Client.

Your SA user has Read & Write permissions on at least one managed server. Typically
assigned by a security administrator, permissions are discussed in the
SA Administration Guide.

Your SA user has all Global Shell permissions on the same managed server. For
information on these permissions, see the “aaa Utility” section in the SA User Guide:
Server Automation.

You are familiar with the Global Shell and the OGFS. If these features are new to you,
before proceeding with this tutorial you should step through the “Global Shell Tutorial” in
the SA User Guide: Server Automation.

The example commands in this tutorial operate on a Windows server named
abc.example.com. This server belongs to a server group named All Windows Servers. When
trying out these commands, substitute abc.example.com with the host name of the managed
server you have permission to access.

1

Open a Global Shell session.

You can open a Global Shell session from within the SA Client. From the Actions menu,
select Global Shell. You can also open a Global Shell session from a terminal client
running on your desktop. For instructions, see “Opening a Global Shell Session” in the SA
User Guide: Server Automation.

List the OCLI methods for a server.

The method subdirectory of a specific server contains executable files—the methods you
can run for that server. The following example lists the OCLI methods for the
abc.example.com server:

$ cd /opsw/Server/@/abc.example.com/method
$ 1s -1

addDeviceGroups

attachPolicies

attachVirtualColumn

checkDuplex

clearCustAttrs

These methods have instance context — they act on a specific server instance (in this case,
abc.example.com). The server instance can be inferred from the path of the method.
Methods with static context are discussed in step 5.

Run an OCLI method without parameters.

To display the public server groups that abc.example.com belongs to, invoke the
getDeviceGroups method:

$ cd /opsw/Server/@/abc.example.com/method
$ ./getDeviceGroups
Accounting App
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All Windows Servers
Visalia Vendors

Run a method with a parameter.

Command-line parameters for methods are indicated by name-value pairs, separated by
white space characters. In the following invocation of setCustomer, the parameter name
is customer and the value is 20039. The : i at the end of the parameter name is an ID
format specifier, which is discussed in a later step.

The following method invocation changes the customer of the abc.example.com server
from Opsware to C39. The ID of customer C39 is 20039.

$ cd /opsw/Server/@/abc.example.com

$ cat attr/customer ; echo

Opsware

$ method/setCustomer customer:i=20039
$ cat attr/customer ; echo

C39

List the static context methods for managed servers.

Static context methods reside under the /opsw/api directory. These methods are not
limited to a specific instance of an object.

To list the static methods for servers, enter the following commands:

$ cd /opsw/api/com/opsware/server/ServerService/method
$ 1ls

The methods listed are the same as those displayed in step 2.
Run a method with the self parameter.

This step invokes getDeviceGroups as a static context method. Unlike the instance
context method shown in step 3, the static context method requires the self parameter to
identify the server instance.

For example, suppose that the abc.example.com server has an ID of 530039. To list the
groups of this server, enter the following commands:

$ cd /opsw/api/com/opsware/server/ServerService/method
$ ./getDeviceGroups self:i=530039

Accounting App

All Windows Servers

Visalia Vendors

Compare this invocation of getDeviceGroups with the invocation in step 3 that
demonstrates instance context. Both invocations run the same underlying method in the
API and return the same results.

Examine the self file of a server.

Within SA, each managed server is an object. However, OGFS is a file system, not an
object model. The self file provides access to various representations of an SA object.
These representations are the ID, name, and structure.

The default representation for a server is its name. For example, to display the name of a
server, enter the following commands:

$ cd /opsw/Server/@/abc.example.com
$ cat self ; echo
abc.example.com
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SA ClI Methods

If you know the ID of a server, you can get the name from the self file, as in the following
example:

$ cat /opsw/.Server.ID/530039/self ; echo
abc.example.com

Indicate an ID format specifier on a self file.

To select a particular representation of the self file, enter a period, then the file name,
followed by the format specifier. For example, the following cat command includes the
format specifier (:1i) to display the server ID:

$ cd /opsw/Server/@/abc.example.com
$ cat .self:i ; echo
com.opsware.server.ServerRef:530039

This output shows that the ID of abc.example.comis 530039. The
com.opsware.server.ServerRef is the class name of a server reference, the
corresponding object in the SA API.

The leading period is required with format specifiers on files and method return values, but is
not indicated with method parameters.

Indicate the structure format specifier.

The structure format specifier (: s) indicates the attributes of a complex object. The
attributes are displayed as name-value pairs, all enclosed in curly braces. Structure
formats are used to specify method parameters on the command-line that are complex
objects. (For an example method call, see Complex Objects and Arrays As Parameters on
page 38.)

The following example displays abc.example.com with the structure format:

$ cd /opsw/Server/@/abc.example.com

$ cat .self:s ; echo

{

managementIP="192.168.8.217"
modifiedBy="spujare"

manufacturer="DELL COMPUTER CORPORATION"
use="UNKNOWN"
discoveredDate=1149012848000
origin="ASSIMILATED"

0sSPVersion="SP4"

locale="English United States.1252"
reporting=false

netBIOSName=
previousSWReg=1150673874000
osFlavor="Windows 2000 Advanced Server"

The attributes of a server are also represented by the files in the attr directory, for
example:

$ pwd
/opsw/Server/@/abc.example.com
$ cat attr/osFlavor ; echo
Windows 2000 Advanced Server
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10 Create a script that invokes an OCLI method.

The example script shown in this step iterates through the servers of the public server

group named All Windows Servers. On each server, the script runs the getCommCheckTime
OCLI method.

First, return to your home directory in the OGFS:

$ cd
$ cd public/bin

Next, run the vi editor:
$ vi
In vi, insert the following lines to create a bash script:

#!/bin/bash
# iterate time.sh

METHOD DIR="/opsw/api/com/opsware/server/ServerService/method"
GROUP_NAME="All Windows Servers"
cd "/opsw/Group/Public/$GROUP NAME/@/Server"

for SERVER NAME in *
do
SERVER ID="cat $SERVER NAME/.self:i’
echo $SERVER NAME
SMETHOD DIR/getCommCheckTime self:i=$SERVER ID
echo
echo
done

Save the file in vi, naming it iterate time.sh. Quit vi.
Change the permissions of iterate time.sh with chmod, and then run it:

$ chmod 755 iterate time.sh
$ ./iterate time.sh
abc.example.com

2006/06/20 16:46:56.000

Format Specifiers

Format specifiers indicate how values are displayed or interpreted in the OCLI environment.
You can apply a format specifier to a method parameter, a method return type, the self file,
and an object attribute. To indicate a format specifier, append a colon followed by one of the
letters shown in Table 2.

) If a format specifier is indicated for a file or a method return value, a period must precede the
file or method name. For method return values that have format specifiers, the leading period
is not included.
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Table 2

Summary of Format Specifiers

Allowed as

Format Method

Specifier |Description Valid Object Types | Parameter?

:n Name: A string identifying the | SA objects Yes. If the name is
object. Unique names are ambiguous, an
preferred, but not required. For error occurs.
objects that do not have a name,
this representation is the same
as the ID representation.

11 ID: A format that uniquely SA objects; Yes. If the type is
identifies the object type and its | Dates clear from the
SA ID. Also known as an object | (java.util. context, the type
reference. Calendar) objects may be omitted.

s Structure: A compact Any complex object Yes
representation intended for
specifying complex values on the
command-line. Attributes are
enclosed in curly braces.

:d Directory: Represents an Any complex object No

attribute as a directory in the
OGFS.

that is an attribute.
This representation
cannot be used for
method parameters
or return values.

Position of Format Specifiers

A format specifier immediately follows the item it affects. For files, a format specifier follows
the file name. In the following example, note the leading period:

cat

.self:s

When applied to a method return type, a format specifier follows the method name. The
following invocation displays the IDs of the groups returned:

./ .getDeviceGroups:i

With method parameters, a format specifier follows the parameter name and precedes the
equal sign, as in the following example:

./setCustomer self:1=9977 customer:1=239

A method parameter with a format specifier does not have a leading period.

SA ClI Methods
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Default Format Specifiers

Every value or object has a default format specifier. For example, the name format specifier is
the default for the osversion attribute. The following two cat commands generate the same
output:

cd /opsw/Server/@/d04.example.com/attr
cat osVersion
cat .osVersion:n

The name format specifier is the default for SA objects stored in the Model Repository, such as
servers and customers. The structure format specifier is the default for other complex objects.

ID Format Specifier Examples

The next example displays the ID of the facility that the d04.example.com server belongs to:

cd /opsw/Server/@/d04.example.com/attr
cat .facility:i ; echo

(The preceding echo command is optional. It generates a new-line character, which makes the
output easier to read. The semicolon separates bash statements entered on the same line.)

The output of a value with the ID format specifier is prefixed by the Java class name. For
example, if the facility value has an ID of 39, then the previous cat command displays the
following output:

com.opsware.locality.FacilityRef:39

The following invocation of the getDeviceGroups method lists the IDs of the public server
groups that d04.example.com belongs to:

cd /opsw/Server/@/d04.example.com/method
./ .getDeviceGroups:i

For more ID format examples, see The self File on page 34.

Structure Format Specifier Syntax

The structure format represents complex objects, which can contain various attributes. You
might use this format to specify a method parameter that is a complex object. For examples,
see Complex Objects and Arrays As Parameters on page 38.

The structure format is a series of name-value pairs, separated by white space characters,
enclosed in curly braces. Each name-value pair represents an attribute. The structure format
has the following syntax:

{ name-l=value-1 name-2=value-2 . . . }
Here’s a simple example:

{ version=10.1.3 isCurrent=true }
Any white space character can be used as a delimiter:

{
version=10.1.3
isCurrent=true

Chapter 2



Attributes can be specified as structures, enabling the representation of nested objects. In the
following example, the versionDesc attribute is represented as a structure:

{

program=agent

versionDesc={
version=10.1.3
isCurrent=true
comment="Latest version"
}

}

To specify an array within a structure, repeat the attribute name. The following structure
contains an array named steps that has three elements with the values 33, 14, and 28.

{ moduleName="Some Initiator" steps=33 steps=14 steps=28 }

Structure Format Specifier Examples

SA ClI Methods

The following example specifies the structure format for the facility attribute:

cd /opsw/Server/@/d04.example.com/attr
cat .facility:s

This cat command generates the following output. Note that customers is an array, which
contains an element for every customer associated with this facility.

{

modifiedBy="192.168.9.246"
customers="Customer Independent"
customers="Not Assigned"
customers="Opsware Inc."
customers="Acme Inc."

ontogeny="PROD"
createdBy=
status="ACTIVE"
createdDt=-1
realms="Transitional"
realms="C39"
realms="C39-agents"
modifiedDt=1146528752000
name="C39"
displayName="C39"

}

The following invocation of getDeviceGroups indicates the structure format specifier for the
return value:

cd /opsw/Server/@/d04.example.com/method
./ .getDeviceGroups:s

This call to getDeviceGroups displays the following output. Because d04 .example.com
belongs to two server groups, the output includes two structures. In each structure, the
devices array has elements for the servers belonging to that group.

{
dynamic=true
devices="m302-w2k-vml.dev.example.com"
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devices="d04.example.com"

status="ACTIVE"

public=true

fullName="Device Groups Public All Windows Servers"
description="test"

createdDt=-1

modifiedDt=1142019861000

parent="Public"

}

{

dynamic=true
devices="opsware-nibwp.build.example.com"
devices="glengarriff.snvl.dev.example.com"
devices="millstreet"

fullName="Device Groups Public z testsrvgroup"

}
The structure format specifier is the default for methods that retrieve value objects (VOs). For
example, the following two calls to getServerVO are equivalent:

cd /opsw/Server/@/d04.example.com/method
./ .getServerVO:s
./getServerVo

In this example, getServerVo displays the following output:

{

managementIP="192.168.198.93"
modifiedBy=

manufacturer="DELL COMPUTER CORPORATION"
use="UNKNOWN"
discoveredDate=1145308867000
origin="ASSIMILATED"

osSPVersion="RTM"

locale="English United States.1252"
reporting=false

netBIOSName=

previousSWReg=1147678609000
osFlavor="Windows Server 2003, Standard Edition"
peerIP="192.168.198.93"
modifiedDt=1145308868000

serialNumber="HVKZS51"
}

This structure represents the Servervo class of the SA API. Every attribute in this structure
corresponds to a file in the attr directory. In the next example, the getServervO and cat
commands both display the value of the serialNumber attribute of a server:

cd /opsw/Server/@/d04.example.com
./method/getServerVO | grep serialNumber
cat attr/serialNumber ; echo
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Directory Format Specifier Examples

The following command changes the current working directory to the customer associated
with the server d04.example.com:

cd /opsw/Server/Q/d04.example.com/attr/.customer:d
The next command lists the name of this customer:

cat /opsw/Server/@/d04.example.com/attr/\
.customer:d/attr/name

The directory specifier can be used only in command arguments that require directory names.
The following cat command fails because it attempts to display a directory:

cat /opsw/Server/@/d04.example.com/attr/.customer:d # WRONG!
However, the next command is legal:

1ls /opsw/Server/Q@/d04.example.com/attr/.customer:d

Value Representation

Because they run in a shell environment (Global Shell), OCLI methods accept and return data
as strings. However, the underlying API methods can accept and return other data types, such
as numbers, booleans, and objects. The sections that follow describe how the OGFS and OCLI
methods represent non-string data types.

SA Objects in the OGFS

The SA data model includes objects such as servers, server groups, customers, and facilities.
In the OGF'S, these objects are represented as directory structures:

/opsw/Customer
/opsw/Facility
/opsw/Group
/opsw/Library
/opsw/Realm
/opsw/Server

The preceding list is not complete. To see the full list, enter 1s /opsw.

Obiject Attributes

SA ClI Methods

The attributes of an SA object are represented by text files in the attr subdirectory. The name
of each file matches the name of the attribute. The contents of a file reveals the value of the
attribute.

For example, the /opsw/Server/@/buzz.example.com/attr directory contains the following
files:

agentVersion
codeset
createdBy
createdDt
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customer
defaultGw
description
discoveredDate
facility
hostName
locale
lockInfo
loopbackIP
managementIP
manufacturer

To display the management IP address of the buzz.example.com server, enter the following
commands:

cd /opsw/Server/Q@/buzz.example.com/attr
cat managementIP ; echo

Custom Attributes

Custom attributes are name-value pairs that you can assign to SA objects such as servers. In
the OGFS, custom attributes are represented as text files in the CustAttr subdirectory. You
can create custom attributes in a Global Shell session by creating new text files under
CustAttr. The following example creates a custom attribute named MyGreeting, with a value
of hello there, on the buzz.example.com server:

cd /opsw/Server/Q/buzz.example.com/CustAttr
echo -n "hello there" > MyGreeting

For more examples, see “Managing Custom Attributes” in SA User Guide: Server Automation.

The self File

The self file resides in the directory of an SA object such as a server or customer. This file
provides access to various representations of the current object, depending on the format
specifier. (For details, see Format Specifiers on page 28.)

To list the ID of the buzz.example.com server, enter the following commands:

cd /opsw/Server/@/buzz.example.com
cat .self:i ; echo

For a server, the default format specifier is the name. The following commands display the
same output:

cat self ; echo
cat .self:n ; echo

The next command lists the attributes of a server in the structure format:

cat .self:s

Primitive Values

Table 3 indicates how primitive values are converted between the API and their string
representations in OCLI methods. Except for Dates, primitive values do not support format
specifiers. Dates support ID format specifiers.
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Table 3

Conversion Between Primitive Types and OCLI Methods

Primitive Type

Java Equivalent

Output from OCLI
Method

Input to CLI
Methods

String java.lang. Character string, Character string,
String presented in the converted to Unicode

encoding of the from the current

current session. session encoding.

Number byte, short, int, |Decimal format, not |Examples -

long, float, localized. Scientific Decimal: 101,
double; and their notation for very 512.34, -104
object equivalents large or small values. | Hex: 0x1F32,
0x2e40
Octal: 0543
Scientific: 4.3E4,
6.532e-9,
1.945e+02

Boolean boolean, Boolean true or false The string “true” and

all mixed-case
variants evaluate to
true. All other
values evaluate to
false.

Binary data byte[], Bytel] Binary string. No Binary string. No
conversion from conversion to session
session encoding. encoding.

Date java.util. Date value. By Same as output.

Calendar default, presented in

this format:
YYYY/MM/DD
HH:MM:SSS

The time is presented
in UTC. If an ID
format specifier is
indicated, the value
is presented as the
number of
milliseconds since
the epoch, in UTC.
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Arrays

The representation of array objects depends on whether they are standalone (an array
attribute file or a method return value) or contained in the structure of a complex object.

First, standalone array objects are presented according the underlying type, separated by
new-line characters. Within an array element, a new-line character is escaped by \n and a
backslash by \\.

Array values can be output or input using any representation supported by the underlying
type. For example, by default, the getDeviceGroups method lists the groups as names:

All Windows Servers
Servers in Austin
Testing Pool

If you indicate the ID format specifier, (.getDeviceGroups: i) the method displays the IDs of
the groups:

com.opsware.device.DeviceGroupRef:15960039
com.opsware.device.DeviceGroupRef:10390039
com.opsware.device.DeviceGroupRef:17380039

Second, an array contained in the structure of a complex object is represented as a set of
name-value pairs, using the attribute as the name. The attribute appears multiple times, once
for each element in the array. The order in which the attributes appear determine the order of
the elements in the array. The following example shows a structure that contains two
attributes, a string called subject and a three-element array of numbers called ranks:

{ subject="my favorites” ranks=17 ranks=44 ranks=24 }

Arrays can also be represented by directories. Within an array directory, each array element
has a corresponding file (for primitive types) or subdirectory (for complex types). The name of
each entry is the index number of the array element, starting with zero.

For an array that is the attribute of a complex object, you should modify the array by editing
its attribute file. This action completely replaces the array with the contents of the edited file.

For an array containing elements that are complex objects, you should modify the array by
changing its directory representation. To change an element value, edit the element file. For
example, suppose you have an array with five string elements. The 1s command lists the
elements as follows:

012 34
The following command changes the value of the third element:

echo -n "My new value" > 2
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OCLI Method Parameters and Return Values

This section discusses the details of method context (instance or static), parameter usage,
return values, and exit status.

Method Context and the self Parameter

In the OGF'S, a method resides in multiple locations. The location of a method is related to its
context, which is either instance or static.

The method with instance context resides in method directory of a specific SA object. The
method invocation does not require the self parameter. The instance of the object affected by
the method is implied by the method location. The following example changes the customer of
the d04.example.com server:

cd /opsw/Server/@/d04.example.com/method
./setCustomer customer:i=9

A method with static context resides in a single location under /opsw/api. The method
invocation requires the self parameter to identify the instance affected by the method. In the
following static context example, self:i specifies the ID of the managed server:

cd /opsw/api/com/opsware/server/ServerService/method
./setCustomer self:1=230054 customer:i=9

Passing Arguments on the Command-Line

SA ClI Methods

The command-line arguments are specified as name-value pairs, joined by the equal sign (=).
The name-value pairs are separated by one or more white space characters, typically spaces.
The names on the command-line match the parameter names of the corresponding Java
method in the SA API.

For example, in the SA API, the setCustomField method has the following definition:

public void setCustomField (CustomFieldReference self,
java.lang.String fieldName, java.lang.String strValue)...

The following OCLI method example assigns a value to a custom field of the server with ID
3670039:

cd /opsw/api/com/opsware/server/ServerService/method
./setCustomField self:1=3670039 \
fieldName="Service Agreement" strValue="Gold"

As described in the previous section, a method with an instance context does not require the
self parameter. The following setCustomField example is equivalent to the preceding
example:

cd /opsw/.Server.ID/3670039
./setCustomField \
fieldName="Service Agreement" strValue="Gold"

You can specify the command-line arguments in any order. The following two OCLI method
invocations are equivalent:

./setCustomField fieldName="My Stuff" strValue="abc"
./setCustomField strValue="abc" fieldName="My Stuff"
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To specify a null value for a parameter, either omit the parameter or insert a white space after
the equal sign. In the following examples, the value of myParam is null:

./someMethod myField="more info" myParam= anotherParam=9834
./someMethod myField="more info" anotherParam=9834

Specitying the Type of a Parameter

If a method has an abstract type for a parameter, you must specify the concrete type as well as
the value. In the following example, the com.opsware.folder.FolderRef type is required:

cd /opsw/api/com/opsware/folder/FolderService/method
./remove self:i="com.opsware.folder.FolderRef:730555"

If you do not specify the concrete type, the following error message is displayed:

Object type type-name is abstract. Specify a concrete sub-type.

Complex Objects and Arrays As Parameters

To pass an argument that is a complex object, enclose the object’s attributes in curly braces, as
shown in the Structure Format Specifier Syntax on page 30.

The following example creates a public server group named Al1Mine. The create method has
a single parameter, pattern, which encloses the parent and shortName attributes in curly
braces. In this example, getPublicRoot returns 2340555, the ID of the top public group.

cd /opsw/api/com/opsware/device/DeviceGroupService/method
./ .getPublicRoot:i ; echo
./create “pattern={ parent:1=2340555 shortName='AllMine’ }”

Specify array parameters by repeating the parameter name, once for each array element. For
example, the following invocation of the assign method specifies the first two elements in the
array parameter named policies:

cd /opsw/api/com/opsware/swmgmt

cd SoftwarePolicyService/method
./attachPolicies self:1i=4220039 \
policies:i1=4400335 policies:1=4400942

Overloaded Methods

A Java method name is overloaded if multiple methods in the same class have the same name
but different parameter lists. With overloaded OCLI methods, the argument names on the
command-line indicate which method to invoke. The setCustomField method, for example, is
overloaded to support the setting of different data types. The following two commands invoke
different versions of the method:

./setCustomField \

fieldName="Service Agreement" strValue="Gold"
./setCustomField \

fieldName=hmp longValue=2245
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Return Values

If the API method underlying an OCLI method returns a value, then the OCLI method
outputs the value to stdout. As with Unix commands, you can redirect a method’s stdout to a
file or assign it to an environment variable.

To change the representation of the return value, insert a leading period and append a format
specifier to the method name. The following example returns server references as IDs, instead
of the default names:

cd /opsw/api/com/opsware/server/ServerService/method
./.findServerRefs:i

If you indicate a format specifier that is incompatible with the method’s return type, the file
system responds with an error.

Exit Status

SA ClI Methods

Like Unix shell commands, OCLI methods use the exit status ($?) to indicate the result of the
call. An exit status of zero indicates success; a non-zero indicates an error. OCLI methods
output error messages to stderr.

Table 4 Exit Status Codes for OCLI Methods

Exit
Status Category Description
0 Success The method completed successfully.
1 Command-Line The command-line for the method call is malformed and
Parse Error could not be parsed into a set of options (--option[=value])
and parameter values (param=value).
2 Parameter Parse The parameter values could not be parsed into the object
Error types required by the API.
3 API Usage Error The call failed because of a usage error, such as an invalid
parameter value.
4 Access Error The user does not have permission to perform the
operation.
5 Other Error An error occurred other than those indicated by exit
statuses 1- 4.

For example, the following bash script checks the exit status of the getDeviceGroups method:
#!/bin/bash
cd /opsw/Server/@/toro.snvl.corp.example.com/method

./getDeviceGroups
cmnd_exit status=$?

if [ $cmnd exit status -eq 0 ]

then
echo "The command was successful."
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else

echo "The command failed."

echo "Exit status = " Scmnd exit status
fi

An OCLI method invokes an underlying API method. If the API method throws an exception,
the OCLI method returns a non-zero exit status. When debugging a method call, you might
find it helpful to view information about a thrown exception. The

/sys/last-exception file in the OGFS contains the stack trace of an exception thrown by
the most recent API call. After this file has been read, the system discards the file contents.

Search Filters and OCLI Methods

Many methods in the SA API accept object references as parameters. To retrieve object
references based on search criteria, you invoke methods such as findServerRefs and
findJobRefs. For example, you can invoke findServerRefs to search for all servers that
have example.comin the hostname attribute.

Search Syntax

Methods such as findServerRefs have the following syntax:
findobjectRefs filter=' [object-type:]expression’

The filter parameter includes an expression, which specifies the search criteria. You enclose
an expression in either parentheses or curly brackets. A simple expression has the following
syntax:

value-object.attribute operator value

(This syntax is simplified. For the full definition, see Filter Grammar on page 159)

Search Examples

Most of the SA object types have associated finder methods. This section shows how to use
just a few of them. To see how searches are used with other OCLI methods, see Example
Scripts on page 43.

Finding Servers

Find servers with host names containing example. com:

cd /opsw/api/com/opsware/server/ServerService/method
./ .findServerRefs:1i \
filter="device:{ ServerVO.hostname CONTAINS example.com }’

Find servers with a use attribute value of either UNKNOWN or PRODUCTION:

cd /opsw/api/com/opsware/server/ServerService/method
./.findServerRefs:i \
filter=’'{ ServerVO.use IN “UNKNOWN” “PRODUCTION” }’
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The following bash script shows how to search for servers, save their IDs in a temporary file,
and then specify each ID as the parameter of another method invocation. This script displays
the public groups that each Linux server belongs to.

#!/bin/bash

TMPFILE=/tmp/server-list.txt
rm -f STMPFILE

cd /opsw/api/com/opsware/server/ServerService/method

./ .findServerRefs:1i \
filter='{ ServerVO.osVersion CONTAINS Linux }' > S$STMPFILE

for ID in “cat "STMPFILE""®

do
echo Server ID: $ID
./getDeviceGroups self:i=$ID
echo

done

Finding Jobs
The examples in this section return the IDs of jobs such as server audits or policy
remediations.
Find the jobs that have completed successfully:

cd /opsw/api/com/opsware/job/JobService/method
./.findJobRefs:i filter='job:{ job status = "SUCCESS" }'

(For a list of allowed values of job_status, see “Job Approval Integration” in the SA
Integration Guide.)

Find the jobs that have completed successfully or with warning:

cd /opsw/api/com/opsware/job/JobService/method
./.findJobRefs:i \
filter="job:{ job status IN "SUCCESS" "WARNING" }'

Find the jobs that have been started today:

cd /opsw/api/com/opsware/job/JobService/method
./.findJobRefs:i \
filter="job:{ JobInfoVO.startDate IS TODAY "" }'

Find all server audit jobs:

cd /opsw/api/com/opsware/job/JobService/method
./findJobRefs \
filter="job:{ JobInfoVO.description = "Server Audit" }'

Find the jobs that have run on the server with the ID 280039:

cd /opsw/api/com/opsware/job/JobService/method
./.findJobRefs:i filter='job:{ job device id = "280039" }'

Find today’s jobs that have failed:

cd /opsw/api/com/opsware/job/JobService/method
./.findJobRefs:i \
filter="'job:{ (( JobInfoVO.startDate IS TODAY "" ) \
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& ( job status = "FAILURE" )) }'

Finding Other Objects

This section has examples that search for software policies and packages.
Find the software policies created by the SA user jdoe:

cd /opsw/api/com/opsware/swmgmt/SoftwarePolicyService/method
./ .findSoftwarePolicyRefs:i \
filter='{ SoftwarePolicyVO.createdBy CONTAINS jdoe }’

Find the MSIs with ismtool for the Windows 2003 platforms:

cd /opsw/api/com/opsware/pkg/UnitService/method

./ .findUnitRefs:1i \

filter='software unit:{ ((UnitVO.unitType = "MSI") \
& ( UnitVO.name contains "ismtool" ) \

& ( software platform name = "Windows 2003" )) }'

Find the Solaris patches named 117170-01:

cd /opsw/api/com/opsware/pkg/solaris/SolPatchService/method
./.findSolPatchRefs:1i filter='{name = 117170-01}"

Find the folder with the name that includes the string Test and with a parent folder named
My Stuff.

cd /opsw/api/com/opsware/folder/FolderService/method
./.findFolders:s \

filter='( ( FolderVO.name CONTAINS "Test" ) \

& (folder parent name = "My Stuff" ) )'

Searchable Attributes and Valid Operators

Not every attribute of a value object can be specified in a search filter. For example, you can
search on ServerVO.use but not on Serverv0.0OsFlavor.

To find out which attributes are searchable for a given object type, invoke the
getSearchableAttributes method. The following example lists the attributes of Servervo
that can be specified in a search expression:

cd /opsw/api/com/opsware/search/SearchService/method
./getSearchableAttributes searchableType=device

The searchableType parameter indicates the object type. To determine the allowed values for
searchableType, enter the following commands:

cd /opsw/api/com/opsware/search/SearchService/method
./getSearchableTypes

To find out which operators are valid for an attribute, invoke the
getSearchableAttributeOperators method. The following example lists valid operators
(such as CONTAINS and IN) for the attribute Servervo.hostname:

cd /opsw/api/com/opsware/search/SearchService/method
./getSearchableAttributeOperators searchableType=device \
searchableAttribute=ServerVO.hostname
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Example Scripts

This section has code listings for simple bash scripts that invoke a variety of OCLI methods.
These scripts demonstrate how to pass method parameters on the command-line, including
complex objects and the self parameter. If you decide to copy and paste these example
scripts, you will need to change some of the hard-coded object names, such as the
d04.example.com server. For tutorial instructions on creating and running scripts within the
OGFS, see step 10 on page 28.

The script remediate_policy.sh on page 46 creates a software policy, adds a package to the
policy, and in the last line, installs the package on a managed server by invoking the
startFullRemediateNow method.

create_custom_field.sh

SA ClI Methods

This script creates a custom field (virtual column), named TestFielda attaches the field to all
servers, and then sets the value of the field on a single server. Until it is attached, the custom
field does not appear in the SA Web Client. You can create custom fields for servers, device
groups, or software policies. To create a custom field, your SA user must belong to a user
group with the Manage Virtual Columns permission.

Unlike a custom attribute, a custom field applies to all instances of a type. For an example
that creates a custom attribute in the OGF'S, see "Managing Custom Attributes" in the SA
User Guide: Server Automation.

The create custom field.sh script has the following code:
#!/bin/bash
# create custom field.sh

cd /opsw/api/com/opsware/custattr/VirtualColumnService/method

# Create a virtual column.

# Remember the name because you cannot search for the
# displayName.

./create vo='{ name=TestFieldA type=SHORT STRING \
displayName="Test Field A" }’

column id=‘./.findVirtualColumn:i name=TestFieldA‘
echo --- column id = Scolumn_id

cd /opsw/api/com/opsware/server/ServerService/method
# Attach the column to all servers.

# All servers will have this custom field.
./attachVirtualColumn virtualColumn:i=Scolumn id

# Get the ID of the server named d04.example.com
devices id=‘./.findServerRefs:i \

filter=\

"device:{ ServerVO.hostname CONTAINS "dO4.example.com" }’*

echo --- devices id = Sdevices id

43



44

# Set the value of the custom field (virtual column) for

# a specific server.

./setCustomField self:i=$devices id fieldName=TestFieldA \
strValue="This is something."

create_device_group.sh

This script creates a static device group and adds a server to the group. Next, the script
creates a dynamic group, sets a rule on the group, and refreshes the membership of the group.
The last statement of the script lists the devices that belong to the dynamic group.

Here is the script’s code:
#!/bin/bash
# create device group.sh

cd /opsw/api/com/opsware/device/DeviceGroupService/method

# Get the ID of the public root group (top of hierarchy).
public root=‘./.getPublicRoot:i‘

# Create a public static group.
./create "vo={ parent:i=$public root shortName='Test Group A’ }"

# Get the ID of the group just created.
group id=‘./.findDeviceGroupRefs:i \
filter='{ DeviceGroupVO.shortName = "Test Group A" }’ *

echo --- group id = Sgroup id

cd /opsw/api/com/opsware/server/ServerService/method

# Get the ID of the server named d04.example.com

devices id=‘./.findServerRefs:i \

filter=\

"device:{ ServerVO.hostname CONTAINS "dO4.example.com" }’*
echo --- devices id = Sdevices id

cd /opsw/api/com/opsware/device/DeviceGroupService/method
# Add a server to the device group.

./addDevices \

self:i=$group id devices:i=$devices id

# Create a dynamic device group.

./create \

"vo={ parent:i=$public root \

shortName='Test Dyn B’ dynamic=true }"

# Get the ID of the device group.

dynamic group id=‘./.findDeviceGroupRefs:i \

filter='{ DeviceGroupVO.shortName = "Test Dyn B" }’

echo --- dynamic group id = $dynamic group id
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# Set the rule so that this group contains servers with
# hostnames containing the string example.com.

# The rule parameter has the same syntax as the filter
# parameter of the find methods.

./setDynamicRule self:i=$dynamic group id \
rule="device:{ ServerVO.hostname CONTAINS example.com }’

# By default, membership in dynamic device groups is refreshed
# once

# an hour, so force the refresh now.

./refreshMembership selves:i=Sdynamic_group id now=true

# Display the names of the devices that belong to the group.
echo --- Devices in group:
./getDevices selves:i=Sdynamic group id

create_folder.sh

This script creates a folder named /Test 1, lists the folders under the root (/) folder, and then
creates the subfolder /Test 1/Test 2. After creating these folders, you can view them under
the Library in the navigation pane of the SA Client.

Here is the code for this script:
#!/bin/bash
# create folder.sh

cd /opsw/api/com/opsware/folder/FolderService/method

# Get the ID of the root (top) folder.
root id="./.getRoot:i’

# Create a new folder under the root folder.
./create vo="{ name='Test 1' folder:i=S$root id }"

# Display the names of the folders under the root folder.
./getChildren self:i=3%root id

# Get the ID of the folder "/Test 1"
folder id="./.getFolderRef:i path="Test 1"’

# Create a subfolder.
./create vo="{ name='Test 2' folder:i=$folder id }"

# Get the ID of the folder "/Test 1/Test 2"

folder id="./.getFolderRef:i path="Test 1" path="Test 2"°
echo folder id = Sfolder id
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detect_hba_version.sh

This script detects the HBA firmware level of all Unix servers and for each server assigns the
level to a custom field. (The HBA is the Host Bus Adaptor, an interface card that connects a
host to a storage device.) Before running this script, create a server custom field named
hba firmware version and then create a dynamic device group with a rule that specifies the
value of this custom field. After the script runs, the device group is automatically populated
with servers that have the specified HBA firmware level.

A future version of SA might include the HBA firmware level in the server properties
gathered by the Server Agent. Until then, you can run this script to fetch the firmware level
and store it in a custom field.

The detect hba version.sh script has the following code:

#!/bin/bash
# detect hba version.sh

# Native Emulex command that fetches the HBA firmware level:
NATIVE CMND="/opt/EMLXemlxu/bin/get fw rev"

cd "/opsw/Group/Public/All Unix Servers/Q@/Server"

# Iterate through all Unix servers.
# Run the native command on each server
# Assign the results of the command to the server's custom field.
for SERVER in *; do
FIRMWARE_VER:$(Cd SSERVER; rosh -1 root "$NATIVE_CMND")
./SSERVER/method/setCustomField \
fieldName=hba firmware version strValue="SFIRMWARE VER"
echo SERVER = $SERVER FIRMWARE VER = $FIRMWARE VER
done

remediate_policy.sh

This script creates a software policy named TestPolicyA in an existing folder named Test 2,
adds a package containing ismtool to the policy, attaches the policy to a single server (not a
group), and then remediates the server. The remediation action launches a job that installs
the package onto the server. You can check the progress and results of the job in the SA Client.
For examples that search for jobs with OCLI methods, see Finding Jobs on page 41.

In this script, in the create method of the SoftwarePolicyService, the value of the
platforms parameter is hard-coded. In most of these example scripts, hard-coding is avoided
by searching for an object by name. In the case of platforms, searching by the name attribute is
difficult because if differs from the displayName attribute, which is exposed in the SA Client
but is not searchable. The easiest way to find a platform ID is by going to the twister and
running the PlatformService.findPlatformRefs method with no parameters.

The update method in this script hard-codes the ID of softwarePolicyItems, an object that
can be difficult to search for by name if the Software Repository contains many packages with
similar names. One way to get the ID is to run the SA Client, search for Software by fields
such as File Name and Operating System, open the package located by the search, and note
the SA ID in the properties view of the package.
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In the following listing, the update method has a bad line break. If you copy this code, edit the

script so that the vo parameter is on a single line.

Here is the source code for the remediate policy.sh script:

#!/bin/bash
# remediate policy.sh

# Get the ID of the folder where the policy will reside.
cd /opsw/api/com/opsware/folder/FolderService/method
folder id=\

V./.findFolders:1 filter=’{ FolderVO.name = "Test 2" }’"

cd /opsw/api/com/opsware/swmgmt/SoftwarePolicyService/method

# Create a software policy named TestPolicyA.

# This policy resides in the folder located in the preceding
# findFolders call.

# The platform for this policy is Windows 2003 (ID 10007)
./create vo="{ platforms:i=10007 \

name='TestPolicyA' \

folder:i=$folder id }"

policy id=‘./.findSoftwarePolicyRefs:i \
filter='{ SoftwarePolicyVO.name = "TestPolicyA" }’‘

echo --- policy id = S$policy id

# Call the update method to add a package to the software

# policy. The package ID is 4230039.

#

# NOTE: The following command has a bad line break.

# The vo parameter should be on a single line.

#

./update self:i=$policy id force=true\

# The next 2 lines should be on a single line.

vo="{
softwarePolicyIltems:i=com.opsware.pkg.windows.MSIRef:4230039 }’

cd /opsw/api/com/opsware/server/ServerService/method

# Get the ID of the server named d04.example.com

devices id=‘./.findServerRefs:i \

filter="device:{ ServerVO.hostname CONTAINS "d04.example.com" }’*
echo --- devices id = Sdevices id

# Attach the policy to a single server (not a group) .
./attachPolicies self:i=Sdevices id \

policies:i=$policy id

# Remediate the server to install the package in the policy.
job_id=‘./.startFullRemediateNow:i self:i=$devices id‘

echo --- job id = $job id
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remove_custom_field.sh

Although not common in an operational environment, removing custom fields is sometimes
necessary in a testing environment. Note that a custom field must be unattached before it can
be removed.

Here is the code for remove custom field.sh:
#!/bin/bash

# remove custom field.sh

if [ ! -n "SI ]
then
echo "Usage: ‘basename S$0' <name>"
echo "Example: ‘basename S$0‘ hmp"
exit

fi

cd /opsw/api/com/opsware/custattr/VirtualColumnService/method
column_id=‘./.findVirtualColumn:i name=$1"

echo --- column id = S$Scolumn_ id

cd /opsw/api/com/opsware/server/ServerService/method

# Column must be detached before it can be removed.
./detachVirtualColumn virtualColumn:i=Scolumn id

cd /opsw/api/com/opsware/custattr/VirtualColumnService/method

# Remove the virtual column.
./remove self:i=Scolumn id

schedule_audit_task.sh

This script starts an audit task, scheduling it for a future date. With OCLI methods, date
parameters are specified with the following syntax:

YYYY/MM/DD HH:MM:SS.sss

The method that launches the task, startAudit, returns the ID of the job that performs the
audit. For examples that search for jobs with OCLI methods, see Finding Jobs on page 41.

Here is the code for schedule audit task.sh:

#!/bin/bash
# schedule audit task.sh

cd /opsw/api/com/opsware/compliance/sco/AuditTaskService/method

# Get the ID of the audit task to schedule.
audit task id=‘./.findAuditTask:i \
filter="audit task:{ \

(( AuditTaskVO.name BEGINS WITH "HW check" ) \
& ( AuditTaskVO.createdBy = "gsmith" )) }’?
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echo --- audit task id = Saudit task id

# Schedule the audit task for Oct. 17, 2008.

# In the startDate parameter, note that the last delimiter for
# the time is a period, not a colon.

job id=‘./startAudit self:i=140039 \

schedule:s=’{ startDate="2008/10/17 00:00:00.000™ 1}’ \
notification:s=’{ onFailureOwner="sjones@example.com" \
onFailureRecipients="jdoel@example.com" \
onSuccessOwner="sjones@example.com" \
onSuccessRecipients="jdoelexample.com" }’*

echo --- job id = $job id

Getting Usage Information on OCLI Methods

In a future release, the OCLI methods will display usage information. Until then, you can get
the necessary information from the API documentation or the OGFS with the techniques
described in the following sections.

Listing the Services

The SA API methods are organized into services. To find out what services are available for
OCLI methods, enter the following commands in a Global Shell session:

cd /opsw/api/com/opsware
find . -name "*Service"

To list the services in the API documentation, specify the following URL in your browser:
https://occ_host:1032

The occ_host is the IP address or host name of the core server running the Command Center
component.

Finding a Service in the APl Documentation

The path of the service in the OGFS maps to the Java package name in the API
documentation. For example, in the OGF'S, the ServerService methods appear in the
following directory:

/opsw/api/com/opsware/server
In the API documentation, the following interface defines these methods:

com.opsware.server. ServerService

Listing the Methods of a Service

In the OGFS, you can list the contents of the method directory of a service, For example, to
display the method names of the ServerService, enter the following command:

1ls /opsw/api/com/opsware/server/ServerService/method
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In the API documentation, perform the following steps to view the methods of
ServerService:

1 In the upper left pane, select com.opsware.server.
2 In the lower left pane, select ServerService.

3 In the main pane, scroll down to view the methods.

Listing the Parameters of a Method

In the API documentation, perform the steps described in the preceding section. In the
Method Detail section of the service interface page, view the parameters and return types.
(For more information about method parameters, see Passing Arguments on the Command-
Line on page 37.)

Getting Information About a Value Object

The API documentation shows that some service methods pass or return value objects (VOs),
which contain data members (attributes). For example, the ServerService.getServerVo
method returns a ServerVvo object. To find out what attributes Servervo contains, perform
the following steps:

1 In the API documentation, select the Servervo link. You can find the this link in several
places:

— The method signature for getServervo
— The list of classes (lower left pane) for com.opsware.server

— On the Index page. A link to the Index page is at the top of the main pane of the API
documentation.

2 On the ServerVo page, note the getter and setter methods. Each getter-setter pair
corresponds to an attribute contained in the value object. For example, getCustomer and
setCustomer indicate that ServerVo contains an attribute named customer.

Determining If an Attribute Can Be Modified

Only a few object attributes can be modified by client applications. To find out if an attribute
can be modified, perform the following steps:

1 In the API documentation, go to the value object page, as described in the preceding
section.

2 In the Method Detail section of the setter method, look for “Field can be set by clients.”

For SA objects represented in the OGF'S, such as servers and customers, you can determine
which attributes are modifiable by checking the access types of the files in the attr directory.
The files that have read-write (rw) access types correspond to modifiable attributes. For
example, to list the modifiable attributes of a server, enter the following commands:

cd /opsw/Server/@/server-name/attr
ls -1 | grep rw
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Determining If an Attribute Can Be Used in a Filter Query

SA ClI Methods

To find out if an attribute of a value object can be used in a filter query (a search), perform the
following steps:

1 In the API documentation, go to the value object page.

2 In the Method Detail section of the getter method that corresponds to the attribute, look
for the string, “Field can be used in a filter query.”

From within a Global Shell session, to find out if an attribute can be searched on, follow the
techniques described in Searchable Attributes and Valid Operators on page 42
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3 Python APl Access with Pytwist

Overview of Pytwist

Pytwist is a set of Python libraries that provide access to the SA API from managed servers
and custom extensions. (The twist is the internal name for the Web Services Data Access
Engine.) For managed servers, you can set up Python scripts that call SA APIs through
Pytwist so that end users can invoke the scripts as DSEs or ISM controls. Created by HP SA
Professional Services, custom extensions are Python scripts that run in the Command Engine
(way). Pytwist enables custom extensions to access recent additions to the SA data model,
such as folders and software policies, which are not accessible from Command Engine scripts.

This chapter is intended for developers and consultants who are already familiar with the SA
data model, custom extensions, Agents, and the Python programming language.

Setup for Pytwist

Before trying out the examples in this chapter, make sure that your environment meets the
following setup requirements, as detailed in the following sections.

Supported Platforms for Pytwist

Pytwist is supported on managed servers and core servers. For a list of operating systems
supported for these servers, see the SA Release Notes.

Pytwist relies on Python versions 1.5.2 and 2.4.4, the versions used by SA Agents and custom
extensions.

Unlike Web Services and Java RMI clients, a Pytwist client relies on internal SA libraries. If
your client program needs to access the SA API from a server that is not a managed or core
server, then use a Web Services or Java RMI client, not Pytwist.

Access Requirements for Pytwist

Pytwist needs to access port 1032 of the core server running the Web Services Data Access
Engine. By default, the engine listens on port 1032.

Installing Pytwist on Managed Servers

During an SA installation or upgrade, the Pytwist libraries are placed on the core server with
the Command Engine component. Therefore, you do not need to install Pytwist to use it with
custom extensions.
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However, Pytwist is not included with the Agent installation. You install Pytwist on a
managed server by remediating a policy that contains a Pytwist ZIP file. In the SA Client, the
Pytwist ZIP files are located in the following folder:

/Opsware/Tools/Python Opsware API Access

This folder also includes pre-built software policies containing the Pytwist ZIP files for each
platform. For example, the policy named Windows Python SA API Access contains ZIP files
for Windows XP, 2000, 2003, and so forth. When you remediate this policy, only the ZIP file
that matches platform version is installed. For example, if you remediate the policy on a
Windows 2003 server, only the ZIP file for Windows 2003 is installed.

To install Pytwist on a managed server, perform the following steps:

1 In the SA Client, under Devices, locate the managed server.

2 In the Content pane, open the managed server.

3 In the Managed Server window, from the Actions menu select Install Software.
4

In the Install Software window, select the software policy, for example, Windows Python
SA API Access.

Click Install.

()}

6 Step through the Remediate wizard until you get to the Summary Review window.

7 Click Start Job.

Pytwist Examples

The Python code examples in this section show how to get information from managed servers,
create folders, and remediate software policies. Each Pytwist example performs the following
operations:

1 Import the packages.

When importing objects of the SA API name space, such as Filter, the path includes the Java
package name, preceded by pytwist. Here are the import statements for the
get server info.py example:

import sys
from pytwist import *
from pytwist.com.opsware.search import Filter

2 Create the TwistServer object:
ts = twistserver.TwistServer ()

See TwistServer Method Syntax on page 59 for information about the method’s
arguments.

3 Get a reference to the service.

The Python package name of the service is the same as the Java package name, but
without the leading opsware. com. For example, the Java

com.opsware.server. ServerService package maps to the Pytwist
server.ServerService:

serverservice = ts.server.ServerService

4  Invoke the SA API methods of the service:
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filter = Filter()
servers = serverservice.findServerRefs (filter)

for server in servers:
vo = serverservice.getServerVO (server)

get_server_info.py

This script searches for all managed servers with host names containing the command-line
argument. The search method, findServerRefs, returns an array of references to server
persistent objects. For each reference, the getServervo method returns the value object (VO),
which is the data representation that holds the server’s attributes. Here is the code for the
get server info.py script:

#!/opt/opsware/bin/python
# get server info.py

# Search for servers by partial hostname.

import sys

sys.path.append ("/opt/opsware/pylibs")

from pytwist import *

from pytwist.com.opsware.search import Filter

# Check for the command-line argument.

if len(sys.argv) < 2:
print ’You must specify part of the hostname as the search target.’
print "Example: " 4+ sys.argv[0] + " " + "opsware.com"
sys.exit (2)

# Construct a search filter.
filter = Filter()
filter.expression = ’'device hostname *=* "%s"’' % (sys.argv[l])

# Create a TwistServer object.
ts = twistserver.TwistServer ()

# Get a reference to ServerService.
serverservice = ts.server.ServerService

# Perform the search, returning a tuple of references.
servers = serverservice.findServerRefs (filter)

if len(servers) < 1:
print "No matching servers found"
sys.exit (3)

# For each server found, get the server’s value object (VO)
# and print some of the VO’s attributes.
for server in servers:

VO = serverservice.getServerVO (server)

print "Name: " + vo.name

print " Management IP: " + vo.managementIP
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print " 0S Version: " + vo.osVersion

create_folder.py

This script creates a folder named /Test?/TestB by invoking the createPath method. Note
that the path parameter of createPath does not contain slashes. Each string element in path
indicates a level in the folder. Next, the script retrieves and prints the names of all folders
directly below the root folder. The listing for the create folder.py script follows:

#!/opt/opsware/bin/python
# create folder.py

# Create a folder in SA.

import sys
sys.path.append ("/opt/opsware/pylibs")
from pytwist import *

# Create a TwistServer object.
ts = twistserver.TwistServer ()

# Get a reference to FolderService.
folderservice = ts.folder.FolderService

# Get a reference to the root folder.
rootfolder = folderservice.getRoot ()

# Construct the path of the new folder.
path = "TestA’, "TestB’

# Create the folder /TestA/TestB relative to the root.
folderservice.createPath (rootfolder, path)

# Get the child folders of the root folder.
rootchildren = folderservice.getChildren (rootfolder,
"com.opsware.folder.FolderRef’)

# Print the names of the child folders.
for child in rootchildren:
vo = folderservice.getFolderVO (child)
print vo.name

remediate_policy.py

This script creates a software policy, attaches it to a server, and then remediates the policy.
Several names are hard-coded in the script: the platform, server, and parent folder.
Optionally, you can specify the policy name on the command-line, which is convenient if you
run the script multiple times. The platform of the software policy must match the OS of the
packages contained in the policy. Therefore, if you change the hard-coded platform name, then
you also change the name in unitfilter.expression.
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) The following listing has several bad line breaks. If you copy this code, be sure to fix the bad
line breaks before running it. The comment lines beginning with "NOTE" point out the bad

line breaks.

#!/opt/opsware/bin/python
# remediate policy.py

# Create, attach, and remediate a software policy.

import sys

sys.path.append ("/opt/opsware/pylibs")

from pytwist import *

from pytwist.com.opsware.search import Filter

from pytwist.com.opsware.swmgmt import SoftwarePolicyVO

# Initialize the names used by this script.

foldername = ’TestB’
platformname = ’'Windows 2003’
servername = ’'d04.example.com’

# If a command-line argument is specified,
# use it as the policy name
if len(sys.argv) ==
policyname = sys.argv[l]
else:
policyname = ’TestPolicyA’

# Create a TwistServer object.
ts = twistserver.TwistServer ()

# Get the references to the services used by this script.
folderservice = ts.folder.FolderService

swpolicyservice = ts.swmgmt.SoftwarePolicyService
serverservice = ts.server.ServerService

unitservice = ts.pkg.UnitService

platformservice = ts.device.PlatformService

# Search for the folder that will contain the policy.
folderfilter = Filter()

folderfilter.expression = 'FolderVO.name = ' + foldername
folderrefs = folderservice.findFolderRefs (folderfilter)

if len(folderrefs) ==
parent = folderrefs[0]

elif len(folderrefs) < 1:
print "No matching folders found."
sys.exit (2)

else:
print "Non-unique folder name: " + foldername
sys.exit (3)

# Search for the reference to the platform "Windows Server 2003."
platformfilter = Filter()

platformfilter.objectType = ’'platform’

doublequote = "\"/

# Because the platform name contains spaces,

Python API Access with Pytwist
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# it’s enclosed in double quotes

# NOTE: The following code line has a bad line break.

# The assignment statement should be on a single line.
platformfilter.expression = 'platform name = ' + doublequote + platformname +
doublequote

platformrefs = platformservice.findPlatformRefs (platformfilter)

if len(platformrefs) ==
print "No matching platforms found."
sys.exit (4)

# Search for the references to some software packages.

unitfilter = Filter ()

unitfilter.objectType = 'software unit’

# NOTE: The following code line has a bad line break.

# The assignment statement should be on a single line.

unitfilter.expression = ’ ((UnitVO.unitType = "MSI") & ( UnitVO.name contains
"ismtool" ) & ( software platform name = "Windows 2003" ))’

unitrefs = unitservice.findUnitRefs (unitfilter)

# Create a value object for the new software policy.
vo = SoftwarePolicyVO()

vo.name = policyname

vo.folder = parent

vo.platforms = platformrefs

vo.softwarePolicyItems = unitrefs

# Create the software policy.
swpolicyvo = swpolicyservice.create (vo)

# Search by hostname for the reference to a managed server.
serverfilter = Filter()

serverfilter.objectType = ’server’

# NOTE: The following code line has a bad line break.

# The assignment statement should be on a single line.
serverfilter.expression = ’ServerVO.hostname = ’ + servername
serverrefs = serverservice.findServerRefs (serverfilter)

if len(serverrefs) ==
print "No matching servers found."
sys.exit (5)

# Create an array that has a reference to the
# newly created policy.

swpolicyrefs = [1]

swpolicyrefs[0] = swpolicyvo.ref

# Attach the software policy to the server.
swpolicyservice.attachToPolicies (swpolicyrefs, serverrefs)

# Remediate the policy and the server.

# NOTE: The following code line has a bad line break.

# The assignment statement should be on a single line.

jobref = swpolicyservice.startRemediateNow (swpolicyrefs, serverrefs)

o

print ’'The remediation job ID is %d’ % jobref.id
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Pytwist Details
This section describes the behavior and syntax that is specific to Pytwist.

Authentication Modes

The authentication mode of a Pytwist client is important because it affects the SA features
and the resources that the client can access. A Pytwist client can run in one of the following
modes:

e Authenticated: The client has called the authenticate (username, password) method
on a TwistServer object. After calling the authenticate method, the client is authorized

as the SA user specified by the username parameter, much like an end user who logs onto
the SA Client.

e Not Authenticated: The client has not called the TwistServer.authenticate method.
On a managed server, the client is authenticated as if it is the device that controls the
Agent certificate. When used within a custom extension, a non-authenticated Pytwist
client needs access to the Command Engine certificate. For more information on custom
extensions and certificates, contact your technical support representative.

TwistServer Method Syntax

The TwistServer method configures the connection from the client to the Web Services Data
Access Engine. (For sample invocations, see Pytwist Examples on page 54.) All of the
arguments of TwistServer are optional. Table 5 lists the default values for the arguments.

Table 5 Arguments of the TwistServer Method

Argument Description Default
host The hostname to connect to. twist
port The port number to connect to. 1032
secure Whether to use https for the connection. 1

Allowed values: 1 (true) or 0 (false).

ctx The SSL context for the connection. None. (See also
Authentication Modes on
page 59.)

When the TwistServer object is created, the client does not establish a connection with the
server. Therefore, if a connectivity problem occurs, it is not encountered until the client calls
authenticate or an SA API method.

Error Handling

If the TwistServer.authenticate method or an SA API method encounters a problem, a
Python exception is raised. You can catch these exceptions in an except clause, as in the
following example:

# Create the TwistServerobject.
ts = twistserver.TwistServer (' localhost’)
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# Authenticate by passing an SA user name and password.

try:
ts.authenticate (' jdoe’,
except:

" secretpass’)

print "Authentication failed."

sys.exit (2)

Mapping Java Package Names and Data Types to Pytwist

The Pytwist interface is for Python, but the SA API is written in Java. Because of the
differences between two programming languages a Pytwist client must follow the mapping

rules described in this section.

In the SA API documentation, Java package names begin with com. opsware. When specifying
the package name in Pytwist, insert pytwist at the beginning, for example:

from pytwist.com.opsware.compliance.sco import *

The SA API documentation specifies method parameters and return values as Java data
types. Table 6 shows how to map the Java data types to Python for the API method

invocations in Pytwist.

Table 6 Mapping Data Types from Java to Python

Java Data Type in SA API Python Data Type in pytwist
Boolean An integer 1 for true or the integer O for false.
Object[] As input parameters to API method calls, object

(object array)

arrays can be either Python tuples or arrays. As
output from API method calls, object arrays are
returned as Python tuples.

Map Dictionary
List Array
Date A long data type representing the number of

milliseconds since epoch (midnight on January 1,
1970).
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4 Creating Automation Platform Extensions (APX)

This chapter describes how to create and manage Automation Platform Extensions (APX),
commonly just called extensions. APXs provide a framework that allows anyone familiar with
script-based programming tools such as shell scripts, Python, Perl, and PHP, to extend the
functionality of SA and create applications that are tightly integrated into SA. SA provides
two types of APXs:

¢  Program APXs (also called Script APXs) run in the Global File System (OGFS) and can
use all of the OGF'S functionality. You can use typical programming practices to leverage
the SA API and access a core’s Managed Servers to implement new custom functionality.
For example, you could write an APX that gathers BIOS information from managed
servers and populates custom fields using shell commands. See Program APXs on
page 63.

e Web APXs allow you to create a web-based application, where either an Apache 2.x
process or a CGI/PHP script is called using GET or POST URL. Web APXs can contain
static web resources such as images, and can employ CGI or PHP for dynamic content
generation. See Web APXs on page 63.

APXs allow you to access data about your managed environment and share and process that

data with web applications, scripts, programs and other applications. Below are some of the
benefits of APXs:

e Listed in the SA Library and can be used from the SA Client.
e  Uniquely identified and managed through versioning.

e Secure because they take full advantage of SA’s security model. When needed, APXs can
securely and temporarily escalate a user’s permissions beyond the normal defaults during
the APX session.

e Scalable within and across SA cores.
*  You can schedule them to be pushed automatically to servers.
e Auditable.

e Able to persist through an upgrade of the SA platform. APXs do not have to be rewritten
after an upgrade.

For information on using APX extensions, see “Running Extensions to SA” in the SA User
Guide: Server Automation. See also the “SA Global Shell” in the SA User Guide: Server
Automation because you can also run APX extensions from the SA Global Shell.
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Creating an APX

The following diagram shows the basic steps to creating an APX and the corresponding
commands to use. For a tutorial on how to create a web APX, see Tutorial: Creating a Web
Application APX on page 83. For a tutorial on how to create a program APX, see Tutorial:
Creating a Program APX on page 89.

Figure 3 Creating an APX

Task Command

\ 1. Create a new APX. / | apxtool new |

\ 3. Import your APX code. / ‘ apxtool import

:

Global Shell command line.

Use your standard

Test development tools.

Debug

1 To create a new APX, use the apxtool new command. This command creates a set of
template files you can edit to create your own APX.

You can optionally register your new APX with the apxtool new command. Registering
your APX reserves the name of your APX in SA. If you do not register your APX at this
step, you can register it with the apxtool import command in step 3 below.

See The apxtool Command on page 70.

2  After creating APX template files, develop your APX code by modifying the template files
created by the apxtool new command and possibly adding your own files. You can test
your APX code to make sure it is running correctly.

3 When your APX code is tested, you must import it into SA with the apxtool import
command.

4 Run your APX either from the SA Client or from the Global Shell command line.

— From the SA Client: Select Library » By Type tab » Extensions » Program.
Select an APX. Select the Actions » Run menu.

— From the Global Shell command line: Open the Global Shell from the SA Client by
selecting the Tools » Global Shell menu. Run your APX by entering the command
/opsw/apx/bin/<APX name>.

— For more information, see “Running Extensions to SA” in the SA User Guide: Server
Automation and the “SA Global Shell” in the SA User Guide: Server Automation.
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) To create an APX extension that is intended to run on VMware ESXi servers, the APX
extension must communicate with the ESXi server remotely using its web services interface.
For more information on VMware ESXi servers, see “Virtual Server Management” in the SA
User Guide: Server Automation.

Program APXs

Program APXs, also called Script APXs, are similar to shell commands and are implemented
as OGFS server scripts. You can invoke them from the OGFS command line and pass input
arguments to them using STDIN or command-line arguments. Their output goes to STDOUT
and STDERR.

Program APXs are executed inside a Global Shell (OGSH) session and have access to all
OGSH features permissible to the user who invokes the APX. This includes rosh, CLI, OGFS,
and more. You can write Program APXs using any script-based tool, such as shell script,
Python, Perl, and so on.

You can invoke Program APXs from the OGSH command prompt. Typically, Program APXs
are executed synchronously, meaning the shell prompt does not return until the Program APX
returns. APXs cannot be scheduled as recurring jobs in either the twister or in OGFS.

Program APXs are located in the OGF'S directory /opsw/apx/bin.

) During an interactive OGSH session, a user only sees those Program APXs in /opsw/apx/
bin that they have permission to execute. Attempting to invoke a Program APX for which a
user has no execution permission results in a File Not Found error from the shell.

A Program APX can also be invoked by other Web APXs or Program APXs. For example, a
CGI program or PHP script from a Web APX can invoke a Program APX.

Web APXs

Web APXs are implemented using CGI programs or PHP scripts. These CGI programs and
PHP scripts are executed inside a user-specific OGSH session. They may access SA facilities
such as rosh, the SA API, CLI, or any commands allowable from within an OGSH session.
Web APXs are served by a built-in Apache web server with a PHP module enabled.

You can access Web APXs in two ways: using a stand-alone web browser such as Internet
Explorer or Firefox, or from the SA Client. Microsoft ActiveX is not supported.

Invoking a Web APX from a stand-alone Web browser the first time will trigger a login dialog
that requires verification of the SA user credentials. Invoking a Web APX from the SA Client
does not require additional login. Web APXs can be used to build user Interfaces for custom
customer applications.

) To launch APXs using Microsoft Internet Explorer versions 6 and 7 on Windows Server 2003
and 2008 with Enhanced Security Configuration enabled, the SAS Web Client URL must first
be added to Internet Explorer’s trusted site list.

Creating Automation Platform Extensions (APX) 63



APX User Roles

There are three general roles of APX users as shown in Table 7:

Table 7 APX User Roles

User Role Description

End User Runs APXs. This user typically does not have permission to modify an
APX or see its content.

APX Developer | Creates and publishes APXs. This class of users can import and export
APXs, and can modify APX content.

APX Determines APXs users are permitted to run. These users assign
Administrator |executable permission to run an APX by managing folder permissions.
APX Administrators may not have permission to modify the APX itself,
but can have the permission to view APX content in order to determine
which APXs to make executable.

APX Permissions

APXs requires that you have the SA Client Feature permission Manage Extensions. A user
group can be given one of the permissions:

e Manage Extensions: Read
e Manage Extensions: Read & Write
¢ Manage Extensions: None

Figure 4 APX Feature Permissions

Automation Platform Extension

Mame Permission

Manage Extensions [ 'Read @ Read & Write | None

These feature permissions apply only to APX developers and administrators, they do not
apply to those users who only need to run APXs.

¢ Read permission grants the ability to display the APX source contents or to export
(download) the APX source archives.

¢ Read & Write permission grants the ability to modify the contents of an APX in addition
to read access.

¢ None permission denies all access to the APX source.
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In addition to the SA Client Feature Manage Extensions permission, folder permissions
(list, read, write, execute) must be used to determine which APXs a user has access to.

Table 8 APX Permissions

Permission Description

List Permission to list the system’s APXs.

Read Permission to view APX contents.

Write Permission to modify APX content and to import and export APXs.
Execute Permission to run APXs and view APX properties.

Table 9 shows a matrix of how permissions are determined based on the combination of the
Manage Extensions feature permissions and folder permissions.

Table 9 APX Permission Matrix

Manage Extensions Permission:
Folder
Permission: Read Read & Write None
List List APXs List APXs List APXs
Read Export APXs Export APXs List APXs
Write Export APXs Import, export APXs | List APXs
Execute Run APXs Run APXs Run APXs

Like other SA features, you can grant a user access to an APX and specify to which managed
servers and or policies the user can apply the APX.

) If a user attempts to access a Web APX for which he does not have execution permission, the
Web browser will receive an HTTP 403 Forbidden return code.

For more information on SA permissions, see the SA Administration Guide.

Permission Escalation

When executing an APX, the user has only the privileges to access resources and operations
granted in SA. However, in some cases, it will be necessary to temporarily grant the user
escalated permissions, privileges beyond the SA privileges, while executing an APX. You can
explicitly grant certain privileges to users, over-and-above their default SA privileges, on a
temporary basis while running an APX. Permission escalation is transparent to the user
running the APX.

For example, you may want a user to be able to run a BIOS information gathering application
on a managed server, but the user does not have the permissions granted to do so. You can
write an APX for a user without the privileges required to run the BIOS gathering application
that temporarily grants that user the required privileges. The user’s privileges return to the
default after the APX ends its run.

Privilege escalation is specified in the file apx . perm file. For more information, see The APX
Permissions Escalation Configuration File - apx.perm on page 80.
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APX Structure

An APX has the following attributes:
e APX type: Either Program APX (also called Script APX) or Web APX.

e APX unique name: This is the full name of the APX that must be unique. For example,
com.hp.sa.RestartMyApp.

e APX display name: This is usually a shorter name than the APX unique name. For
example, RestartMyApp.

e APX version: You can maintain multiple versions of your APX by setting a version string
or you can let SA manage versions for you automatically. The APX version can be a simple
number such as version 1, 2, 3, and so on, or it can be any alphanumeric string.

See Importing an APX into SA - apxtool import on page 74 and Setting the Current
Version of an APX - apxtool setcurrent on page 77 for more information.

File Structure

To SA, an APX is just a set of files and directories that conform to the contract of the APX type
(Program APX or Web APX) such that the APX runtime can properly execute it. For example,
a Web APX may need an index.html file or an index.php file. A Program APX may require
a shell command with the same name as the APX.

For more information on the files in an APX, see APX Files on page 79.

OGFS Integration

The APX infrastructure depends on the OGFS to manage user sessions and to expose various
parts of the APX in the SA file system. The following sections describe how APX is integrated
into the OGF'S and its various applications.

APX Executable Directory

Program APXs are treated as executable programs in the Global Shell, OGSH. These APXs
are exposed as an executable command in the OGSH. This allows a shell user to invoke the
APX as if running a shell command.

The APX executable directory has the following format:
/opsw/apx/bin/{apx name}

where apx_name is the name of the APX. Running apx name in /opsw/apx/bin/{apx_name
invokes the current version of apx name.

APX Runtime Directory

The APX Runtime directory is used by the APX runtime to support execution of an APX. The
APX Runtime directory must have access to the APX source. In addition, users who have
developer privileges and have read permission to an APX can also access the APX. The APX
Runtime directory is not available for non-APX developers in the Global Shell.

The APX Runtime directory references the source of the current version of an APX. It has the
format:
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/opsw/apx/runtime/{apx_type}/{apx name}

where apx_type can be script or web.

APX Interfaces - Defining Categories of APX Extensions

APX interfaces enable you to create named categories of APXs and to find all the APXs of a
given category. An interface is the name of the category. For example, you could create a
category of APXs that all take a certain set of input parameters and produces a certain type of
output data. Or you could create a category of APXs that all perform a specific set of
operations.

You can also create an APX or an external application that gets the names of all APXs of the
desired category and executes them. Or the APX or application could just present the list of
APXs of the desired category and let the user select one to execute.

An APX interface is a name that defines an informal contract between the caller of an APX
and the APX.

e An APX that defines an interface name creates a category of APX with that name.

e An APX that implements an interface declares itself to be an APX of that category.

An Example Interface

SA provides an interface named RightClickToRun. This interface defines a category of APX
that takes one or more devices as input parameters and runs against those devices. In
addition, the SA Client displays all APXs that implement this interface in the Actions »
Run Extension menu, which allows users to select one or more devices and run these APXs
against the selected devices. For more information on this interface, see The RightClickToRun
Interface on page 69.

Defining an Interface

An APX interface defines the name of a category of APXs. All APXs that implement the
interface belong to the category and must adhere to the conventions of the interface. To create
a new category, you make your APX “define” the interface.

To make your APX define an interface, perform the following steps.

1 Create the APX with the apxtool new command. For details on this command, see
Creating a New APX - apxtool new on page 71.

2 Locate the files of your new APX and open the file named interfaces in a text editor. The
interfaces file is located in the APX-INF directory of your APX directory.

3 At the end of the interfaces file, add three lines for:
— The name of the interface section in the file. This is the unique name of the interface.
— The display name of the interface.
— A description of the interface.

For example, the following shows the interface section name, the display name and the
description of the interface named “com.hp.sa.MyNewInterface”:

[com.hp.sa.MyNewInterface]
name=MyNewInterface
description="This is a simple interface for testing purposes.”
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Save your changes and close the file.

Import your modified APX into SA with the apxtool import command. For details on
this command, see Importing an APX into SA - apxtool import on page 74.

To upgrade an existing APX to define an interface you must create the interfaces file and
add your interfaces as described above.

Implementing an Interface

An APX interface specifies a category of APX that adheres to the conventions of the interface.
To specify that your APX belongs to a category, you make your APX “implement” the interface.
To make your APX implement an interface, perform the following steps.

1

Create the APX with the apxtool new command. For details on this command, see
Creating a New APX - apxtool new on page 71.

Locate the files of your new APX and open the file named apx.cfgin a text editor.

Locate the section in your apx.cfg file that discusses the “Implementing” section. This
section briefly describes how to specify the interfaces that your APX implements.

Locate the following lines in the file apx.cfg:

[Implementing]
interfaces=

Modify the interfaces=line and add the name of your interface at the end of the line. For
example, if your APX implements the interface named “com.hp.sa.MyNewlInterface”, the
apx.cfg file would contain the following lines:

[Implementing]
interfaces=com.hp.sa.MyNewInterface

To implement more than one interface, add them to the interfaces line separated by colon,
as follows:

[Implementing]
interfaces=com.hp.sa.MyNewInterface:com.hp.sa.AnotherInterface

Save your changes and close the file apx.cfg.

Import your modified APX into SA with the apxtool import command. For details on
this command, see Importing an APX into SA - apxtool import on page 74.

) You must set the current version of the APX to see the implemented interfaces when viewing
the APX in the SA Client or with the apxtool query command. For more information, see
Setting the Current Version of an APX - apxtool setcurrent on page 77.

) To upgrade an existing APX to use an interface you must add your interfaces to your existing
apx.cfgq file as described above.
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The RightClickToRun Interface

SA provides an interface you can use with your APXs named
com.hp.client.server.RightClickToRun. This interface works only with program APXs,
not with web APXs. Use this interface when you want your APX to do all of the following:

e Take one or more devices as input parameters to the APX. APXs that implement this
interface must take “-d <device id>” as an input argument.

e Appear in the Actions » Run Extension » Select Extension... window.

e Appear in the Actions » Run Extension menu of the SA Client. APXs appear in this
menu after they have been run once using the Actions » Run Extension » Select
Extension... menu.

) To execute an APX from the Actions » Run Extension menu, the user must have execute
permission on the APX. Any APX the user does not have permission to execute will not appear
under this menu item. For information on permissions, see the SA Administration Guide.

The RightClickToRun interface lets users select one or more devices in the SA Client and run
your APX against those devices.

When you select the Actions » Run Extension menu item, the SA Client displays all of the
program APXs that implement the interface com.hp.client.server.RightClickToRun. When you
select an APX, it is run against all the selected servers. The APX will be invoked once for each
selected server.

For instructions on making your APX implement this interface, see Implementing an
Interface on page 68. For details on using an APX that implements this interface, see
“Running SA Extensions” in the SA User Guide: Server Automation.

Using the Interface API

You can use the SA API to integrate your own applications with SA and APXs. Your
application can determine all the APXs that implement a particular interface by using the
interface named APXInterfaceService in the package named com.opsware.apx in the SA API.
See API Documentation and the Twister on page 21 in Chapter 1 for more information on
using the SA API.
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The apxtool Command

Use the apxtool command in an OGF'S session to create and manage APXs. The apxtool
command is available in the Global Shell in the directory /opsw/bin/apxtool.

For a tutorial on how to use the apxtool to create a web APX, see Tutorial: Creating a Web
Application APX on page 83.

Syntax of apxtool

Invoke the APX tool from the OGFS command line as follows:

apxtool

[-h | --help] {function} arguments

To obtain a complete list of commands and arguments supported by the APX tool, run apxtool
from an OGSH command line with no arguments.

The APX Tool supports the following major functions:
Table 10 APX Tool Functions

Function

Usage

new

Creates a new APX source directory and a new set of template files in the
OGFS. Optionally registers the APX into SA. Registering assigns an APX ID
and makes the name of your APX available to others (with appropriate
permissions) using SA. See Creating a New APX - apxtool new on page 71.

import

Imports your APX files into the SA Library and creates a new version of your
APX. Optionally registers the APX into SA. Registering assigns an APX ID
and makes the name of your APX available to others (with appropriate
permissions) using SA. See Importing an APX into SA - apxtool import on
page 74.

setcurrent

Sets the current version of an APX in the SA Library. You can have multiple
versions of an APX in SA, but only the current version can be executed. See
Setting the Current Version of an APX - apxtool setcurrent on page 77.

query

Displays information about an APX. See Querying APX Information - apxtool
query on page 75.

export

Copies all of an APXs files from the SA Library to a separate set of files.

delete

Deletes an APX from the SA Library.

Using Short and Long Command Options

Most of the options to the apxtool command accept a short form or a long form.

e The short form is a single hyphen and a character, for example, “-t“ and “-v”.

»

¢ The long format is two hyphens followed by a word, for example, “--type“ and “--view".

Some options require an argument following the option. For example, “-t webapp“ and “-t
details®. Arguments can be specified in one of four formats, which are all equivalent. To
illustrate, the following commands are equivalent and produce the same results:

apxtool query -t webapp
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apxtool query -twebapp
apxtool query -tw

apxtool query —--type webapp
apxtool query —--type=webapp

Some options only require typing a minimum number of characters, enough to identify the
option argument. For example, in the query function, the --view option requires argument
“list” “details”, “versions®. The following commands produce the same result:

apxtool query --view=details
apxtool query —--view=d
apxtool query -vdetails
apxtool query -vd

Creating a New APX - apxtool new

You can use the APX tool to create a new APX and optionally register the name of the APX
into SA. This command creates a set of template files for an APX that you can modify. For
information on the files that make up an APX, see APX Files on page 79.

Usage

apxtool new [options] {src dir}

where the src_dir argument specifies the directory where the template files of the new APX
are to be created. If this argument is omitted, the template files are placed into the current
directory.

Table 11 lists the options for creating a new APX:
Table 11 Options for apxtool new

Option Usage
-h, --help Show this help message and exit.
-t <type> (Required) The APX type. Valid values are: script

or webapp. For example, -ts for script APX, -tw for
web APX. (A script APX is also known as a program
APX.)

—-—type=<type>

-u <unique name> (Required) The unique name of the APX. A unique
name is a dot separated name that conforms to file
system format. It must have at least one dot. Valid
characters are: [a-zA-20-9 .].

-—-uniquename=<unique name>

Example:
com.hp.sa.security.scan ports
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Table 11 Options for apxtool new (cont’d)

Option

Usage

—-n <name>

——name=<name>

(Optional) The display name of the APX in a folder.
If a name is not specified, but a unique name is
specified, the last part of the APX unique name is
used as the display name. Note that this name must
be unique within the specified folder.

For example, if the unique name were
com.hp.sa.MyWebExt, the default display name
would be MyWebExt.

-d <description>

——-description=<description>

(Required) A brief description of an APX. If the
description is a filename with the extension . txt,
the file is assumed to be a text file and its content is
used as the APX description.

-r

--register

(Optional) Registers the name of the APX into the
system. If you specify this option, you must also
specify -f or --folder.

If you do not specify -r and -f with apxtool new, you
must use -f with apxtool import

-f <path>

—--folder=<path>

(Optional) The SA folder path where the APX will
be registered. This can be a full path, partial path,
absolute path, or relative path, as long as it can
uniquely identify a specific folder. This option is only
needed if -r or --register is used.

If you do not specify -r and -f with apxtool new, you
must use -f with apxtool import.

-Q, --quiet

(Optional) Suppresses output messages.

-F, —-—-force

(Optional) Suppresses confirmation prompts.

Deleting an APX - apxtool delete

You can use the APX tool to delete an existing APX from the SA library.

Usage

apxtool delete [options]
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Table 12 lists the options for deleting an APX:
Table 12 Options for apxtool delete

Option Usage

-h Show this help message and exit.

—-help

-t <type> (Required) APX type. Valid values are: script or

——type—<type> webapp. For example -ts for script.

--id=<APX id> (Optional) The object identifier of the desired APX.

-u <unique name> (Optional) The unique name of the APX. A unique
name is a dot separated name that conforms to file
system format. It must have at least one dot. Valid
characters are: [a-zA-20-9 .].

--uniquename=<unique name>

Example:
com.hp.sa.security.scan ports

-n <name>, --name=<name> (Optional) APX display name in a folder.

-f <path>, --folder=<path> (Optional) SA folder path. path can be a full path,
partial path, absolute, or relative, as long as it can
uniquely identify a specific folder.

-Q, --quiet (Optional) Suppresses output messages.

-F, —--force (Optional) Suppresses confirmation prompts.

Exporting an APX from SA - apxtool export

You can use the APX tool to export an APX. Export downloads a specific version of an APX
source archive file and places the files into a directory or into a .zip archive file.

Usage

apxtool export [options] {target dir}

where the argument target_dir is the directory into which the APX source archive file is
copied or into which the APX source archive content is expanded, depending on whether or
not the --archive option is specified. If omitted, the current directory is used.
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Table 13 lists the options for exporting an APX.

Table 13 Options for apxtool export

Option

Usage

-h, --help

Show this help message and exit.

-t <type>, --type=<type>

(Required) APX type. Valid values are: script or
webapp. For example, -t s for script.

-—-1d=<APX id>

(Optional) The object identifier of the desired APX.

-u <unique name>,
--uniquename=<unique name>

(Optional) The unique name of the APX. A unique
name is a dot separated name that conforms to file
system format. It must have at least one dot. Valid
characters are:

[a-zA-20-9 .].

Example:
com.hp.sa.security.scan ports

-n <name>, -—--name=<name>

(Optional) APX display name in a folder.

-f <path>, --folder=<path>

(Optional) SA folder path. path can be a full path,
partial path, absolute, or relative, as long as it can
uniquely identify a specific folder.

-v v<ersion string>, --
version=<version string>

(Optional) This option specifies which APX version
to download. If omitted, the current version is
downloaded.

-a, --archive If specified, export the APX source in its original
source archive as a ZIP or JAR file.

-Q, --quiet (Optional) Suppresses output messages.

-F, --force (Optional) Suppresses confirmation prompts.

Importing an APX into SA - apxtool import

You can use the APX Tool to import APXs. Import publishes a new version of an APX and
optionally sets this version as the current version. If the APX was has not been registered yet,
this command also registers the APX.

) Only the current version of an APX can be run. If you do not set the current version, the APX
will not be runnable. You can set the current version with either apxtool import or with
apxtool setcurrent. See Setting the Current Version of an APX - apxtool setcurrent on
page 77.

Usage

apxtool import [options] {apx src}
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where apx_src can be an archived APX source file with extension .zip or .jar or it can be
the name of a directory containing the APX files to be published. apx src may be a relative
or absolute path. If omitted, the current directory is used. The specified directory or archive
file must contain the directory APX-INF.

Table 14 lists the options that are available when importing an APX:

Table 14 Options for apxtool import

Option Usage
-h, --help Show this help message and exit.
-c, --setcurrent If specified, set the newly published version as the

current version of an APX.

--version=<version string>

The new version of this APX. This option must not be
used if version string is already specified in
apx.cfqg. If no version is specified, one will be
assigned automatically.

-f <path>, --folder=<path>

(Optional) SA folder path. path can be a full path,
partial path, absolute, or relative, as long as it can
uniquely identify a specific folder.

If you did not specify -r and -f with apxtool new, you
must use -r with apxtool import.

-Q, --quiet

(Optional) Suppresses output messages.

-F, —--force

(Optional) Suppresses confirmation prompts.

Querying APX Information - apxtool query

You can use the APX Tool to get and view APX information. You can specify additional options
to limit resulting APXs. Multiple occurrences of the same option form a logical OR expression.
If no matching result is found, this command returns exit code 100.

Usage

apxtool query [options]
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Table 15 lists the options that are available when querying APX information:
Table 15 Options for apxtool query

Option Usage
-h, --help Show this help message and exit.
-v <view>, --view=<view> (Optional) Select one of the predefined views of the

query results. Choices are 1ist (default), details,
and versions.

-v list is a single line representation of APX basic
information presented in tabular format.

-v detailsis a multiple line representation of APX
information.

-v versions lists all APX versions. You would only
need to specify enough characters for the view type;
for example, -vd, is the same as -v details. Ifthe
versions layout is selected, the query must result
in a single APX object.

-t <type>, --type=<type> (Optional) Specifies the type of APX to display.
Valid values are: script or webapp or interface.
The default is to display all types.

-t script displays all script APXs.
-t webapp displays all web APXs.

-t interface displays all APXs that define one or
more interfaces.

For example, apxtool query -ts displays all the

script APXs.
--id=<APX id> (Optional) The object identifier of the desired APX.
-u <unique name> (Optional) The unique name of the APX. A unique
—-uniquename=<unique name> name is a dot separated name that conforms to file

system format. It must have at least one dot. Valid
characters are: [a-zA-20-9 .].

Example:
com.hp.sa.security.scan _ports

-n <name>, --name=<name> (Optional) APX display name in a folder.

-f <path>, --folder=<path> (Optional) SA folder path. path can be a full path,
partial path, absolute, or relative, as long as it can
uniquely identify a specific folder.

--current (Optional) if specified, only query APX objects that
have a current version set.
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Table 15 Options for apxtool query (cont’d)

Option

Usage

--format=<format string>

(Optional) This advanced option allows you to
specify custom display formatting for an APX listing.

format_string is a string containing embedded
tag names that are substituted with values at
display time. Tag names must have a format of

% (tag_name).

Use the format string “© show tags  ”todisplay a
list of all the supported tag names.

--csv (Optional) Displays the output in comma-separated
values format. Ignored if the --format option is
specified.

-Q, --quiet (Optional) Suppresses extraneous output messages.

Setting the Current Version of an APX - apxtool setcurrent

>»

You can use the APX tool to set an APX version as the current version.

Only the current version of an APX can be run. If you do not set the current version, the APX
will not be runnable. You can set the current version with either apxtool import or with
apxtool setcurrent. See Importing an APX into SA - apxtool import on page 74.

Usage

apxtool setcurrent [options]

{version str}

where the argument version_str is required to uniquely identify an existing version of an

APX.

Table 16 lists the options that are available when setting an APX version:

Table 16 Options for apxtool setcurrent

Option Usage
-h, --help Show this help message and exit.
-t <type>, --type=<type> (Required) APX type. Valid values are: script,

webapp. For example, -t s for script.

—--id=<APX id>

(Optional) The object identifier of the desired APX.
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Table 16 Options for apxtool setcurrent (cont’d)

Option

Usage

-u <unique name>,

(Optional) APX unique name. A unique name is a

—--uniquename=<unique name> dot separated name that conforms to file system

format.It must have at least one dot. Valid
characters are It must have at least one dot.
[a-zA-20-9 .].

Example:
com.hp.sa.security.scan ports

-n <name>, --name=<name> (Optional) APX display name in a folder.

-f <path>, --folder=<path> (Optional) SA folder path. path can be a full path,

partial path, absolute, or relative, as long as it can
uniquely identify a specific folder.

-Q, --quiet

(Optional) Suppresses output messages.

-F, —-—-force

(Optional) Suppresses confirmation prompts.

Error Handling

The APX tool command conforms to the standard POSIX convention and returns 0 on success
and a non-zero value for other errors. The APX tool sends normal output to STDOUT and
errors and warnings to STDERR. When an error occurs, the APX tool typically returns a
descriptive message to STDERR.

Error conditions are typically categorized as shown in Table 17:

Table 17 APX Tool Error Conditions
Return
Code Description
0 Success
1 Syntax or usage error
2 Permission related error
3 User canceled operation
4 Runtime error

There may be other undocumented exit codes. The only guarantee is that if the exit code is 0,
the command completed its operation successfully.
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APX Files

This section describes the template files created when you run the apxtool new command.
The following table summarizes these files. The sections below describe some of the files in
more detail.

Table 18 APX Files

File Name Description

apx.cfg APX configuration file, contains metadata that fully describes the APX.
See The APX Configuration File - apx.cfg on page 79.

apx.perm APX permissions file, specifies permission escalation rules. See The
APX Permissions Escalation Configuration File - apx.perm on page 80.

description.txt |Text description of the APX. Specified with the apxtool new -d
option. See Creating a New APX - apxtool new on page 71.

interfaces APX interface definition file. Specifies the interfaces the APX defines
or implements. See APX Interfaces - Defining Categories of APX
Extensions on page 67.

usage.txt Text description of how to use the APX.

run.sh For program APXs only, this file contains the executable code of the
APX. This file contains the functionality of the program APX. For an
example, see Tutorial: Creating a Program APX on page 89.

index.php For web APXs only, this file contains the PHP source code for the web
APX. This file contains the functionality of the web APX. For an
example, see Tutorial: Creating a Web Application APX on page 83.

The APX Configuration File - apx.ctg

All APXs regardless of type must have a configuration file named apx.cfg. The apxtool new
command creates a template of this file for you to modify. This file contains metadata that
fully describes the APX. The apx.cfg uses a “key=value” format to define the properties of
the APX. Multiple lines are joined together with a line continuation character, “\“.

Table 19 APX Configuration File Attributes describes common attributes for all APXs. APX
type specific attributes are described in the corresponding APX type functional specifications.
Note that some of the attributes may be extracted from the apx.cfg configuration file and
managed in SA. For modifiable attributes such as the description, subsequent updates of the
apx.cfq file will update the SA managed data accordingly.
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To see an example apx.cfq file, run the apxtool new command and open the files it creates.

Table 19 APX Configuration File Attributes

Attribute Modifiable? Description

type No The type of the APX, which must be either webapp or
script. (Script APXs are also known as Program APXs.)
Once created, you cannot change the APX type.

name Yes This is the APX display name and may contain multi-byte
characters. This name can be changed at any time. This
name will be listed in the SA Client APX folders.

unique name | No The unique name of the APX. This name will be used as
the file name for the APX as it appears in the OGFS. This
name together with the type forms a key that uniquely
identifies an APX. Once created, the name cannot be
changed. Since this name is used in the file system, it
must conform to the file system naming specification.
Generally, this name should be in ASCII.

version Yes The version string representing the current version of the
APX. If the value begins with the string “auto:”, then SA
will automatically manage the versions using an integer
incremented for each new version.

description | Yes A text description of what the APX does. You can
alternatively use the file description. txt instead of
this attribute.

usage Yes A text description describing how to use the APX. You can
alternatively use the file usage. txt instead of this
attribute.

interfaces Yes One or more interfaces the APX implements. Separate

multiple interfaces with a colon (:) character.

command Yes The executable file the APX is to run when it is invoked.

The APX Permissions Escalation Configuration File - apx.perm

Use the file apx . perm to specify permission escalation rules. If this file does not exist, or if it
contains no escalation permissions, the APX will run with the user's default permissions.

When a new APX is created using the APX Tool’s New command, it generates certain default
files, including a default apx.perm file, which by default has no escalation permissions
defined. The default file does contain some commented out examples which an APX developer
can use as templates.

There are three ways to specify escalations, described below.
e No Escalation on page 81.
e All Permissions on page 81.

e With Escalation on page 81.
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No Escalation

The escalations attribute is not specified. The APX runtime uses the current user privilege to
execute an APX. If an APX invokes privileged operation which a user does not have, APX
execution will terminate with an error.

All Permissions

This is a special privilege that temporarily grants all operation permissions to a user. It is
intended for development or demo use only. This is a useful tool for speedy proof of concept, or
demo, without worrying fine grain permission tuning. It is a poor choice for a production
environment due to its lack of security.

To grant all permissions, edit file apx.perm with a macro that matches all features with
wildcard characters. For example:

use_ feature (name="*")

With Escalation

Specify a list of predefined common operations in the apx.perm file. When executing the
APX, the APX runtime temporarily grants these permissions to the APX. SA has a
comprehensive list of feature and resource permissions. To simplify the task of escalating
related feature, one can use wildcard characters to match groups of related features. For
example:

@use feature (name="Application.*”)

Showing the Progress of an APX

You can use the apxprogress command in your program APX to provide information about
the progress of your APX. This is useful for program APXs that run for a long period of time
when you want to give the user status on the progress of your APX.

You can use a web APX as a front-end to the program APX and display the progress in the web
APX.

The apxprogress Command

Use the apxprogress command to define the number of steps in the execution of a program
APX and to record when each step has completed. This lets users of the APX know how far the
APX has progressed and how much is remaining.

Syntax of apxprogress

apxprogress {option}...
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Table 20 Options to the apxprogress Command

Option

Description

-1 <total number of steps>

Specifies the total number of steps the APX takes to
run. Use this option once at the beginning of the APX to
specify the total number of steps the APX will take.

You can use this option multiple times in an APX to
increase the number steps. Each use increments the
total number of steps by the specified value.

<current step>

Specifies the current step number. Call apxprogress
with this option after each step in the APX code has
completed.

-m <message> Specifies a text message describing the status of the
APX.

-a <data> Specifies additional information the APX can make
available about itself.

-d Indicates debug mode. Displays the output of the
command to stdout for debugging purposes.

-h Displays help information about the apxprogress

command.

Example Shell Script that Uses apxprogress

The following shell script is part of a program APX that uses the apxprogress command. The
APX defines a total of 100 steps and announces its current progress 100 times. Each time it
also provides a message that includes the step number.

#!/bin/sh
R i
# A simple shell script for a program APX that displays progress

# about itself.
# Author: <name>
R i
echo "This is a simple APX that uses apxprogress."

totalsteps=100
apxprogress —-i S$totalsteps -c 1

for 1 in “seq S$totalsteps’; do

done

apxprogress -c¢ $i -m "APX is running, working on step $i" -d

sleep 10
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Viewing APX Progress

You can use the SA API method JobService.getProgress ()to access the progress
information about a running APX that calls the apxprogress command. For an example
showing this method, see 7. View the APX Progress in the Twister Interface on page 94, which
is part of the Tutorial: Creating a Program APX on page 89.

Tutorial: Creating a Web Application APX

This tutorial demonstrates how to create, publish, and run a simple web application APX
named mywebapp.

Running the default version of the APX created during this tutorial displays the output of the
PHP command, phpinfo. Later the tutorial shows you how to modify the PHP code so that it
displays a list of managed servers. Because the tutorial provides the source code, prior
knowledge of PHP is not required.

Complete the following tasks in order.
1. Set Permissions and Create the Tutorial Folder on page 84
2. Create a New Web Application on page 84
3. Import the New Web Application into SA on page 86
4. Run the New Web Application on page 86
5. Modify the Web Application on page 87
6. Run the Modified Web Application on page 88

Tutorial Prerequisites

To complete this tutorial, you must have the following capabilities and environment:

e The ability to log on to SA as admin or as another member of the Super Administrators
group. Logging on as admin enables you to set permissions.

e The ability to log on to SA as a user who belongs to the Advanced Users group.

Advanced users have permission to create and run the web application. In the example
commands shown in this tutorial, the name of this user is jdoe.

e An understanding of how to set client feature permissions in the SA Web Client.

For more information about permissions, see the User and Group Setup chapter of the SA
Administration Guide.

e An understanding of how to create folders in the SA Client

For details on folders, see the SA User Guide: Server Automation.
¢ An understanding of how to open a Global Shell session.

For instructions, see the Global Shell chapter of the SA User Guide: Server Automation.
¢ An understanding of basic Unix commands such as 1s and cd.

e Experience developing web applications that run on HTTP servers.
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1. Set Permissions and Create the Tutorial Folder

1 Logon to the SA Web Client as admin and verify that the Advanced Users group has the
following permission:

— Manage Extensions: Read & Write
You can find this permission on the Client Features tab in the SA Web Client.

2 Log on to the SA Client as a member of the Advanced Users group and create the
following folder in the SA Library:

/Dev/MyApp

Later in the tutorial, you will upload a web application into the My2App folder. In the non-
tutorial environment, the name of this folder is arbitrary. You can create or choose any
other folder to contain your web applications.

Exit the SA Client.
4  Logon to the SA Client as admin and open the Folder Properties of the My2App folder.

On the Permissions tab of Folder Properties, make sure that the Advanced Users
group has the following permissions:

— List Contents of Folder

— Read Objects Within Folder

— Write Objects Within Folder

— Execute Objects Within Folder
6  Exit the SA Client.

2. Create a New Web Application

1 Open a Global Shell session as an SA user who belongs to the Advanced Users group.

2 In your core’s OGFS home directory, create a directory named mywebapp and then change
to that directory:

$ mkdir mywebapp
$ cd mywebapp

The web application files will be stored in the mywebapp directory.

3 Using the apxtool new command, create the directory structure and default files for the
web application as shown below.

$ pwd

/home/jdoe/mywebapp

$ 1s

$

$ apxtool new -tw -d "This is my first app." \

-u com.hp.sa.jdoe.mywebapp

Create source directory /home/jdoe/mywebapp/com.hp.sa.jdoe.mywebapp? Y/N y
Info: Successfully created APX 'mywebapp' source directory: /home/jdoe/
mywebapp.
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The -tw option indicates that the APX type is a web application, -d specifies a description,
and -u specifies a unique name for the application.

) For more information about the apxtool new command options, see the online help:
$ apxtool new -h

4  Change directories into the new directory created by the apxtool new command and list

the files there.

$ pwd

/home/jdoe/mywebapp

$ cd com.hp.sa.jdoe.mywebapp

$ 1s

APX-INF cgi-bin c¢ss 1images index.php

$ 1s -R
APX-INF cgi-bin c¢ss 1images index.php

./APX-INF:
apx.cfg apx.perm description.txt interfaces usage.txt

./cgi-bin:

./css:
hp sa.css

./images:
5 Display the contents of the default index.php file:

$ cat index.php
<?php

// Show information about PHP
phpinfo () ;

?>

As with other web applications, you can replace the index.php file with an index.html
file. However, this tutorial uses the index.php file, which you will modify in a later
section.

6 Examine some of the files in the APX-INF directory. For more information see APX Files on
page 79.

The APxX-INF directory contains information that is specific to APX web applications. As
shown by the following cat command, the description.txt file holds the text you
specified with the -d option of apxtool new

$ 1s APX-INE/

description.txt apx.cfg apx.perm usage.txt
$ cat APX-INF/description.txt

This is my first app $
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The following grep command shows some of the properties in apx.cfg, the APX
configuration file. The values for type and uniquename result from the -t and -u options
of the apxtool new command. For details on the APX configuration file, see The APX
Configuration File - apx.cfg on page 79.

$ grep "=" APX-INF/apx.cfg
type=webapp

name=mywebapp

unique name=com.hp.sa.jdoe.mywebapp

3. Import the New Web Application into SA

Importing the web application performs the following actions:

— Installs the web application on an HTTP server within SA.

— Copies the web application to a folder that appears in the SA Library and in the
Global Shell.

— Assigns a version number to the web application.

Enter the apxtool import command and respond to the prompts with y, as shown below. The
-f option specifies the folder in the SA Library where the web application will be stored. The
-c option sets the current version of the web application.

$ pwd

/home/jdoe/mywebapp/com. hp.sa.jdoe.mywebapp

$

$ apxtool import -f "/Dev/MyApp" -c

APX source is not specified.

Do you want to publish current directory: /home/jdoe/mywebapp/
com.hp.sa.jdoe.mywebapp? Y/N y

APX with unique name 'com.hp.sa.jdoe.mywebapp' does not exist.
Register it into the system? Y/N y

Info: Successfully registered APX 'mywebapp' (310001) in folder ‘/Dev/
MyApp’ .

Info: Successfully published a new version 'l' for APX 'mywebapp'.
Info: Successfully set APX 'mywebapp' (310001) current version as 'l'.

4. Run the New Web Application

Now that you have published the web application, you are ready to run it from the SA Client,
just as an end-user would.

1
2
3

Log on to the SA Client as a user who belongs to the Advanced Users group.
Select the Library tab and the By Type tab.
Navigate to the Extensions» Web node where you should see the mywebapp extension.

If you do not see mywebapp, make sure that you have the necessary permissions as
described in 1. Set Permissions and Create the Tutorial Folder on page 84.

To run the web application, select mywebapp. and select the Actions » Run menu.

The window shown in Figure 5 appears. The web application displays the information
generated by the phpinfo statement of the index.php file.
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Figure 5 Web Application Version 1
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5. Modity the Web Application

Running th

e default index.php file is a good way to check your development environment,

but it does not take advantage of SA functionality. In this section, you modify the index.php
file so that it lists the names of servers managed by SA.

1 In the Global Shell session, locate the index.php file of the web application.

$ cd /home/jdoe/mywebapp/com.hp.sa. jdoe.mywebapp

$ 1s

APX-INF cgi-bin c¢ss images index.php

2 Open the index.php file in a text editor such as vi.

3 Replace the contents of index.php with the following lines:

<html>
<head>

<title>Servers</title>
</head>

<body>

<p>List of servers:</p>
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<?php
passthru("ls /opsw/Server/@");
?>

</body>
</html>

The passthru statement above runs the 1s command and passes stdout (without
reinflates) back to the web page. The 1s command lists the names of your managed
servers as they appear in the OGFS.

Save the index.php file and exit the text editor.
Publish the modified web application.

The following apxtool import command sets the current version to 2. The -F option
suppresses the confirmation prompts.

$ apxtool import -f "/home/jdoe/mywebapp/com.hp.sa.jdoe.mywebapp" \
-c --version=2 -F

Info: Successfully published a new version '2' for APX 'mywebapp'
Info: Successfully set APX 'mywebapp' (310001) current version as '2'.

6. Run the Modified Web Application

1

In the SA Client, use the View » Refresh menu to refresh the view of your web
extensions, which should now contain version 2 of mywebapp.

Select mywebapp and select the Actions » Run menu. The output should be similar to
Figure 5 except it displays the output of the PHP passthru statement and the OGSH 1s
statement, which lists all your managed servers. Note that the passthru statement
removes the line feeds that separate the server names returned by the 1s command.
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Tutorial: Creating a Program APX

This tutorial demonstrates how to create, publish, and run a simple program APX named
myshellapp that runs a simple shell script. Later the tutorial shows you how to modify the
shell script to call the apxprogress command and provide progress information. Because the
tutorial provides the source code, prior knowledge of shell programming is not required.

Complete the following tasks in order.

1
2
3
4
5
6
7

. Set Permissions and Create the Tutorial Folder on page 89
. Create a New Program APX on page 90

. Import the New APX into SA on page 92

. Run the New APX on page 92

. Modify the APX on page 92

. Run the Modified APX on page 93

. View the APX Progress in the Twister Interface on page 94

Tutorial Prerequisites

To complete this tutorial, you must have the following capabilities and environment:

The ability to log on to SA as admin or as another member of the Super Administrators
group. Logging on as admin enables you to set permissions.

The ability to log on to SA as a user who belongs to the Advanced Users group.

Advanced users have permission to create and run the web application. In the example
commands shown in this tutorial, the name of this user is jdoe.

An understanding of how to set client feature permissions in the SA Web Client.

For more information about permissions, see the User and Group Setup chapter of the SA
Administration Guide.

An understanding of how to create folders in the SA Client

For details on folders, see the SA User Guide: Server Automation.

An understanding of how to open a Global Shell (OGSH) session and use the Global Shell.
For instructions, see the Global Shell chapter of the SA User Guide: Server Automation.

An understanding of basic Unix commands such as 1s and cd.

1. Set Permissions and Create the Tutorial Folder

1

Log on to the SA Web Client as admin and verify that the Advanced Users group has the
following permission:

— Manage Extensions: Read & Write
You can find this permission on the Client Features tab in the SA Web Client.

Log on to the SA Client as a member of the Advanced Users group and create the
following folder in the SA Library:

/Dev/MyApp
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Later in the tutorial, you will upload a program APX into the My2App folder. In the non-
tutorial environment, the name of this folder is arbitrary. You can create or choose any
other folder to contain your APX.

3 Exit the SA Client.
4  Log on to the SA Client as admin and open the Folder Properties of the MyApp folder.

5 On the Permissions tab of Folder Properties, make sure that the Advanced Users
group has the following permissions:

— List Contents of Folder

— Read Objects Within Folder

— Write Objects Within Folder

— Execute Objects Within Folder
6  Exit the SA Client.

2. Create a New Program APX

1 Open a Global Shell session as an SA user who belongs to the Advanced Users group.

2 In your core’s OGFS home directory, create a directory named myshellapp and then
change to that directory:

$ mkdir myshellapp
$ cd myshellapp

The program APX files will be stored in the myshellapp directory.

3 Using the apxtool new command, create the directory structure and default files for the
program APX as shown below.

$ pwd

/home/jdoe/myshellapp

$ 1s

$

$ apxtool new -ts -d "This is my first program APX." \
-u com.hp.sa.jdoe.myshellapp

Create source directory under ‘/home/jdoe/myshellapp/
com.hp.sa.jdoe.myshellapp’ for APX ‘myshellapp’? Y/N y

Info: Successfully created source directory ‘/home/jdoe/myshellapp/
com.hp.sa.jdoe.myshellapp for APX ‘myshellapp’.

The -ts option indicates that the APX type is a program APX (also called a script APX), -
d specifies a description, and -u specifies a unique name for the application.

For more information about the apxtool new command options, see the online help:
$ apxtool new -h

4  List the files created by the apxtool new command:

$ pwd
/home/jdoe/mywebapp
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$ 1s

com.hp.sa.jdoe.myshellapp

$ cd com.hp.sa.jdoe.myshellapp

$ pwd
/home/jdoe/myshellapp/com.hp.sa.jdoe.myshellapp
$ 1s -R

APX-INF run.sh

. /APX-INF:
apx.cfg apx.perm description.txt interfaces usage.txt

5 Display the contents of the default run. sh file:

$ cat run.sh
#!/bin/sh

G
# APX myshellapp

#

# Created by: jdoe

#
G
echo "This is APX myshellapp"

6 Examine some of the files in the APX-INF directory. For more information on these files
see APX Files on page 79.

The APX-INF directory contains information that is specific to APXs. As shown by the
following cat command, the description.txt file holds the text you specified with the -
d option of apxtool new.

$ 1s APX-INF/

apx.cfg apx.perm description.txt interfaces usage.txt
$ cat APX-INF/description.txt

This is my first program APX.S$

The following grep command shows some of the properties in apx.cfg, the APX
configuration file. The values for type and uniquename result from the -t and -u options
of the apxtool new command. For details on the APX configuration file, see The APX
Configuration File - apx.cfg on page 79.

$ grep "=" APX-INF/apx.cfg
type=script

name=myshellapp

unique name=com.hp.sa.jdoe.myshellapp
command=run.sh
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3. Import the New APX into SA

Importing the APX performs the following actions:

— Copies the APX to a folder that appears in the SA Library.

— Assigns a version number to the APX.

Enter the apxtool import command and respond to the prompts with y, as shown below. The
-f option specifies the folder in the SA Library where the web application will be stored. The
-c option sets the current version of the web application.

$ pwd

/home/jdoe/myshellapp/com.hp.sa.jdoe.myshellapp

$

$ apxtool import -f "/Dev/MyApp" -c

APX source is not specified.

Do you want to publish current directory: /home/jdoe/myshellapp/
com.hp.sa.jdoe.myshellapp? Y/N y

APX with unique name 'com.hp.sa.jdoe.myshellapp' does not exist.
Register it into the system? Y/N y

Info: Successfully registered APX 'myshellapp' (20001).

Info: Successfully published a new version 'l' for APX 'myshellapp'
Info: Successfully set APX 'myshellapp' (20001) current version as '1l'.

Now that you have published the APX, you are ready to run it from the SA Client, just as
another SA user would.

4. Run the New APX

Now that you have published the APX, you are ready to run it from the SA Client.

1
2
3

VO 0 N o0 0~

Log on to the SA Client as a user who belongs to the Advanced Users group.
In the navigation pane, select the Library tab, then the By Type tab.

Open the Extensions node and select the Program node. This displays all the program
APXs in the SA Library. You should see your APX there. If you do not see myshellapp,
make sure that you have the necessary permissions as described in 1. Set Permissions and
Create the Tutorial Folder on page 89.

Select your APX.

Select the Actions » Run menu item. This displays the Run Program Extension wizard.
Select the Next button.

Select the Start Job button.

When your APX finishes, select the status indicator to display details.

Select the Close button.

5. Modify the APX

In this section, you modify the run.sh file and add calls to the apxprogress command to
provide progress information.

1

92

In the Global Shell session, locate the run. sh file of the APX.
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$ cd /home/jdoe/myshellapp/com.hp.sa.jdoe.myshellapp
$ 1s
APX-INF run.sh

Open the run.sh file in a text editor such as vi.

Replace the contents of run.sh with the following lines:

echo "This is a simple APX that uses apxprogress."

totalsteps=100
apxprogress —-i $totalsteps -c 1

for 1 in “seq S$totalsteps’; do
apxprogress —-c $i -m "myshellapx is running, working on step $i" #-d
sleep 10

done

These apxprogress commands specify that the APX has 100 steps and it calls
apxprogress 100 times, once for each step, waiting ten seconds between calls. For more
information, see Showing the Progress of an APX on page 81.

For debugging, you can change “#-d” to “-d” and run the shell script manually to display
the output from the apxprogress commands on stdout.

Save the run.sh file and exit the text editor.
Publish the modified APX.

The following apxtool import command loads the new version of the APX and sets the
current version to 2. The -F option suppresses the confirmation prompts.

$ apxtool import -f "/home/jdoe/myshellapp" \

-c --version=2 -F

Info: Successfully published a new version '2' for APX 'myshellapp'
Info: Successfully set APX 'myshellapp' (20001) current version as '2'.

6. Run the Modified APX

Now that you have modified and republished the APX, run it from the SA Client as before.

1

O A W N

In the SA Client, use the View » Refresh menu to refresh the view of the program
extensions, which should now show version 2 of myshellapp.

Select your APX.

Select the Actions » Run menu item. This displays the Run Program Extension wizard.
Select the Next button.

Select the Start Job button.
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7. View the APX Progress in the Twister Interface

The apxprogress commands report the progress of the running APX. You can obtain this
progress information by calling the API method JobService.getProgress (). This section
shows you how to run this method from the Twister interface. For more information on the
Twister interface to the SA API, see API Documentation and the Twister on page 21.

1

2
3
4

O 00 N O

10

12

In the SA Client, select the Jobs and Sessions tab.

Locate your APX in the list of jobs.

Note the Job ID number of your APX job. You will use this in a later step.

Run the SA Twist interface by entering the following URL into a web browser:
https://<core host>:1032

where <core host>is the IP address or host name of your SA core server. This displays
the Twist interface to the SA API in the web browser.

Select the “Twister” link. This displays the Twister interface to the SA API where you can
get complete information about API interfaces, packages and methods and where you can
run methods.

Locate and select the JobService interface, which is in the com.opsware.job package.
Scroll down and locate the getProgress () method.

Select the Try It button just above the getProgress () method.

Enter your SA credentials.

Select the Login button.

In the “id” field, enter the job number of your running APX, from step 3 above.

Select the Go button. This calls the getProgress () method and displays the current
progress information about your APX from the apxprogress command, as shown below.
Notice that the total number of steps is 100 and the number of completed steps is 94 in
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this snapshot. For more information on the output from the getProgress () method, see
the Javadocs documentation by selecting the getProgress () method in the navigation
pane of the Twister web browser.

JobService.getProgress()

[ lfj J.TbR - name (fype: java.lang String)
se [ el.

id 2780001 (type: long)
Go |

Return type: com.opsware.job.JobProgress

Invocation took: 0.08 secs

errorCount: ()
totalCount: 1
doneCouni: 0
elemProgressInfo:
[ObjectArray] [size=1]
1. message:
key: myshellapx is running, working on step 94
values: null
defaulthIsg: myshellapx is running, working on step 94
class: class com.opsware job_JobMessagelnfo
status: 0
error: mull
element: Server : 0 <null>
stage:
key: RUN
values: null
defaultdisg: RUN
class: class com.opsware job_JobMessageInfo
doneSteps: 94
totalSteps: 100
applicationData:
class: class com opsware.script ScriptJobTargetProgress
active: true
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5 Agent Tools

Introduction to Agent Tools

Agent Tools is a suite of shell scripts, batch files, and Python scripts specifically designed to
retrieve and/or modify information about Managed Servers. The information is retrieved from
and/or modified in the Core’s Model Repository.

Using the scripts, you can retrieve and modify such data as custom fields, customer
assignments, custom attributes, and more. Given this ability, you can automate many
procedures that in the past had to be accomplished on a server-by-server basis.

In addition, you can incorporate the information the scripts retrieve into customized scripts of
your own design. Since information such as customer assignment and custom attributes
varies from managed server to managed server, the ability to retrieve and use this
information on-the-fly in customized scripts can be very useful.

For example:

¢ You may have a script that handles post-installation configuration for a certain
application that must be able to discover the Facility name in which the server is
registered. Agent Tools provides a script to get the Facility name and insert it into your
post-installation script without manual intervention.

e  When installing a monitoring agent, a post-installation script must modify a configuration
file to include the IP address of the monitoring server in that particular facility. Agent
Tools provides a script to discover the monitoring server’s IP address by reading a custom
attribute on the Core so that it can be inserted into the configuration file.

e A DSE can be written to retrieve the EEPROM version from many servers and store that
information as a custom attribute or custom field.

Some other uses of Agent Tools scripts include:

¢ Gathering information from an SA Core during software installation for use in
configuration.

e Storing metadata from managed servers in the SA database while executing a DSE,
Global Shell script, or software installation.

¢ Retrieving custom attribute information for Managed Servers.
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Installation Requirements

Agent Tools has the following requirements

Operating System Support

Agent Tools supports the operating systems supported by the SA Managed Servers. For a list
of supported operating systems, See the SA Simple/Advanced Installation Guide.

Security, Access Control, and Authentication

Agent Tools must be run as the root user on Unix/Linux systems or as an Administrator on
Windows systems. Agent Tools uses the Server Agent's certificate to connect to the Web
Services Data Access Engine (twist) which is pyTwist’s default behavior, and is granted the
privileges that the Web Services Data Access Engine gives to the Agent. This typically applies
to read/write privileges on the server from which Agent Tools is run, therefore, no user
authentication is required.

) An exception is the set_customer script. You must have read access to a customer to be able
to associate a server with that customer. Agent certificates do not have read access to other
customers, therefore the user must authenticate when running this script.

Other Requirements

e Access privileges to pyTwist
e Access privileges to the SA UAPI
e Installed Python 1.5.2 or 2.4.4 or Python 2 (shipped with the Server Agent)

Installation

Agent Tools is installed in the Core during the normal HP SA Installer Core installation
process. However, you must also install Agent Tools on your Managed Servers to make it
available on those servers. This section describes that process.

Agent Tools is installed on Managed Servers as a set of executable scripts. Depending on your
operating system, these will be shell or batch scripts and Python scripts which are called by
the shell and batch scripts. You can run these scripts from a managed server to retrieve and
modify information in the SA Core. These scripts can be run manually or called from package
installation scripts, DSEs, Global Shell scripts, and so on.

Agent Tools is included as part of the Python SA API Access (pyTwist) software policy. This
policy is located in the directory:

/Opsware/Tools/Python Opsware API Access
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Manually Installing Agent Tools

To install Agent Tools on a Managed Server:
1 Launch the SA Clientt.

2 Go to the Managed Servers list and select the Managed Server(s) on which you want to
install Agent Tools.

Right click and select Install Software.
4  Select the Python Opsware API Access software Policy.

The Software Policy installation wizard will guide you through the rest of the process.

Installing Agent Tools when Installing an Agent

Alternatively, you can specify the Python SA API Access software Policy ID and specify that it
be remediated during Agent installation. For information about Agent installation, see the SA
Administration Guide.

Upgrading Agent Tools

Since Agent Tools is provided as a software policy (part of the pyTwist software policy), you
can upgrade to newer versions of Agent Tools by performing a remediation after upgrading
the core.

When the SA core is upgraded, the Python SA API Access software policy is also updated; any
old versions of Agent Tools are removed and new versions are attached to the policy. After the
SA Core upgrade (during which Agent Tools will be automatically upgraded as part of the core
upgrade), you can then upgrade Agent Tools on the Managed Servers by performing the
following tasks:

1 Select the managed servers that have had Agent Tools installed. You can see a list of the
servers and groups attached to the Python SA API Access software policy by opening the
policy itself.

2 Right click on the selected servers and choose Remediate.
3 Select the Python Opsware API Access software policy.

4 The old versions of the pyTwist and Agent Tools packages are removed, and the new
versions are installed.

Data Migration

Since Agent Tools keeps no persistent data on the managed server, there's no requirement for
data migration or preservation.
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Agent Tools Scripts

Usage

<scriptname>.py|bat|sh --arguments

Table 21 Agent Tool Scripts

Script

Function

get_all_cust_attr

Retrieves all custom attributes for a server record.

Usage: get_all_cust_attr.py [--localonly]
[--mode=python|shell |pretty]

The mode determines the format for the output (such as Python
dictionary, shell statements, etc.). Pretty is the default.

Note: Shell mode does not work when there are multi-line custom
attributes.

get_cust_attr

Retrieves the value of a single custom attribute.

Usage:
get_cust_attr.py [--localonly] <custom attribute
name>

set_cust_attr

Sets the value of a single custom attribute on the server.

Usage: set_cust_attr.py

<custom attribute name>

<custom attribute value>|--valuefile
<path to file with value in it>

del_cust_attr

Deletes a custom attribute from the server's record in the
database.

Usage: del_cust_attr.py <custom attribute name>

get_cust_field

Retrieves the value of a single custom field.

Usage: get_cust_field.py <custom field name>

set_cust_field

Sets the value of a single custom field on the server.

Usage: set_cust_field.py <custom field name> <custom
field value>|--valuefile <path to file with value in
it>

get_customer

Retrieves the customer name that the server is associated with.

Usage: . /get_customer.py

set_customer

Sets the customer name that the server is associated with.

Usage: set_customer.py <customer name>
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Table 21 Agent Tool Scripts (cont’d)

Script Function
get_facility Retrieves the name of the Facility that the server is associated
with.

Usage: . /get_facility.py

get_info Prints out all fields for a server (in a format similar to the server's
info file in OGSH).

Usage: get_info.py

sub_text_file Reads in a text file, looks in the file for tokens/parameters, replaces
them with the value of custom attributes, and prints the amended
file to stdout. See below for more info on the expected file format.

Usage: sub_text_file.py [--localonly]
<path to file with tokens in it>

Formatting for the sub_text_file Script

Text files passed to the sub_text_file script can have any content, however, the script looks
for any lines with two @ characters and will treat the string between and including the @
character pairs as a token. You can have a single @ character on a line, it will be ignored,
however a second @ character on the same line will cause any text between the two @
characters to be treated as a token.

The tokens are replaced with the value of the custom attribute specified between the @ signs.
For example, the string @dns_server@, is replaced with the value of the custom attribute
dns_server. If this custom attribute does not exist or its value is empty, the token is replaced
with an empty string.

Take a text file that contains the entry:

IP: @monitoring server ip@

The script will output will look similar to the following:

IP: 82.159.202.117

Where IP is the value retrieved by monitoring_server_ip.

Output

The sub_text_file script outputs to stdout. You can redirect the output to a file if needed.
You can also use a . template file stored in your zip file to format the output. For example:

SAGENTTOOLSPATH/sub_text file.sh petstore config.template >
petstore config.cfg
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Sample Agent Tool Scripts

The following are simple examples of using Agent Tools scripts.

Unix/Linux

This example puts a message containing the name of the facility in the Message of the Day
(MOTD) that users see when they log into the Unix server.

/etc/opt/opsware/pytwist/pytwist.conf
facility name="SAGENTTOOLSPATH/get facility.sh’
echo "You have connected to a server in the S$facility name facility. For
hardware information on this server as stored in Opsware, run SAGENTTOOLSPATH/
get info.sh." > /etc/motd

Windows

This Windows example puts a text file on all users' desktops with information about the
server.

call "C:\Program Files\Common Files\Opsware\etc\pytwist\
pytwist conf.bat"

call"$AGENTTOOLSPATH%\get info.bat" > "$SYSTEMDRIVES$\Documents and
Settings\All Users\Desktop\server info from Opsware.txt"

Do not hard code the path to Agent Tools Instead you must do the following:

1. Source the PyTwist configuration file:

Unix:

./etc/opt/opsware/pytwist/pytwist.conf

Windows:

call

C:\Program Files\Common Files\Opsware\etc\pytwist
\pytwist_conf.bat

2. Use the environment variable:
Unix:

$AGENTTOOLSPATH

Windows:

%AGENTTOOLSPATHS

Using this method will prevent errors in your scripts should the path to Agent Tools change in
future.
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6 Microsoft Windows PowerShell/SA Integration

Introduction to Microsoft Windows PowerShell

@

Windows PowerShell is an extensible command shell for system administrators and
programmers, integrated with Microsoft’s .Net 2.0 Framework Class Library. It uses the NET
common language runtime and the .NET Framework, and accepts and returns .NET objects.
This enhances the tools and methods available to manage and configure of Windows.

Windows PowerShell provides numerous cmdlets, which are built into the shell and provide a
wide range of functionality. Cmdlets can be used individually or in combination to perform
more complex tasks.

Windows PowerShell not only enables access to a computer’s file system, PowerShell
Providers allow you to access data stores like the registry and digital signature certificate
stores. A Provider is a software module that provides a uniform interface between a service
and a data source.

Before you attempt to use the Windows PowerShell with SA, it is assumed that you are
familiar with and comfortable using Microsoft Windows PowerShell. If you need background
or instruction in using PowerShell, see http:/ /www.microsoft.com.

Because the included cmdlets can modify data on your managed servers, it is important that
you have a solid understanding of Windows PowerShell and its use.

Windows PowerShell Integration with SA

SA provides initial integration with Microsoft Windows PowerShell on managed servers
running Windows. PowerShell is available from SA user interfaces and SA data is available
from within the standard PowerShell environment or from within any PowerShell Runspace.
A PowerShell Runspace is a hosting environment for the PowerShell runtime system.

The following PowerShell cmdlets are available with SA:
e  Get-SASServer

e Set-SASServer

e Get-SASJob

SA also includes a PowerShell SAS Provider (a component that provides access to the objects
in an SA core in a PowerShell environment).
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Integrated PowerShell /SA Cmdlets

Table 22 lists and describes the integrated PowerShell/SA cmdlets included with SA.
Table 22 PowerShell Cmdlets

Cmdlet

Description

Arguments

Get-SASServer

Retrieves server data from
specified server(s)

-Credential <PSCredential>

-Core <Hostname | IPAddress>

-Name < ListOfHostnameFragments> |
-Id <ListOfServerIDs>

Get-SASJob

Retrieves data for specified
jobs

-Credential <PSCredential>
-Core <Hostname | IPAddress>
-JobFilter <ListOfJobIDs>

Set-SASServer

Retrieves a list of managed
servers

-Credential <PSCredential>
-Core <Hostname | IPAddress>
-Server <ServerVO>

Installation Requirements

An MSI installer package containing the cmdlets and PowerShell SA Provider assemblies,
configuration and setup files for installation on a System Administrator's Windows desktop.

Operating System Support

e  Windows XP

e  Windows Server 2003

e  Windows Vista

e  Windows Server 2008

Installation

To implement Microsoft Windows PowerShell/SA integration, you must perform the following

tasks:

1 Locate the Microsoft Windows PowerShell/SA Connector MSI package in the OCC
Library » Software Policies.

2  Run the MSI to install the assemblies that define the SA-specific cmdlets and SA
Provider. The file readme. rtf provides last minute information. The Microsoft Windows
PowerShell initialization script, profile.ps1 (similar to .bashrc) and a set of sample
PowerShell scripts that show how to use PowerShell in an SA environment are also

installed.

By default, the MSI installs the connector into C: \Program Files\Opsware\PsSas.
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The file, SAS-WSAPI .ps1, describes accessing the WS-API directly from PowerShell, without
the need for cmdlets.

Microsoft PowerShell Integration with SA Features

Microsoft PowerShell is available as an option in the following areas:
e Remote access to Managed Servers

e Audit and Snapshots Rules

e DSE Script Integration

Remote access to Managed Servers

From the SA Client, you can open a remote PowerShell session for any managed server (not
available for a group of servers), as you would when opening a remote terminal.

1 Launch the SA Client.
2 From the Navigation pane, select Devices » All Managed Servers.
3 Select a Managed Server and open it.

In the Device Explorer window, from the Actions menu, select Launch Remote
PowerShell.

) You cannot run a script that contains WMI calls while logged in to a remote PowerShell
session. If you try to run a script containing WMI call, you will get an Access Denied error,
even if you are a member of a group with the necessary permissions to run that script.

Audit and Snapshots Rules

Microsoft PowerShell is integrated with SA Audit. While configuring a custom script rule,
Microsoft PowerShell scripts are now an option along with batch, Python 1.5.2 and Python 2
and Visual Basic. For details about Audit the SA User Guide: Audit and Compliance.

DSE Script Integration

For Managed Servers, you can set up PowerShell scripts that call SA APIs using Pytwist so
that end users can invoke the scripts as DSEs or ISM controls. For more information about
writing scripts that invoke Pytwist APIs, see Python API Access with Pytwist on page 53.

Sample Sessions

This section provides four scenarios that demonstrate using Windows PowerShell/ SA
integration.
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e Scenario 1 demonstrates extracting managed server data from an SA Core, modifying it,
and writing it back to the core.

e Scenario 2 demonstrates exporting SA managed server data to an Excel spreadsheet
using Windows PowerShell/SA integration.

e Scenario 3 demonstrates mounting the SA core as a Windows PowerShell PSdrive and
navigating around the virtual file system.

e Scenario 4 demonstrates listing all the types of SA objects available to a Windows
PowerShell environment.

Scenario 1

Authenticating to an SA Core, obtaining data about a managed server, modifying the data,
and writing the data back to the SA Core.

1 Open a PowerShell prompt from the desktop icon.
2 Store the SA Core credentials securely in a PowerShell shell variable. See Figure 6.

Figure 6 Storing the SA Credentials in a PowerShell Variable

0 C:%Documents and Settings'paul’,Desktop' powershell.e

Plindows PowerShell
Copyright <G> 2886 Microsoft Corporation. All rights reserved.

PS C:~documents and settings“Opsware> fcreds = get—credential

cmdlet get—credential at command pipeline position 1
Supply values for the following parameters:
Credential

User: student3dh

Password for user student3dbh: e

PS C:sdocuments and settingssOpsware? Screds
Password

=tudent3s System.Security.SecureString

PE C:xdocumentsz and settingsOpsware>

3 Using the Get-SasServer cmdlet, you can retrieve the SA record representing a server
as shown in Figure 7.

Figure 7 Using the Get-SasServer cmdlet

ocuments and Settings'paul,Desktop',powershell.e

PS C:sdocuments and settings“Opsware?
PS8 C:sdocuments and settingss\Opswarel
't Cxdocuments and settingsOpsware? Sserver = Get SasServer core 172.160.74.1

1 —credential $creds —name linuxB4.company.com
PS8 C:sdocuments and settings“\Opswarel _

The returned object is stored in a shell variable.

The Get-SasServer cmdlet takes a parameter to identify the SA Core from which the
server data is to be retrieved, a parameter to supply credentials to the SA core for the
operation, identifying and authenticating the SA user account in whose identity the
operation is to be attempted, and a parameter to identify the server being requested.

Chapter 6



More information on the Get-SasServer cmdlet arguments or the arguments for any cmdlet

can be obtained by using the PowerShell Get-Help base cmdlet, for example:

Get-Help Get-SasServer -detailed

4 You can now examine the properties of the returned object by entering the name of the

shell variable. See Figure 8.

Figure 8 Examining SA Server Properties

ocuments and Settings’paul’Desktop’,powershell

PS5 C:xdocuments and settingssOpswarel
PS5 C:xdocuments and settingssOpswarel
PS G:ndocuments and settings\Opsware> $server

agentUersion
codeset
customer

def aultGu
discoveredDate
facility
firstDetectDate
hypervisor
lastScanDate
locale
lockInfo
loophackIP
managementIP
mid

ozSPUersion
peerIP

platform
previousSiRegDate
realmn

reporting

createdBy
createdDate
ref

: 32h.B.8.17
UTF-8

OpsuarelebServices .CustomerRef
172_16.239.1

8.-28,2007 7:24:31 PM
OpswarellebServices .FacilityRef
i-1-8881 12:80:88 AM

False

118081 12:80:88 AM

OpsuwarelebServices . LockInfo

172_16_239_229
18388081
linuxB4.company.comn

MANAGED
PROUISIONED

172 _16.239_229
OpswarellebServices .PlatformRef
9/5,2087 8:35:49 PM
OpswarellebServices .RealmRef
True

UNENOWN

0K
UNKNOWN
i

linuxB4 . company.com

UMUARE, IHC.

UMUARE VIRTUAL PLATFORH

Linux 3A%

172.16.237.229

ggHHRE—SE 4D 7E 78 D1 D& AY 8D-2C D8 98

True

se

8-28-20807 8:17:42 PM
fAutomatic

8-28-2087 7:24:31 PM
OpzwarellebServices . ServerRef

PE C:documents and settings™0

Microsoft Windows PowerShell/SA Infegration

CF 9C 48 E? F?7

107



108

5

List the object’s properties, the types of the properties and the methods that can be called
on the object from a PowerShell script as shown inFigure 9.

Figure 9 Listing an Object’s Properties

13 Sdocuments
P documents
P8 C:ndocuments

IsPublic IsSer

PS8 C:xdocuments

B C\Documents and Settggs"-.,pauI"-.,Desktop"-.,powershe
and settingssOpsware’

=101

and settingssOpsware’
and settingssOpsware? Sserver.gettype(d

Serverll

BaseType

OpswarellebService. ..

and settingssOpsware? Szerver ! Get—Member

TypeMame : OpswarellebServices.Serverll

createdDate
customer
def aultGuw
description
dirtyAittributes
discoveredDate
facility
irstDetectDate
hostName
hypervisopr
lastScanDate

manuf acturer
mid

mode 1

modif iedBy
modif iedDate

name
netBIOSName
opsuLifecycle
origin

osFlavor
nzSPlersion
oslersion
peerlP

platform
previousSWRegDat
primaryl P

realm

ref

wirtualizationTy
RunP8ScriptBlock

Hembe rT ype
Method
Method
Method
Method
Froperty
Property
Property
Property
Property
Property
I'roperty
Property
Property
Property
Property
Property
Property
Property
Froperty
Froperty
Property
Property
Property
Property
Property
Property
Property
Property
Property
Property
Froperty
Froperty
Property
Property
Property
Property
Property
e Property
Property
Property
Property
Property
Property
Froperty
Froperty
Property
pe Property

Definition
System.Boolean Equals{Ohject ohj>
System.[nt32 GetHazhCode(>
System.Type GetType(d
Jitring ToSteringdD
ng agentUerzion {get;set;>

System.itring createdBy {get;set:}
System.Datelime createdDate {getiset;}
OpswarellebServices.CustomerRef customer {get...
System.3tring defaultGuw {getiset:}

m ring description {gctisct;l}
System.3tringl[] dirtvAttributes {get;set:}
System.DateTime discoveredDate {get;set;:?
OpswarellebServices .FacilityRef facility {get...
System.DateTime firstDetectDate {get;set:}
System.3tring hostName {get;set;>
System.Boolean hypervisor {get;set;>
System.DateTime laztScanDate {get;set;:;>
System.%tring locale {get;set;2
OpswarellebServices .LockInfo lockInfo {get;set;>
System.Boolean logChange {get;set;l}

loophackIP {get;set;’
managementIP {get;set;:}
manuf acturer {getiset;:}
mid {get;set;?
model {get;set;¥
System.3tring modif iedBy {get;set;¥
System.DateTime modifiedDate {get;set:?
System.3tri name {get;set;:>
netBI0OSHame {get:set;}
opswLifecycle {geti:set;>
origin {getsset;>
osFlavor {getiset;}
osSPUerzion {get;set;2
osVersion {get;set;:l
g peerlP {getiset;}
OpswarellebServices.PlatformBRef platform {get...
System.DateTime previousSUWRegDate {get:set;}
System.String primarylP {get;set:}
Opsuwar bServices .RealmRef realm {get;set;>
OpswarellebServices .0bhjRef ref {get;:;set:}
System.Boolean reporting {get;set;}
System.itring serialNumber {get;set;>
ring stage {getiset;>
ring state {get;set;>
System.3tring use {geti;set;}
System.[ntbd virtualizationType {get;set;:>

ScriptMethod System.Object RunPEScriptBlock<);

PS C:sdocuments and settingsSOpswarel _
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6 You can modify the object’s Description attribute in Windows PowerShell, then call the

Set-SasServer cmdlet and pass the modified Servervo object to the cmdlet. This

cmdlet will take the Servervo object and update the managed server record in the SA

Core. The set-SasServer cmdlet takes parameters that identify the SA Core to which
the updated data is to be written and credentials identifying the SA user account under
whose identity the operation is executed.

At the end of the update operation, the updated Servervo is returned to Windows
PowerShell and the properties are displayed at the prompt as shown in Figure 10.

Figure 10 Modifying an Object’s Description

C:ndocuments and
C:Ndocuments and

GC:sdocuments and
from PowerShell"
C:Ndocuments and
C:ndocuments and
C:Ndocuments and
C:“documents and
1 —credential %creds

agentUersion

dizcoveredDate
facility
hyperuvisor

nzSPlersion
peerlP

platform
previousSWRegDate

createdBy
createdDate
ref

PS Cidocuments and

(ol x|
settingss\Opsware>

gsettingssOpsware > i

settings~Opsware? Sserver.description = "Modified by student

settingssOpsware >

settings~0psware? Sserver.dirtyfAttributes = "description”
settingssOpsware >

settings~Opsware> Sserver | Set—SasServer —core 192_.168.34.1

32h.8.0.17
UTF-8

OpswarellebServices .CustomerRef
172 .16.239.1

8./28,2007 7:24:31 PM
OpswarellebServices .FacilityRef
False

OpswarellebBervices.LockInfo

172.16.239.229
1838881
linuxB4 . company.com

MANAGED
PROVISIONED

172.16.239.229
OpswarellebServices .PlatformRef
95,2007 8:35:49 PM
OpswareWebServices . RealmRef
True

UNKNOWN

OK
UNKNOWN
i

Modified by student35 from PowerShell
linuxB4.company.comn

UMWARE .. .

UMUARE VIRTUAL PLATFORM

Linux 3AS

172.16.239.229

ggHHHE—SG 4D 7E 78 D1 D& A7 8D-2C D3 98 CF 9C 48 E? F?7

True

student3s

9/6,.2087 2:88:56 PM
Automatic

8./28,2007 7:24:31 PM
OpswarellebBervices .ServerRef

settings™\Opsware> _

Scenario 2

This scenario demonstrates retrieving all managed server data from the SA Core and

displaying it in Microsoft Excel.

1 Use the Get-SasServer cmdlet to retrieve Servervos for each Linux and Windows

managed server from the SA Core. In the session below, the —-name parameter is used to
supply a list of name matching filters, for example, -name linux,win, to the SA Core.

Microsoft Windows PowerShell/SA Infegration
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The Get-SasServer cmdlet returns an array of ServervOs that is, in this example, 14
items in length. You can index into this array to examine any one of the Servervo objects.
See Figure 11.

Figure 11 Using the Get-SasServer cmdlet with a Name Filter

-0 x|

= Cwcuments and Settings',pa esktop'powershe

C:documents and settings>Opswarel

C:ndocuments and settings~Opswarel

C:~documents and settings“0psware> Sservers = Get-SasServer —core 192.168.34.
—credential Screds —name linux.win

C:ndocuments and settings\Opsware> Sservers.length

C:sdocuments and settings~Opsware? Sservers[4]

agentUersion
codeset
customer
defaultGu

osSPUersion
peerlP

platform
previousSWRegDate

32h.B.B.17

UTF-8

OpzwarellebServices .CustomerRef
172.16.23%.1

8-28,2087 7:29:53 PM
OpsuwarellebServices .FacilityRef
False

OpswareWebServices.LockInfo

172 _16.239.212
1858881
linux@6 .company.com

MAMAGED
PROUISIONED

172 _16.239.212
OpswarellebServices .PlatformRef
6-2007 4:47:57 AM

psuwarellebServices . RealmRef
True
UNKMOUN

0K
UNKNOUN
1

linux@6 .company.com

UMYARE. .

UMWARE UVIRTUAL PLATFORM

Linux 3A8

172.16.239.212

UMWARE-S56 4D 97 32 24 47 F1 44-3D B@ FE 34 2C B4 88 9@

ozUersion
primarylP
zerialNumber
dirtyAttributes
logChange

modif iedBy
modifiedDate

True

se
8-28-20A7 8:19:39 PM
Automatic

8,28-,2087 7:29:53 PM
OpswarellebServices . ServerRef

PS C:xdocuments and settings~Opswarel _

2 Now you can format the Serverv0 data as HTML and save to a temporary file. The
temporary file is created in the TEMP directory. In a PowerShell session, to get the value
of the $TEMP% environment variable, enter Senv: temp. See Figure 12.

Figure 12 Converting ServerVO Data to HTML and Saving to a Temporary File

w
& C:\Documents and Settings',paul’,Desktop' powershe é =10] %
PS5 C:wdocuments settings~Opsware > -
PE C:wdocuments settingss\Opsware> $serversFile = %Senu:temp + "Sservers.html"

PS8 C:sdocuments
PS8 C:wdocuments

settings~\Opsware’ $servers | ConvertTo-Html > $serversFile
settingssOpsware>

3 Using the New-0Object base Windows PowerShell emdlet you can launch Microsoft Excel,
then create a new workbook inside this instance of Excel, and populate the workbook from
the contents of the temporary file. Finally, set the running Excel instance to be visible.
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This will cause Excel to come to the foreground. Now you can sort the data by date,
column value, etc., to determine, for example, the date on which each server came under
management in the SA Core. SeeFigure 13.

Figure 13 Using the New-Object cmdlet to Launch Microsoft Excel

0] =

- ocuments and Settings’paul,Desktop’,powers|

PS C:~documents settings\Opsware?
PS5 C:sdocuments settings~Opzsware’
PS5 C:wdocuments settingssOpsware> Sapp = New—Object —comobject Excel.Applical
tion
PSS C:~documents settingss0psware?

G:~documents settings“Opsware> $hook = Sapp.Workbooks.Open¢{ %serversFile

PS C:~documents settings\Opsware’
C:ndocuments settings\Opsware? Sapp.Visible = $true
C:sdocuments settings~Opsware? _

Scenario 3

This scenario demonstrates mounting the SA Core as a Windows PowerShell PSDrive,
navigating to the SA Jobs folder and retrieving its contents.

1 Mount the SA Core as a Windows PowerShell PSDrive. PowerShell allows different data
stores or repositories to be navigated as if they were a file system. In this scenario, you
mount the SA Core, specifically the managed environment data store, as if it were a drive
named OPSWorld. The windows PowerShell base system then calls the PowerShell SAS
Provider, -PSProvider OpswareSas, whenever data is read from or written to this
virtual file system — or when the file system is navigated by a client. See Figure 14.

Figure 14 Mounting the SA Core as a Windows PowerShell PSDrive

ocuments and Settings'paul’,Desktop’,

PS C:ndocuments and settings“Opsware>

PS C:idocuments and settings“Opsware? cd

PSS Gy

PE C:%> New—PiDrive —name OPEWorld —root OPSUorld: —core 172.168.34.11 —credenti
al Screds —PSProvider OpswareSas

Provider Root CurrentLocation

OPSWor1d OpswareSas OPSWor1d:

PS5 C:»\> Get—-PSDrive
Provider

FileSystem
lias

FileSystem
Certificate
FileSystem
Environment
Function
Registry HEKEY_CURRENT _USER
Regiztry HEKEY_LOCAL_MACHINE

OPSWor1d OpswareSas OPSWor1d:

R FileSystem R:=~

il FileSystem [IH

Uariahle Uariahle
FileSystem Y

Zz FileSystem Z

~
~
~

2 Change directory to the newly mounted drive and obtain a directory listing. dir is a
PowerShell alias for the Get-ChildItem cmdlet. See Figure 15.
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Figure 15 DIR as an Alias for the Get-Child cmdlet

uments and Settings' pauliDesktop’,powershe

Cind

[ RN

C:\>» cd OPSWorld:
OPSUorld:ny>
OPSUorld:~> dir

Divrectory: OpswarefasPeOpsuarefas:"0PSlorld:-"

LastWriteTime Length Mame

12,/31-1688 Server

123116808 Joh

12,/31-1688 AuditResult

12,31/16808 NetworkDevice

12/31-1688 SnapshotResult
darhs 12,31/1688 Folder

PS OPSWorld:=~>

3 Change directory to the Jobs folder, get a directory listing, and save the directory listing
as a shell variable. This shell variable will contain an array of JobInfoVO objects from

the SA Core into which you can index. See Figure 16.

Figure 16 Save a Directory Listing as a PowerShell Variable

ocuments and Settings',paul,Desktop’ powershel

OPSHorld:~>

OFSWorld:s>

OPSYorld:~> cd Job
QOPSWorld:~Job>
0PSWorld:~Joh? Sjobs = dir
OPSWorld:~Joh}>
0PSWorld:~Joh> 5$jobhs.length

0PSHorld:~Joh>
0PSWorld:~Jobh> 5johs[2]

OpzuwarefasPespswarelas t tOPEUAr1d i sInh
OpswarefasPs\OpswareSas: :0PSWorld:

o
OPSUorld
OpswareSasPs\OpswareSas
True

£
8-29-2087 1:17:47 PH

serverinfo
staleDate
startDate

3
1-1-8001 12:08:88 AM
8-29-.2087 1:17:41 PH
6

Sapin

OpswarellebServices . JobRef

PS 0PSWorld:sJob> (5johs[21>.GetTypel?
IsPublic IsSerial Mame

False JobInfold

PS OPSWorld:sJoh>

Way script: opsware.virtwalization.scan_hypervisors

Opswarellebfervice. ..

Chapter 6



4 Change directory to the C: drive and remove the 0OPSWor1d PSDrive. See
Figure 17.

Figure 17 Removing the OPSWorld PSDrive

ocuments and Settings'paul’,Desktop’,

OFSUorld:s

0PSWor1d:=~2

OPSWorld:s> cd Job
OPSUorld:sJoh>
OPSWorld:=~Jobh}> %$jobs = dir
OPSUorld:sJoh>
OPSWorld:=~Jobh> $jobs.length

OPSWorld:=~Joh>
OPSWorld:~Joh> $johs[2]

OPSUor1ld: Joh
OPSUorld:

OpswareSasPs“\0pswaresa
OpswarelasPss\Opswarela

[i]
OPSWorld
OpswareSasPs\Opswarelas
True

=
5

Way script: opsware.virtualization.scan_hypervisors
>
8,29-28087 1:17:49 PN
serverinfo L]
ctaleDate 1-1-8081 12:00:88 AH
startDate 8,29,2007 1:17:41 PM
[
Zapin

OpzwarelehServices .JobRef

PS OPSWorld:~Joh> (5$johs[21>.GetType{(>
IzsPublic IsSerial Mame BazeType

False JobInfol0O OpswarellebService...

PS OPSWorld:sJoh>

Scenario 4

This scenario describes examining all the types of SA objects available inside the Windows

PowerShell environment.

1 Locate the .NET assembly containing the PowerShell SAS Provider and cmdlets. See
Figure 18.

Figure 18 Locating the .NET Assembly Containing the PowerShell SAS Provider

and cmdlets

ocuments and Settings',paul’,Desktop’powershel
Mindows Powerfhell
Copyright <(C> 2086 Microsoft Corporation. All rights reserved.

PS C:documents and settings“Opsware> cd “PowerShell
PS5 C:PowerShell>
PS C:~PowerShell> dir OpswarelebServices.dll

Directory: Microsoft.PowerShell.CoresFileSystem::C:“\PowerShell

Mode i i Length MHame

—a—— 548864 OpswarellebServices.dll

PS5 C:nPowerShell>

Microsoft Windows PowerShell/SA Infegration
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2 Using .NET Reflection, load the .NET assembly and examine the loaded types. This

displays all the SA types that are available for use in the Windows PowerShell
environment. See Figure 19

Figure 19 Loading the .NET Assembly and Examining the Types

Documents and Settings' paul’,Desktop'powershell -0l
PS G:“PowerShell> I

PS5 G:“FPouwershell> Stypes = L[System.Reflection.Assemblyl::LoadFile< "G:“Pouwershel|
1~0pswarelebServices .d11" >

PS C:“\PowerShell>

PS C:“PowerShell> Stypes.GetTypes{> | more

IsPublic IsSerial Mame BaseType
ZIPService System.leb.Servic...
WindowsUtilityService System.lebh.Servic...
SiteMapService System.lleb.Servic...
SearchService System.lebh.Servic...
MetworkScriptService System.leb.Servic...
FolderService System.lebh.Servic...
DepotService System.Webh._Servic...
APARFilesetService System.lebh.Servic...
PatchPolicyService System.lebh.Servic...
MetworkPortService System.lebh._Servic...
AuthenticationfService System.leb.Servic...
False APARService System.Webh.Servic...
False VirtualServerService System.lleb.Servic...
False SolResponseFileService System.lebh.Servic...
False FilesetService System.lleb.Servic...
False EventCacheService System.lebh.Servic...
False SC0PackagerService System.leb.Servic...
False PolicyService System.lebh.Servic...
False MetworkDeviceGroupService System.lebh._Servic.
False InstallProfileService System.lebh.Servic...
False FacilityService System.lebh._Servic...
False DeviceGroupService Systen.lWeb.Servic...
<SPACE> next page; <CR> next line; @ guit
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3 Create an instance of a NetworkDeviceVO. This is a nascent NetworkDeviceVoO,

showing all of the attributes of a network device available for scripting, reporting etc. in

the PowerShell environment. See Figure 20.

Figure 20 Creating an Instance of a NetworkDeviceVO

ocuments and Setting
PE CG:“PowerShell>

P53 C:“PowerShell>

NATIPAddress
NATRealmName
ROMUersion
TFTPEerverIPAddress
accessMethods

conzolePAddress
consolePort
conzoleRealmMame

eviceGrouplld
eviceGroup2ld
eviceGroup3ld
eviceld

exc ludeFromPoll
feedSource

f irmuwarelerszion

f lashNemory

freePorts
geographicalLlocation
hierarchyLayer
lastAccessAttemptDate
lastfccesslittemptEtatus
lastAccessSuccessDate
lastConf igChangelserld

lastInportDate
lasztModifiedUserId
lastRecordModif iedDate

Microsoft Windows PowerShell/SA Infegration

Jpaul,Desktop’powershell

lastConfigPolicyCheckedDate
lastDuplexDatallpdateDate

=101 |

PS C:“\PowerShell> SnetworkDevice = new—ohject Opst-Jal-el-JehSeruices.HetunrkDeuiceUOi

PS C:“\PowerShell> SnetworkDevice

a
118881 1Z2:88:80 AM

5]
11,0081 12:08:08

11,8081 12:08:80
5]
11,8081 12:08:808
11,0081 12:08:00
11,8081 12:08:808
a

11,0081 12:08:808 hd
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7 Java RMI Clients

Overview of Java RMI Clients

A Java Remote Invocation (RMI) client can call the methods of the SA API from a server that
has network access to the SA core. The server running the client does not have to be an SA
core or managed server. When it connects to the core, the client specifies an SA user name and
password, much like an end user logging on with the SA Client. The group that the user
belongs to determines which SA resources and tasks are available to the client.

This chapter is intended for software developers who are familiar with SA fundamentals and
the Java programming language.

Setup for Java RMI Clients

Before developing Java RMI clients for the SA API, perform the following steps:

1 Install an SA core in a development environment. Do not use a production core.
2 Obtain a development server where you will build and run the Java RMI client.
3 On the development server, install the J2SE v 1.4.2 SDK.
4

Verify that the development server has a network connection to the SA core server that
runs the OCC component.

5 Download the opswclient.jar file from the SA core server to your development server.
The opswclient.jar file contains the Java RMI stubs for the SA API. You include the
opswclient.jar in the classpath option when compiling and running Java RMI clients.

To download opswclient.jar specify the following URL, where occ_host is the core server
running the OCC component:

https://occ _host:/twister/opswclient.jar

Java RMI Example

This section describes a simple Java RMI client named GetServerInfo.

The GetServerInfo client searches for managed servers by full or partial host name, which
you specify as a command-line argument. For each managed server found, the client prints
out the server’s name, management IP address, and OS version.
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The GetServerInfo client performs the following steps:

1

Connects to SA:

OpswareClient.connect ("https", host, (short)port,
userPasswd[0], userPasswd[l], true);

Gets a reference to the ServerService interface:

server3vc = (ServerService)OpswareClient.getService
(ServerService.class) ;

Invokes methods on ServerService:

ServerRef [] serverRefs = serverSvc.findServerRefs (filter);
ServerVO[] serverVOs = serverSvc.getServerVOs (serverRefs);

System.out.println (serverVOs[i].getName ()) ;

Compiling and Running the GetServerlnfo Example

Before compiling and running the example, perform the following tasks:

1
2
3

Obtain the opswclient.jar file, as described in Setup for Java RMI Clients on page 117.
Download the ZIP file that contains the demo program GetServerInfo.java file.

To compile the client, specify the opswclient.jar file for the classpath option:

javac -classpath path/opswclient.jar GetServerInfo.java

To run the client, enter the following command, where target is the full or partial name of
a server managed by SA:

java -classpath .:path/opswclient.jar \
GetServerInfo [options] target

In the following example, Get ServerInfo connects to SA on host c44 (where the OCC core
component runs) and port 443. The program displays information for managed servers
with hostnames that contain the string opsw.

java -classpath .:/home/jdoe/opswclient.jar \
GetServerInfo —--host c44.dev.example.com --port 443 opsw

Respond to the prompts for the SA user name and password. The SA user must have read
permissions for the servers that match the target specified on the command line.
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8 Web Services Clients

Overview of Web Services Clients

The SA API supports Web Services, a programming environment built on open industry
standards such as SOAP (Simple Object Access Protocol) and WSDL (Web Services Definition
Language). You can create Web Services clients in a variety of programming languages such
as Perl and C# (as shown later in this chapter) or with Web Services-enabled development
environments such as Microsoft Visual Studio .NET and BEA WebLogic Workshop.

This chapter is intended for software developers who are familiar with SA fundamentals and
Web Services development.

Programming Language Bindings Provided in This Release

This release of SA includes Web Services client stubs for C#. Web Services clients written in
Perl do not require client stubs.

This release does not include Web Services client stubs for Java or Python. However, Java
clients can access the SA API through RMI and Python clients through Pytwist, as described
in the preceding chapters.

URLs for Service Locations and WSDLs

Clients access the Web Services at URLs with the following syntax, where host is the server
running the OCC core component and port is for the HTTPS proxy. (The default proxy port is
443). The packageName corresponds to the Java library that the service belongs to.

https://host:port/osapi/packageName/WebServiceName

The WSDL files are at URLs with the following syntax:
https://host:port/osapi/packageName/WebServiceName?WSDL

For example, the following URLSs point to the FolderService location and WSDL:
https://occ.c38.example.com:443/o0sapi/com/opsware/folder/FolderService

https://occ.c39.example.com:443/0sapi/com/opsware/folder/
FolderService?wsdl

The SOAP binding style is RPC (Remote Procedure Call) and the transport protocol is HTTPS.
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Security for Web Services Clients

Like other clients of the SA API, Web Services clients must be authenticated and authorized
to perform operations in SA. Communication between clients and the Web Services
component in the SA core is encrypted. Access is restricted to HTTPS clients through the
HTTPS proxy port of the OCC core component. (The default port is 443.)

Overloaded Operations

The SA API has overloaded operations, but the WSDL 2.0 specifications do not support
overloading. An overloaded operation in the SA API is exposed by the Web Service as a single
operation.

Java Interface Support

The SA API uses Java interfaces, but Web Services does not support interfaces. As a
workaround, the WSDL files map interfaces to xsd:anyType. For clients coded in object-
oriented programming languages such as C#, if an API method returns an interface, the
return type must be cast to a concrete class. Arrays of interfaces are converted to Object[];
specific types of the array members are preserved through serialization/deserialization. For a
C# code example, see Handle Interface Return Types on page 131.

Unsupported Data Types

The following data types are used by the SA API but are not supported by SOAP:

java.util.Properties
com.opsware.common.ModifiableMap
com.opsware.acm.ValueSet
com.opsware.swmgmt . PolicyOverrideFilter

Methods Omitted from Web Services

The following SA API methods use unsupported data types as parameters or return types. As
a result, they are not exposed as operations in the Web Services.

com.opsware.custattr.CustomAttribute.getCustAttrs
com.opsware.custattr.CustomAttribute.setCustAttrs
com.opsware.custattr.CustomField.getCustomFields
com.opsware.custattr.CustomField.setCustomFields
com.opsware.pkg.Patch.getPolicyOverrideRefs

Partial Support for java.util. Map

Axis converts java.util.Map to apachesoap:Map, which is a collection of key-value pairs.
With .NET, this conversion does not work. C# clients, for example, will receive an empty array
of key-value pairs. However, this conversion does work with Soap::Lite in Perl. Therefore, SA
API methods that use java.util.Map are available as operations in the Web Services.

The following methods use java.util.Map as parameters or return types:

com.opsware.acm.GroupConfigurable.getApplicationInstances
com.opsware.acm.ServerConfigurable.getCustAttrsWithRC
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com.
com.
com.
com.
com.

opsware

opsware

opsware.
.custattr.VirtualColumnVO.setConfigInfo

opsware

.compliance.sco.CMLSnapshot.getValueSet
opsware.
.compliance.sco.SnapshotResultService.remediateCMLSnapshot

compliance.sco.CMLSnapshot.setValueSet

custattr.VirtualColumnVO.getConfigInfo

Methods in VOs With Unsupported Data Types

The following methods of VOs use unsupported data types as parameters or return types:

com.
com.
com.
com.
com.
com.
com.
com.
com.
com.

opsware.
opsware.
opsware.
opsware.
opsware.
.virtualization.HypervisorInventoryNode.setProperties
.virtualization.VirtualConfigNode.getProperties
.virtualization.VirtualConfigNode.setProperties
.virtualization.VirtualServerConfig.getProperties
.virtualization.VirtualServerConfig.setProperties

opsware
opsware
opsware
opsware
opsware

acm.ApplicationInstanceVO.getValueset
acm.ApplicationInstanceVO.setValueset
acm.ConfigurableVO.getValueset
acm.ConfigurableVO.setValueset
virtualization.HypervisorInventoryNode.getProperties

Invoke setDirtyAtrributes When Creating or Updating VOs

Web Services clients must invoke setDirtyAttributes before invoking a create or update
method on a service. The setDirtyAttributes method explicitly the marks the attributes

(fields) of a VO that need to be set by the create or update invocation. The attribute names
specified by setDirtyAttributes are case sensitive.

For example, to modify the description attribute of a Foldervo object, the following code
invokes setDirtyAttributes before it invokes update:

// fs is FolderService

FolderVO folderVO = fs.getFolderVO (folderRef) ;
folderVO.setDescription ("credit card processing");
folderVO.setDirtyAttributes (new String[]{"description"});
fs.update (folderRef, folderVO, true, true);

Invoking setDirtyAttributes is required for Web Services clients because of the way Axis
deserializes XML objects from XML. If setDirtyAttributes is not invoked, Axis calls setters
on all attributes of the VO, including read-only attributes, resulting in a ReadOnlyException.

Compatibility With SA Web Services APl 2.2

The SA Web Services API 2.2 is not compatible with the SA API described in this guide. The
method signatures, services, WSDLs, and port bindings are not the same. If you are creating
new Web Services clients, be sure to use the SA API, not the SA Web Services API 2.2.

Perl Web Services Clients

This section contains step-by-step instructions and sample code for creating Perl Web Services
clients that access the SA APL.

Web Services Clients
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Required Software for Perl Clients

Your development environment must have the following Perl modules:
e Crypt-SSLeay-0.51

e TO-Socket-SSL-0.95

e Net_SSLeay.pm-1.25

e HTML-Parser-3.35

e MIME-Base64-3.01

e URI-1.30

e libwww-perl-5.76

e SOAP-Lite-0.65_6

If you are running a recent version of ActiveState Perl on Windows, the only module you need
to install is SSL. To install SSL with PPM, perform the following steps:

1 Start PPM, either from the Windows Start menu or by entering ppm.bat at the command
prompt.

2 Enter the following command:
install http://theoryx5.uwinnipeg.ca/ppms/Crypt-SSLeay.ppd
3 Respond to the prompts. The default values should work.

Running the Perl Demo Program

To run the demo program, perform the following steps:
1 Obtain the ZIP file that contains the demo program uapisample.pl file.

2 Edit the uapisample.pl file, changing the hardcoded values for host, username,
password, and object IDs such as serverID.

3 Run uapisample.pl.

Perl Example Code

The following code snippets are from uapisample.pl, a Perl program contained in the ZIP file
you downloaded previously.

Set Up the Service URI

# Construct the URI for the service.

#

my Susername = "integration";

my Spassword = "integration";

my Sprotocol = "https";

my Shost = "occ.c38.dev.example.com";

my Sport = "443";

my ScontextUri = "osapi/com/opsware/";

my $folderServiceName = "folder/FolderService";
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my $folderUri = "http://www.example.com/" . S$contextUri
$folderServiceName;

# Create a proxy to the FolderService.

#
my S$SfolderProxy = S$protocol . "://" . Susername . ":" . S$password . "@"
Shost . ":"™ . Sport . "/" . ScontextUri . S$folderServiceName;

Initiate a New Service

my S$folderPort = SOAP::Lite
-> uri ($folderUri)
-> proxy ($folderProxy) ;

Invoke a Service Method

my $root = $folderPort->getRoot ()->result();
print 'Got root folder: ' . S$root->{'name'} . "\n";

# Alternative:
my $root = $folderPort->SOAP::getRoot () ;
print 'Got root folder: ' . S$root->{'name'} . "\n";

Get a VO

SrootVO = $folderPort->getFolderVO (SOAP: :Data->name ('self')
->value (\SOAP: :Data->name ('id"') ->type ('long')->value (0)))
->result();

# The preceding call to getFolderVO does not pass a FolderRef

# parameter. If a method such as FolderService.remove accepts a

# FolderRef parameter, use the following code:

#

my S$folderToBeRemoved = SOAP::Data->name ('self')

->attr({ 'xmlns:ns fs' => 'http://folder.example.com/FolderService'}) -
>type('ns_fs:FolderRef')—>value(\SOAP::Data—>name('id')—>type('long') -
>value (123456)) ;

SfolderPort->remove ($folderToBeRemoved) ;

# To see the Perl representation of the returned VO, you can use
# the Dumper method. This will help you understand how to

# construct the dirty attributes of a VO for a create or update
# method.

#
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use Data: :Dumper;
print Dumper ($folderVO) ;

Get an Array

# Construct S$folder, the FolderRef before getting the array.

#

my $folder = SOAP::Data->name ('self') ->attr({ 'xmlns:ns fs' => 'http://
folder.example.com'}) —>type('ns_fs:FolderRef')—>value(\SOAP::Data—
>name ('id') ->type ('long') ->value (S$Sroot->{'id'}));

# The getChildren method returns an array of FNodeReference

# objects.

#

my S$children = $folderPort->getChildren ($folder, SOAP::Data->name ('type')-
>type ('string')->value (''))->result();

foreach $child (Q{Schildren}) {
print 'Get child: ' . $child->{'name'} . "\n";

Construct an Object Array

For a function that takes an object array as a parameter,
such the getVOs method, take the following approach:
First, construct the Array object elements individually
and put them in an array.

e

my Qrefs = [];
foreach my S$ref (@{S$myRefs}) {
# Assume myRefs was returned from a previous
# Web Services call.
my $object = SOAP::Data->name ('FacilityRef')
->value (\SOAP: :Data->name ('id")
->type ('long')
->value (Sref->{'id'}
)
)—>attr ({ 'xmlns:facility' => 'http://locality.example.com'})
->type ('facility:FacilityRef');
push @refs, Sobject;

# Second, construct an Array Object and put the array in it.
#
my S$selves = SOAP::Data->name ("selves" =
\SOAP: :Data->name ("element" => Qrefs)-
>type ("facility:FacilityRef"))
—>attr ({ 'xmlns:facility' => 'http://locality.example.com'})
->type ("facility:ArrayOfFacilityRef");
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Update or Create a VO

# This example updates the description attribute of a ServerVo.

#

my S$serverID = 40038;

my Sserver = SOAP::Data->name ('self')->value (\SOAP::Data->name ('id')-
>type ('long')->value ($serverlID) ) ;

# Don’t forget to set dirtyAttributes for the attributes
# you want to update. You also need dirtyAttributes for
# create methods that pass a VO.

#
my @dirtyAttrs = ('description');
my $serverVO = SOAP::Data->name('vo') ->attr({ 'xmlns:ns ss' => 'http://

server.example.com'}) ->value (\SOAP::Data->value( SOAP::Data-

>name ('description')->value ('PERL UPDATE DESC')->type('string'), SOAP::Data-
>name ('logChange')->value ('false')->type ('boolean'), SOAP::Data-

>name ('dirtyAttributes' => \SOAP::Data->name ("element" => @dirtyAttrs)-
>type ("string")) ->type("ns ss:ArrayOf soapenc string"), ));

my S$Sforce = SOAP::Data->name ('force')->value('true')->type('boolean');
my Srefetch = SOAP::Data->name ('refetch')->value ('true')->type ('boolean');

# Call the update method.

#
print 'Invoking method serverWSPort.update...', "\n";
my SupdatedServerVO = $serverWSPort->update (
Sserver,
SserverVo,
Sforce,
Srefetch)->result () ;
print "New description: ", S$updatedServerVO->{'description'}, "\n";

Handle SOAP Faults

Make sure that you turn off on fault subroutine in the
"use SOAP::Lite ..." statement.

The fault member of a SOAP return will be set if the Web
Service call throws an exception.
The following code tries to get a folder that does not exist:

H o HE HE HE HE o

my S$testVO = $folderPort->getFolderVO (SOAP: :Data->name ('self') -
>value (\SOAP: :Data->name ('id"') ->type ('long')->value (123456))) ;

1f (StestVO->fault) {

print StestVO->faultstring . "\n";
# This will print the error msg.
print "ExceptionName: " . getExceptionName ($StestVvO) . "\n"; # A

NotFoundException should be displayed here
# The code that deals with the error goes here....
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# The following subroutine extracts the exception name from the
# returned faultdetail.
#
sub getExceptionName {
my S$fault = shift; #get the fault object
if ($fault->faultdetail->{'fault'}) {
return ref (Sfault->faultdetail->{"'fault'});

}

# As shown in the preceding code, it’s easier to handle SOAP
# faults if you execute functions like this:

#

# my S$data = Sport->function(...);
# Not like this:

# Sport->SOAP: : function(...);

# Sport->function(...)->result;

Construction of Perl Objects for Web Services

Before calling a Web Services operation, a Perl client must set up the data structures that are
required for the input parameters. The information you need for setting up the data
structures is in the API documentation (javadocs) and the service’s WSDL file. The Perl code
example in this section shows how to construct the input parameter for the getServervo
operation. The step-by-step instructions after the code show where to get the information
about the input parameter from the API documentation and the WSDL file.

Source Code for Calling getServerVO

The following Perl code sets up the input parameter self and then calls the getServervo
operation. This call retrieves the VO (value object) for the managed server of ID 12345.

# Create a top-level SOAP::Data object that represents the
# with the name self.

#

Sself = SOAP: :Data->name (' self’)

# The namespace corresponds to the schema of the data type
# of the SOAP:Data object. The name chosen (ns_ss) is

# arbitrary.

#

$self->attr ({'xmlns:ns_ss =>
"http://server.example.com/ServerService’});

# Specify the type (ServerRef) for the parameter self, using the
# name of the namespace from the preceding statement.

#

$self->type ('ns_ss:ServerRef’);

# Create the value for the parameter. The value is a pointer

# to a SOAP::Data object. The number 12345 is the SA ID of # a managed server.
#

my $id = SOAP::Data->name (’id’)->type (' long’)->value (12345) ;
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# From the self object, point to the value.

#

$self->value (\$id) ;

# Finally, call getServerVO:

#

my Sdata = $serverPort->getServerVO ($self);
if (Sdata->fault) {

}

# Handle exceptions here

else(

my S$serverVO = S$data->result;

Location of Information for getServerVO Setup

To get the information needed to write the code for the call to getServerVvo, perform the
following steps:

1

In a browser, go to the API documentation (javadocs) at the following URL:
https://occ _host:1032/twister/docs/index.html

The occ_host is the IP address or host name of the core server running the Command
Center component. (For instructions on invoking methods with the Twister, see API
Documentation and the Twister on page 21.)

Examine the API documentation to determine the input parameters and return value of
the method.

The getServervo method is defined in the interface
com.opsware.server.ServerService. In the following method signature, note that
getServerVO accepts a ServerRef as a parameter and returns a ServerVo:

public ServerVO getServerVO (ServerRef self)
throws java.rmi.RemoteException,
NotFoundException,
AuthorizationException

In a browser, specify the following URL to open the WSDL file for the ServerService:
https://occ _host/osapi/com/opsware/server/ServerService?wsdl
In the WSDL file, locate the namespace for the ServerService:

<schema targetNamespace="http://server.example.com" xmlns="http://
www.w3.0rg/2001/XM
LSchema">

The following Perl statement (from the code listed previously) specifies the namespace:

$self->attr ({'xmlns:ns_ss =>
"http://server.example.com/ServerService’});

In the WSDL file, locate the getServerVvo operation and note the input message name
getServerVORequest.

<wsdl:operation name="getServerVO" parameterOrder="self">

>

Web Services Clients

<wsdl:input message="impl:getServerVORequest" name="getServerVORequest"/>
<wsdl:output message="impl:getServerVOResponse" name="getServerVOResponse"/
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<wsdl:fault message="impl:NotFoundException" name="NotFoundException"/>
<wsdl:fault message="impl:AuthorizationException"
name="AuthorizationException"/>
</wsdl:operation>

6 In the WSDL file, locate the getServerVORequest message:

<wsdl:message name='"getServerVORequest'>
<wsdl:part name="self" type="impl:ServerRef"/>
</wsdl:message>

The getServerVORequest message element defines the name (self) and type
(ServerRef) of the input parameter of getServervo. The following Perl statement
specifies ServerRef:

$self->type ('ns_ss:ServerRef’);
7 In the WSDL file, locate the complexType for ServerRef:

<complexType name="ServerRef">
<complexContent>
<extension base="tnsl:ObjRef">
<sequence>
<element name="secureResourceTypeName" nillable="true"
type="soapenc:string"/>
</sequence>
</extension>
</complexContent>
</complexType>

Note that ServerRef extends ObjRef.
8 In the WSDL file, locate the complexType for ObjRef:

<complexType abstract="true" name="ObjRef">
<sequence>
<element name="id" type="xsd:long"/>
<element name="idAsLong" nillable="true" type="soapenc:long"/>
<element name="name" nillable="true" type="soapenc:string"/>
</sequence>
</complexType>

In ObjRef, note the name (id) and type (1ong). These data types are specified in the
following Perl statement:

my $id = SOAP::Data->name (’id’)->type (' long’)->value (12345) ;
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C# Web Services Clients

This section contains step-by-step instructions and sample code for creating C# Web Services
clients that access the SA APL.

Required Software for C# Clients

To develop C# Web Services clients, your development environment must have the following
software:

e  Microsoft NET Framework SDK version 1.1
e C# client stubs for SA API

Obtaining the C# Client Stubs

SA provides a stub file for each service, for example, FolderService.cs. All stubs have the
same namespace: OpswareWebServices. In addition to the stubs, SA provides shared.cs, the
file that contains shared classes such as ServerRef.

To obtain a ZIP file containing the C# stubs, specify the following URL, where occ_host is the
core server running the OCC component:

https://occ _host:1032/twister/opswcsharpclient.zip

The constants defined in services and objects are not defined in the C# stubs. To get
information about the constants, use the API documentation (javadocs), as described in
Constant Field Values on page 22.

Accessing the C# Stub Documentation

Reference documentation generated by Ndoc is available as a compiled Windows help file that
is contained in the same ZIP file as the C# stubs. (NDoc generates code documentation from
the from .NET assemblies and the XML documentation files output by the C# compiler.) This
reference documentation contains syntax (but not descriptive) information about the class
hierarchy and member method signatures. For descriptions, see the corresponding javadocs as
explained in API Documentation and the Twister on page 21.

To access the C# stub documentation, perform the following steps:
1 Download the opswcsharpclient. zip file from the URL shown in the previous section.
2 Unzip opswcsharpclient.zip.

3 In Windows, open the wscsharplcient.chm file.

Building the C# Demo Program

To build the demo program, perform the following steps:
1 Obtain the ZIP file that contains the following demo program files:
e App.config - Application settings
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® JebServicesDemo.cs - Client code that invokes service methods
e MyCertificateValidation.cs - Certificate validation class
Create the following directory:

C:\wsapi

From the Visual Studio.NET 2003 Start Page, select New Project and create a project with
the following values:

e  Project Type: Visual C# Projects

e Template: Console Application

e Name: WSAPIDemo

e Location: C:\wsapi

This action creates the new directory C:\wsapi\WSAPIDemo, which contains some files.
In the new project, delete the default file Classl.cs from the list of objects.

Copy the files you obtained in step 1 into the C:\wsapi\WSAPIDemo directory.

Download the client stubs from the URL specified in Obtaining the C# Client Stubs on
page 129.

Copy the C# client stubs into the C:\wsapi\WSAPIDemo directory.

Add the files copied in the preceding two steps to the WSAPIDemo project:

¢ In Visual Studio.NET, from the File menu, select Add Existing Item.

¢ Browse to the directory C:\wsapi\WSAPIDemo, and select each file, one at a time.
Add a reference to System.Web.Services.dll:

¢ In Visual Studio.NET, from the Project menu, select Add Reference.

e Under the .NET tag, browse to Component with Name: System.Web.Services.dll.
e C(Click System.Web.Services.dll, click Select, and then click OK.

If you used a different template when creating the project, you might need to add
references to System, System. XML, and System.Data. Check the Project References to
determine if you need to add these references.

In the App.config file, change the values for username, password, host, and the
hardcoded object IDs such as serverID.

In Visual Studio.NET, from the Build menu, select Build WSAPIDemo.

Running the C# Demo Program

To run the demo program, perform the following steps:

1

Open the Visual Studio .NET 2003 command prompt:

Start » All Programs » Microsoft Visual Studio .NET 2003 »
Visual Studio .NET Tools » Visual Studio .NET 2003 Command Prompt Change

Change the directory to:

C:\wsapi\WSAPIDemo\bin\Debug
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3 Enter the following command:

WSAPIDemo.exe

C# Example Code

The following code snippets are from WebServicesDemo.cs, a C# program contained in the
ZiP file you downloaded previously.

Set Up Certificate Handling

# This setup is required just once for the client.
#

ServicePointManager.CertificatePolicy = new MyCertificateValidation();

Assign the URL Prefix

# This is the URL prefix for all services.

#
wsdlUrlPrefix = protocol + "://" + host + ":" + port + "/" + contextUri + "/";

Initiate the Service

FolderService fs = new FolderService();
fs.Url = wsdlUrlPrefix + "com.opsware.folder/FolderService";

Invoke Service Methods

FolderRef root = fs.getRoot():;
FolderVO vo = fs.getFolderVO (root) ;

Handle Interface Return Types

In the API, FolderVO.getMembers returns an array of
FNodeReference interfaces, but Web Services does not support
interfaces. In the C# stub, the return type of
FolderVO.members is Object[]. If a returned Object type will
be used as a parameter that must be a specific type, then you
must cast it to that type. For example, the following code
casts elements of the returned array to FolderRef as
appropriate.

S S e HE $E 3E 3E 3E

Object[] members = vo.members;
for (int 1=0; i<members.Length;i++)
{
Console.WritelLine ("Got object: " + members[i].GetType () .FullName + " --> " +
((ObjRef)members[i]) .name) ;
if (members[i] is FolderRef) {
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Console.WritelLine ("I am a FolderRef: " +
((FolderRef)members[i]) .name) ;
}

Update or Create a VO
# When updating a VO, the changed attributes must be set in
# dirtyAttributes. (The VO passed to a create method has
# the same requirement.)
#
# Note: If you update a VO that was returned from a service
# method invocation, such as getFolderVO, then you must
# set the logChange attribute of the VO to false:
# vo.logChange = false;
#
# The following code changes the name of a folder.
#

Console.WriteLine ("Changing name from " + vo.name +
" to yo csharp.");

vo.name = "yo csharp";

vo.dirtyAttributes = new String[]{"name"};

# Manually set dirty fields being changed.

#

vo = fs.update(folder, vo, true, true);
Console.WritelLine ("Folder name changed to: " + vo.name);

Handle Exceptions

.NET converts Web Services faults into SoapExceptions
without trying to deserialize them into application
exceptions first. As a result, your code cannot catch
application exceptions. As a workaround, the C# stubs
provided by SA include SOAPExceptionParser,

a class that enables you to get information from
SOAPExceptions. The following code shows how to get the
exception name and error message by calling the getDetail
method of SOAPExceptionParser.

e

try{

// Try to get a non-existent folder here.

} catch (SoapException e) {
SoapExceptionDetail detail =
SoapExceptionParser.getDetail (e) ;

Console.WriteLine ("SoapExceptionDetail.name: " +
detail.exceptionName) ;
Console.WriteLine ("SoapExceptionDetail.msg: " +

detail.message) ;
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Password Security with C#

The FolderService method reads the user and password pair from the file App.config. The
following shows an example of this method.

User user = new User();

user.username = "user";

user.password = "password";

FolderService fs = new FolderService():;

fs.Url = wsdlUrlPrefix + "com.opsware.folder/FolderService";
fs.user = user;

If you do not want to store the password in clear text in the App.config file, you can use the
SecureUser class to encrypt the password. The SecureUser class uses the C# SecureString in
.NET 2.0. Passwords are stored encrypted in a SecureString. Furthermore, the getPassword()
method is only visible internally. SecureUser is a static class, so you only need to set your user
name and password once or each time you switch users. Each service retrieves the user name
and password from SecureUser first and then its user member variable and then App.config,
for backward compatibility. SecureUser takes either a String or a SecureString for the
password. In either case, clients are responsible to clean up the password variable passed to
the SecureUser.setUser() method.

At some point the password will need to be converted to a regular C# string in memory, which
will only get freed when the next garbage collection occurs. Using SecureUser will only ensure
internal password storage is secure.

The following example shows how to set the user name and password securely.

SecureString passwd
passwd.AppendChar ('
passwd.AppendChar (
passwd.AppendChar (
passwd.AppendChar (
passwd.AppendChar ('

(

r

new SecureString();
\} A} .

p")
a')
's');
lsl).

w')

d

A}

passwd.AppendChar ('
SecureUser.setUse
for each service.
passwd.Dispose(); // resets passwd and frees up memory so no copy remains from
caller.

')

("username", passwd); // that's it, no need to set up user
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9 Pluggable Checks

Overview of Pluggable Checks

The SA Audit and Remediation feature enables you to define and monitor the compliance
information for SA managed servers. Because compliance standards are continuously
evolving, SA lets you create specialized custom checks and policies, and extend those provided
with SA. A pluggable check is an audit rule, which belongs to one or more audit policies. You
create a pluggable check in a command-line environment, upload the check, and then add it to
an audit policy with the SA Client.

This chapter is intended for software developers who are familiar with XML and with the
Audit and Remediation feature of SA.

Setup for Pluggable Checks

Before developing pluggable checks, perform the following steps:
1 Install an SA core in a development environment. Do not use a production core.

2 On a server that has an installed Agent, install OCLI 1.0. For information on the OCLI,
see the SA User Guide: Server Automation.

Pluggable Check Tutorial

This tutorial shows how to create a pluggable check named HelloWorld Check. This simple
check verifies that the /var/tmp/helloworld file exists on a Unix managed server. If the file
does not exist, the remediation script of the pluggable check creates the file.

To develop the HelloWorld Check, perform the following steps:

1 Follow the instructions in Setup for Pluggable Checks on page 135. The server where you
install OCLI 1.0 will be the development server for this tutorial.

2 The HelloWorld Check example code is included with the ZIP file that contains the API
code examples.

3 Unzip the file you downloaded in the preceding step and verify that the
pluggable checks/helloworld directory contains the following files:

config.xml
gethelloworld.py
sethelloworld.py
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The HelloWorld check is made up of these three files. The config.xml file is a
configuration file. The gethelloworld.py Python script performs the audit. The
sethelloworld.py Python script performs the remediation. In the following steps, you
package these files into a ZIP file and then import the ZIP file into SA.

On your development server, copy the unzipped helloworld files to a working directory,
for example:

cd /home/jdoe/dev

mkdir helloworld

cd helloworld

cp unzip dest/pluggable checks/helloworld/*

Obtain a Globally Unique ID (GUID). Each pluggable check requires a GUID. You can
acquire a valid GUID by using one of the following techniques:

— Log on to web sites such as the following:
http://kruithof.xs4all.nl/uuid/uuidgen
— Download the free Windows tool guidgen from:

http://www.microsoft.com/downloads/details.aspx?FamilyID=94551F58-484F-
4A8C-BB39-ADB270833AFC&displaylang=en

If you programmatically create your GUIDs, then your code should conform to RFC4122
(http://www.ietf.org/rfc/rfcd4l22.txt).

With a text editor, insert the GUID in the config.xml file, for example:
<checkGUID>6c7ed38c-d8d6-11db-8314-0800200c%a66</checkGUID>

This is the only element in config.xml that you need to modify for this tutorial.
In the text editor, save config.xml with the change you made for the GUID.

Keep the text editor open. Throughout this tutorial, you will examine various elements in
config.xml to learn how they map to the Python scripts and the SA Client display fields
of the HelloWorld Check.

In the config.xml file, note the following elements, which are related to the audit (get)
and remediation (set) scripts of the HelloWorld Check:

<!-- The name of the script that performs the check. -->
<checkGetScriptName>gethelloworld.py</checkGetScriptName>

<!-- The name of the script that remediates the audit. -->
<checkSetScriptName>sethelloworld.py</checkSetScriptName>

<!-- The exit code of the gethelloworld.py script will be checked.-->
<checkReturnType>EXITCODE</checkReturnType>

<!-- A string argument is passed to gethelloworld.py. -->
<checkGetArgumentType>STRING</checkGetArgumentType>

<!-- The default argument for gethelloworld.py is the name of the file the
script is checking for. -->
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<checkGetArgumentDefaultValue>/var/tmp/helloworld
</checkGetArgumentDefaultvValue>

<!-- If the helloworld file exists, the exit code of gethelloworld.py is O.
-—>
<checkSuccessExitCodeValue>0</checkSuccessExitCodeValue>

<!-- If the helloworld file does not exist, the exit code of
gethelloworld.py is 1. —-->
<checkSuccessExitCodeValue>1</checkSuccessExitCodevValue>

9 Examine the gethelloworld.py script, which performs the audit by checking for the
existence of the file /var/tmp/helloworld. You do not need to edit this script for this
tutorial. Later in this tutorial (step 29 on page 141), when you run the audit in the SA
Client, this script executes on a managed server.

The /var/tmp/helloworld string is the default argument of the script, as indicated by
the value of <checkGetArgumentDefaultValue> in config.xml. The script’s exit
code (result) corresponds to the values specified for <checkSuccessExitCodes>.

Here is the source code for the gethelloworld.py script:

import sys
import os
import string

if name == " main ":

if len(sys.argv) != 2:
sys.stderr.write ("No argument found! Please enter a
file name!\n")
sys.exit (220)

filename = sys.argv[1l]

if os.path.isfile(filename) or os.path.isdir (filename) :
result = 0

else:
result =1

sys.stderr.write ("Debugging: Found result %$s\n"

$ result)
sys.stdout.write ("$s\n" % result)

sys.exit (result)

10 Next, examine the remediation script sethelloworld.py, which creates the
/var/tmp/helloworld file. This script runs on a managed server if you decide to
remediate the audit in step 34 on page 141. Do not change the script for this tutorial.

The source code for sethelloworld.py follows:

import sys
import os
import string
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if name == " main ":

if len(sys.argv) != 2:
sys.stderr.write ("No argument found!
Please enter a file name!\n")
sys.exit (220)

filename = sys.argv[l]
if os.path.isfile(filename) or os.path.isdir (filename) :
# Do nothing because the file already exists.
pass
else:
try:
fd = open(filename, "w")
fd.write(" ")
fd.close()
except:
sys.stderr.write ("Could not open file %s for
writing!\n" % filename)
sys.exit (220)

# Exit successfully with a 0 exit code.
sys.stderr.write ("Successfully created file\n")
sys.exit (0)

Package the HelloWorld Check.

To package the HelloWorld pluggable check, archive the contents of the working directory
into a single ZIP file, for example:

cd /home/jdoe/dev/helloworld
zip ../helloworld.zip *

Verify that the ZIP file contains the two Python scripts and the config.xml file by
entering the following unzip command:

unzip -t ../helloworld.zip

testing: config.xml OK
testing: gethelloworld.py OK
testing: sethelloworld.py OK

No errors detected in compressed data of ../helloworld.zip.
Import the pluggable check into SA with the oupload command of OCLI 1.0:

oupload -C"Customer Independent" \
-t"Server Configuration Check" \
--forceoverwrite --old -0"SunOS 5.8" ../helloworld.zip

Note: The platform option (-0) is Sun0OS 5.8 for all Unix and Linux checks. For Windows
checks, the platform option is Windows 2003.

If oupload does not run successfully, make sure that you have installed the correct
version of OCLI 1.0, set the PATH environment variable correctly, and included the 1ogin
file in your environment. For details on these requirements, see the OCLI 1.0 in the SA
User Guide: Server Automation.
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Open the SA Client.

In the next few steps, you create a new audit, adding to it the HelloWorld Check you
imported with the oupload command.

From the Tools menu, select Update Cache.

From the Navigation pane, select Library » By Type » Audits and Remediation »
Audits » Unix.

From the Actions menu, select New.
In the Audit Window, in the Name field of the Properties pane, enter HelloWorld Audit.
In the Views pane, select Rules » File System.

The Content pane should list the HelloWorld Check under Available for Audit, as shown
in Figure 21.

Figure 21 HelloWorld Check in the Rules for a File System

' Rules > File System

Source @ [(hot zet)
Available for Audit:

[ File Sy=stem
= [} Specific File System Rules
= LJ iy Custom Checks
[ Hellgworld Check

.

20 In the config.xml file, note the following elements, which are related to the information

21
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displayed in Figure 21:

<!-- The check name is the rule name shown in the SA Client. -->
<checkName>HelloWorld Check</checkName>

<!-- The category corresponds to the rule hierarchy displayed by the SA
Client. —-->
<checkCategory>File System|My Custom Checks</checkCategory>

In the Audit Window of the SA Client, under Available for Audit, select HelloWorld Check

and click the plus sign.
The Content pane should list the details for HelloWorld Check, as shown in Figure 22.
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Figure 22 HelloWorld Check Rule Details
Rule Details: HelloWaorld Check
Description Test ID

helloworid 1
Check that Awar/tmp/helloworld exists.

Input Values

File: Marne % Walue | | bvartrphelionarld
Target Yalue

Operstor: Reference: Walue:

= » | Value | File existz

Remediation: HelloWorld Check

Remediation Yalue
File Marme Wallie | | deartmphelloseorld

22 In the config.xml file, examine the following elements, which are related to the
information displayed under Rule Details in Figure 22:

<!-- The following value appears under Description in the Rule Details of
the SA Client. -->

<checkDefaultDescription>

Check that /var/tmp/helloworld exists.

</checkDefaultDescription>

<!-- The following element corresponds to the Test ID in the SA Client. -->
<checkTestID>helloworld 1</checkTestID>

<!-- This label is under Input Values in the SA Client. -->
<checkGetArgumentDefaultLabel>File Name
</checkGetArgumentDefaultLabel>

<!-- The default argument to the gethelloworld.py script also appears
under Input Values in the SA Client. -->
<checkGetArgumentDefaultValue>/var/tmp/helloworld
</checkGetArgumentDefaultValue>

23 In the Views pane of the SA Client, select Targets.

In the following steps you add a target server to HelloWorld Audit. In later steps, the
gethelloworld.py and sethelloworld.py scripts will run on the target server.

24 1In the Contents pane, click Add.
25 In the Select Server window, drill down to a server and click OK.
26 In the Audit window, select File » Save.

At this point, the HelloWorld Audit contains the HelloWorld Check (rule) and is associated
with a target server.

27 In the Audit window, from the Actions menu, select Run Audit.
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28 Step through the windows of the Run Audit task.
29 In the Run Audit window, click Start Job.

This action launches the job that runs the gethelloworld.py script on the target server.
30 After the job has completed, click View Results.
31 In the Views pane of the Audit Result window, select Policy Rules (1).
32 In the Content pane of the Audit Result window, open HelloWorld Check.

The Difference Details window should appear, as shown in Figure 23.
Figure 23 HelloWorld Check Difference Details

Difference Details: HelloWorld Check g|

R,
HelloWorld Check

Source: Target:

Device Mame or Reference Type: Walue i1 71 .dev .opsyvvare .com
IP Address (if Device): 192168197 244

Input Walues:
File: Matne:  Mvartmpihelloworld

Check Type: exitcode
Operator: =

Policy Walue: File exists

Actual Yalue: File does not exist

[ Remediate... ][ Cloze ]

33 Inthe config.xml file, note the following elements, which are related to the information
displayed in the Difference Details window of Figure 23:

<!-- The following value appears as the Policy Value in the Difference
Details window. -->

<checkSuccessExitCodeDefaultDisplayName>

File exists</checkSuccessExitCodeDefaultDisplayName>

<!-- The next value appears as the Actual Value in the same window. —-->
<checkSuccessExitCodeDefaultDisplayName>
File does not exist</checkSuccessExitCodeDefaultDisplayName>

34 If you want to create /var/tmp/helloworld on the target server, on the Differences
Window, click Remediate.

This action runs the sethelloworld.py script. For more information, see the SA User
Guide: Audit and Compliance.
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Overview of Audit and Remediation

Sarbanes-Oxley (SoX), Information Technology Infrastructure Library (ITIL), and ISO20000
make it urgent to keep server configurations in compliance. The SA Audit and Remediation
feature offers you a well-organized set of policies to help you address compliance issues. A
graphical interface makes it easy for you to select and run audits against specified servers,
and see how well they comply with professional standards.

Audit and Remediation also simplifies system administration. For example, you might
monitor a class of servers that run a home grown application built by your team, such as a
database server or middleware application. As you configure and monitor the servers that run
the application, you keep a list that tracks the ideal state of the configuration. Such a list
might include file, directory, and network share permissions.

You can create an audit that defines these configurations, then audit the servers after
installing the application. The audit results will confirm whether or not the application is
installed and has been configured successfully according to your criteria. If the configuration
is non-compliant, you can create an ad-hoc audit to troubleshoot the problem. When the audit
results indicate an error, you can remediate the server to match your ideal configuration. To
ensure that the configuration change works in production, you can set the audit to run on a
configurable schedule and have a notification sent upon completion.

Showing a window for selecting an audit, Figure 24 includes the following callouts:

e Callout A: Any category listed in the Views panel may have SA non-modifiable
capabilities, or modifiable pluggable checks.

e Callout B: This points to the SA capabilities for dealing with Windows services.
e Callout C: This lists pluggable checks for working with Windows Services.
Figure 24 Windows Services Audit Rule
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Each check evaluates one rule. Several checks can be bundled together into a policy.
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The SA Audit and Remediation feature comes with many out-of-the-box checks. You can run
most audits by selecting the desired check. The choice of audits grows continuously as
developers design, code, test, and add more checks to the system through the HP Live
Network. These checks are imported as complete policies.

However, since every business has unique challenges and unique resources, you may need to
determine compliance against a set of criteria not available for auditing within the SA Audit
and Remediation framework. For this reason, the system provides a way to create your own
custom pluggable checks.

The Audit and Remediation feature evaluates, by specific rules, the compliance state of
servers under SA management. This feature can also remediate the servers that do not match
the desired configuration state as defined in the rules. These rules include various server
parameters, registry values, file permissions, application configurations, file existence, COM+
objects, and more.

In the Windows environment, web server rules can also be specified with application
configuration, which is based upon the Microsoft Internet Information Services (IIS) Web
server configuration file, UrlScan.ini. SA can compare partial or full values from specific
configuration files, select the desired elements from the file, and make sure that these values
or configuration file entries exist. For more information, see the SA User Guide: Application
Configuration.

SA includes many predesigned audit rules. Each defines a desired state of configuration for a
server or server groups. Some rules are value-based, providing a comparator ( <, >, ==, !=,
contains, etc.), a value or set of values, and one or more checks, which spell out the underlying
code used to evaluate the state of the audited item or items. The comparison data determines
compliance or non-compliance. A rule may also contain remediation values if the check
supports remediation.

A rule consists of a single check. You can create new functionality by using custom content
objects in the form of pluggable checks. You can also bundle related pluggable checks into
audit policies for convenience.

Pluggable Check Creation

Pluggable Checks

A pluggable check is code that is downloaded to the managed server or servers and is executed
by the Audit and Remediation framework. You can use checks to extend the native Audit and
Remediation properties and to provide additional specialized functionality. Each pluggable
check includes a customized config.xml file and at least one script that compares the audited
feature against values specified in the config.xml file. A pluggable check may also include a
script that sets specified variables in the audited server to the value specified in the
config.xml file. You can write pluggable check scripts in Python 1.5.2 or Python 2, Visual Basic
Scripting (VBS), BAT, or shell script. A pluggable check is packaged as a zip archive.

Most of the CIS checks are direct translations of the CIS benchmarks. More information can
be found at http://www.cisecurity.org.

Most types of checks fall into one of the following categories:
e  Windows Registry checks

e Unix Services checks
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e User checks, which may use password or shadow file information

Guidelines for Pluggable Checks

To simplify server maintenance, adhere to the following guidelines:

e  When creating a new pluggable check, pay special attention to the names. Describe the
purpose of the check, and replace spaces with an underscore. For example,
Users Without Password Expiration is self-explanatory. This will help you to find a
check quickly when a server acquires several hundred or more checks.

e  Write a generic check. This enables you to easily create additional checks of the same
execution type with only a few lines of code change. For example, for most CIS2k3
Windows Service Checks, you can change a single line of code to create a new check for a
new service.

¢  When naming the audit (get) and remediation (set) scripts, remove the spaces or
underscores from the directory name, and prefix with get or set, as appropriate. For
example, getUsersWithoutPasswordExpiration.sh is a good name for an audit file. Be
consistent on this, even if you think your custom check will not be used by anyone else.

e Pay attention to error checking. Remember that unexpected return values might report an
audit as non-compliant when a script failure occurs. Trap the unexpected error or
exception, and write out information about it to stdout or stderr to simplify
troubleshooting.

e Convert most checks to a simple binary case of True or False when possible.

e Always try to handle not only the specific benchmark case, but also its counterpart. For
example, you can easily create a “Disable Service X,” pluggable check at the same time
that you create an “Enable Service X” and reuse most of the code. This can be useful if you
decide later to test for the opposite condition.

e Use the standard exit codes defined by the framework whenever possible. These are:

EXIT FAILURE=220
EXIT ERR USAGE=221
EXIT ERR INVALID 0S=222

e  When returning disabled or enabled in a Boolean type check, return 0 for disabled, 1 for
enabled.

e Package each pluggable check as a ZIP archive. A single file system directory contains the
files listed in Table 23.

Table 23 Pluggable Check Contents

File Name Description

config.xml (Required) The XML configuration file defining how this
pluggable check executes, returns, and ultimately reports
compliance or non-compliance.
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Table 23 Pluggable Check Contents (cont’d)

File Name

Description

getName. {py | sh | BAT

| vbs}

(Required) The audit script, written in Python, VBS, BAT, or
shell, that evaluates the audited object, and returns text and
exit codes according to the config.xml definitions.

setName. {py | sh | BAT

| vbs}

audit script.

(Optional) The remediation script, written in Python, VBS,
BAT, or shell, that remediates the condition checked by the

Additional Code,

Scripts, or Libraries

the audit or remediation scripts.

(Optional) Helper and supplementary scripts used by either

) The file names for the audit and remediation scripts do not need to begin with get and set, but

this convention simplifies file maintenance.

The following example shows a directory structure for a pluggable check:

./check name/

./check name/config.xml
./check name/getcheckname.py
./check name/setcheckname.py

Development Process for Pluggable Checks

Figure 25 shows an overview for the development process, which takes place in a command-

line environment.

Figure 25 Development Process
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Pluggable Check Configuration (config.xml)

The config.xml file is a specification file for the pluggable check that contains elements to
control how this check appears in the SA Client, default values, value types for comparison,
and the category of the check. For example, the following element in the config.xml file
determines the pluggable check’s rule category in the SA Client:

<checkCategory>Windows Services</checkCategory>

Standard categories, each indicated with its own icon, include hardware, software, operating
systems, users and groups, file systems, and more, as shown by Figure 26.

Figure 26 Pluggable Check Categories in the Rule Hierarchy
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The following listing shows the template for the config.xml file:

<?xml version="1.0" encoding="UTF-8"?>

<!DOCTYPE checkConfiguration SYSTEM "check.dtd">

<checkConfiguration version="1.0">

<checkName>$CHECKNAME</checkName>

<checkGUID>$CHECKGUID</checkGUID>
<checkDefaultDescription>$CHECKDESCRIPTION</checkDefaultDescription>
<checkRemediationDefaultDescription> $CHECKREMEDIATIONDESCRIPTION </
checkRemediationDefaultDescription>
<checkGetScriptName>$SGETSCRIPTNAME</checkGetScriptName>
<checkGetScriptType>PY</checkGetScriptType><!-- Or SH for shell, BAT for Bat,
VBS for Visual Basic -->
<checkSetScriptName>$SETSCRIPTNAME</checkSetScriptName><!-- Optional -->
<checkSetScriptType>PY</checkSetScriptType><!-- Optional -->
<checkVersion>32b.0-1.0</checkVersion>
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<checkReturnType>SRETURNTYPE</checkReturnType> <!-- EXITCODE, STRING, or
NUMBER -->
<checkTestIDs>
<checkTestID>$CHECKTESTID</checkTestID> <!-- Optional -->
</checkTestIDs>
<checkPlatformTypes>
<checkPlatform>$PLATFORMTYPE</checkPlatform> <!-- Currently Unix or Windows --
>
</checkPlatformTypes>
<checkCategories>
<checkCategory>$CATEGORY</checkCategory> <!-- Top-level GUI category -->
</checkCategories>
<checkGetArguments> <!-- All arguments are optional -->
<checkGetArgument>
<checkGetArgumentType>SGETARGTYPE</checkGetArgumentType> <!-- STRING or NUMBER
-—>
<checkGetArgumentDefaultLabel>$GETDEFAULTLABEL</
checkGetArgumentDefaultLabel>
<checkGetArgumentDefaultDescription>$GETDEFAULTDESCRIPTION</
checkGetArgumentDefaultDescription>
<checkGetArgumentDefaultValue>$GETDEFAULTVALUE</
checkGetArgumentDefaultValue>
</checkGetArgument>
</checkGetArguments>
<checkSetArguments> <!-- Also optional -->
<checkSetArgument>
<checkSetArgumentType>$SETARGTYPE</checkSetArgumentType>
<checkSetArgumentDefaultLabel>$SETDEFAULTLABEL</
checkSetArgumentDefaultLabel>
<checkSetArgumentDefaultDescription>$SETDEFAULTDESCRIPTION</
checkSetArgumentDefaultDescription>
<checkSetArgumentDefaultValue>$SETDEFAULTVALUE</
checkSetArgumentDefaultValue>
</checkSetArgument>
</checkSetArguments>
<checkSuccessExitCodes> <!-- Only for EXITCODE type checks, generally at least
two entries --—>
<checkSuccessExitCode>
<checkSuccessExitCodeValue>$SEXITCODEVALUE</checkSuccessExitCodeValue>
<checkSuccessExitCodeDefaultDescription>$EXITCODEDESCRIPTION
</checkSuccessExitCodeDefaultDescription>
<checkSuccessExitCodeDefaultDisplayName>$EXITCODEDISPLAYNAME
</checkSuccessExitCodeDefaultDisplayName>
</checkSuccessExitCode>
</checkSuccessExitCodes>
</checkConfiguration>

For more details, see Document Type Definition (DTD) for config.xml File on page 151.

Audit (get) Scripts

You can design the audit script, also known as the get script, to obtain a value from a
managed server. The script is executed with optional parameters, as specified in the
config.xml file. If the script is running an EXITCODE check, the result of the script is
compared to the exit codes specified in the config.xml file. For STRING and NUMBER
return type checks, the result is compared to what is written to STDOUT.
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An audit script has a set of pre-defined return codes. You can define additional return codes in
the check config.xml file.

The audit script may display informational messages. These messages are useful when
troubleshooting an audit script failure. Review the following sample Python audit script:

import sys
import os
import string

if name == " main ":
# If there are get arguments they will be loaded into sys.argv

# Enter the desired check code here
# Example:
# Looking for file "/usr/bin/ssh"

if os.path.isfile("/usr/bin/ssh"):
result =1

else:
result = 0

# Case A:

# If number/string check, the results are grabbed from # stdout.
# All debugging statements must be sent to stderr so as not

# to be picked up.

sys.stderr.write ("Debugging: Found result %s\n" % result)

sys.stdout.write (result)

# Case B:

# If exitcode check, the results are returned by the argument
# passed to sys.exit (). The exitcodes must match the

# ExitCodeValues defined in the config.xml file.

sys.exit (result)

Remediation (set) Scripts

You can design the remediation script, also known as the set script, to enact a change on the
managed server that would cause the audit script to return success when completed. The
script is executed with optional parameters, as specified in the check config.xml file.

These set scripts are optional, and can vary in character from being very similar to their
counterpart get scripts to entirely different (and longer).

From a shell standpoint, there is nothing special in the script itself, other than the return
codes being used. Most checks display some debug output or information messages. This is not
normally seen by users, except in the event of a script failure, where the messages are useful
for troubleshooting purposes.

As a standard practice, always include at least one parameter to the set script. Also,
remember to modify the config.xml file so that it displays nicely in the SA Client when
adding a set script to an already existing check.
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Make sure your remediation scripts exit with exit code 0 to indicate success. All other exit
codes will indicate failure of the remediation operation.

Review the following sample Python set script.

import sys
import os
import string

if name == " main ":
# If there are set arguments they will be loaded into
# sys.argv
# Enter the desired set code here. Stdout may be used for
# debugging.
# Uses exitcode 0 for success, and all other values for
# failure.
# enter condition where set script if successful. for this
# example, use ‘if 1/

if 1:
sys.exit (0)

else:
sys.exit (-1)

Other Code for Pluggable Checks

>»

Pluggable checks may also contain code other than the get or set scripts. Libraries,
executables or additional scripts can be added to the check, so their set or get scripts can
utilize these upon execution.

You can also include additional code in the ZIP file.

Zipping Up Pluggable Checks

Pluggable Checks

After you have created the config.xml file, the audit (get) script, and the optional
remediation (set) script, create a ZIP archive containing these files. The following shell history
shows the creation process in a UNIX environment.

# 1s
check name

# cd check name

# zip ../checkname.zip *
adding: config.xml

adding: getcheckname.py
adding: setcheckname.py

# unzip -t ../checkname.zip

testing: config.xml OK
testing: getcheckname.py OK
testing: setcheckname.py OK

No errors detected in compressed data of ../checkname.zip.

149



Importing Pluggable Checks

Import a pluggable check into an SA core or mesh using the OCLI 1.0 utility, which is
documented in the SA Content Utilities Guide. The following shell history provides an
example of the import process for Linux:

# cp checkname.zip /var/tmp/checks
# cd /var/tmp/checks

# cp opsware 32.a.692.0-upload/disk001/packages/Linux/3AS/ocli-32a.2.0.5-
linux-3AS .

# chmod 755 ocli-32a.2.0.5-1inux-3AS

# ./ocli-32a.2.0.5-1inux-3AS

# . ./ocli/login.sh

# export PATH=/opt/opsware/bin:S$SPATH

# oupload -C"Customer Independent" -t"Server Configuration Check" --
forceoverwrite --old -0"SunOS 5.8" your Pluggable check.zip

) The oupload command uses "SunOS 5.8" to specify that the check falls into the generic Unix
category in the SA Client. To specify a check for the Windows category, use "Windows 2003."

Audit Policy Creation

The audit policy creation procedure is illustrated in Figure 27 below:

Figure 27 Audit Policy Creation Procedure
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L

Creating an Audit Policy

Audit policies consist of rules. Each rule consists of one or more checks, which can include the
user-created pluggable check. Audit policies and rules are displayed, created and edited in the
SA Client. Figure 28 shows a list of the audit rules available on a model system.
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Figure 28 List of Audit Rules
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For detailed information on creating an audit policy, see the SA User Guide: Audit and
Compliance.

Exporting the Audit Policy

To move a new audit policy to other SA cores, export it from one and import it to another using
the DCML Exchange Tool (DET) command-line utility. Use this tool to populate a newly-
installed SA core with content, such as policies, from an existing core. For detailed
instructions on this procedure, see the SA Content Utilities Guide.

Document Type Definition (DTD) for config.xml File

Pluggable Checks

This file governs SA Client display names and descriptions, default values, comparisons to be
performed upon values returned by the check code, the category of the SA Client displaying
these values, and more.

Two elements in the default config.xml file, checkGetArguments and checkSetArguments,
are used to pass data values to the scripts at execution time. If your programmable check does
not require any arguments, delete these elements from your config.xml file.

The following DTD for config.xml is dynamically generated by SA:

<!ELEMENT checkConfiguration (checkName,
checkRemediationDefaultDescription?, checkGetScriptName?,
checkGetScriptType?, checkSetScriptName?, checkSetScriptType?, checkVersion,
checkAllowRemediationOnFailure?, checkReturnType, checkTestIDs?,
checkPlatformTypes, checkExclusivePlatforms?, checkExcludePlatforms?,
checkCategories, checkGetArguments?, checkSetArguments?,
checkComparisonDefaults?, checkCompareValidValues?, checkSuccessExitCodes?)>
<!ATTLIST checkConfiguration version CDATA #REQUIRED>

<!ELEMENT checkName (#PCDATA)>

<!ELEMENT checkGUID (#PCDATA)>

<!ELEMENT checkDefaultDescription (#PCDATA)>
<!ELEMENT checkRemediationDefaultDescription
<!ELEMENT checkGetScriptName (#PCDATA) >

checkGUID, checkDefaultDescription,

(#PCDATA) >
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<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT

checkGetScriptType (#PCDATA)>
checkSetScriptName (#PCDATA)>
checkSetScriptType (#PCDATA)>

checkVersion (#PCDATA) >
checkAllowRemediationOnFailure (#PCDATA) >
checkReturnType (#PCDATA)>

checkTestIDs (checkTestID+)>

checkTestID (#PCDATA)>

checkPlatformTypes (checkPlatform+)>
checkPlatform (#PCDATA)>
checkExclusivePlatforms (checkExclusivePlatform+)>
checkExclusivePlatform (#PCDATA) >
checkExcludePlatforms (checkExcludePlatform+)>
checkExcludePlatform (#PCDATA)>
checkCategories (checkCategory+)>
checkCategory (#PCDATA) >

checkGetArguments (checkGetArgument+)>
checkGetArgument (checkGetArgumentType,

checkGetArgumentDefaultLabel, checkGetArgumentDefaultDescription,
checkGetArgumentDefaultValue?, checkGetArgumentValidvalues?)>

<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT

checkGetArgumentType (#PCDATA)>
checkGetArgumentDefaultLabel (#PCDATA)>
checkGetArgumentDefaultDescription (#PCDATA)>
checkGetArgumentDefaultValue (#PCDATA)>
checkGetArgumentValidvValues (checkGetArgumentValidvalue+)>
checkGetArgumentValidvValue (checkGetArgumentValidvalueItem,

checkGetArgumentValidValueDisplayName) >

<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT

checkGetArgumentValidvValueItem (#PCDATA)>
checkGetArgumentValidValueDisplayName (#PCDATA)>
checkSetArguments (checkSetArgument+)>
checkSetArgument (checkSetArgumentType,

checkSetArgumentDefaultLabel, checkSetArgumentDefaultDescription,
checkSetArgumentDefaultValue?, checkSetArgumentValidvalues?)>

<!ATTLIST
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT

checkSetArgument populateFromRule CDATA #IMPLIED>
checkSetArgumentType (#PCDATA)>
checkSetArgumentDefaultLabel (#PCDATA)>
checkSetArgumentDefaultDescription (#PCDATA)>
checkSetArgumentDefaultValue (#PCDATA)>
checkSetArgumentValidvalues (checkSetArgumentValidvalue+)>
checkSetArgumentValidvalue (checkSetArgumentValidvalueItem,

checkSetArgumentValidValueDisplayName) >

<!ELEMENT
<!ELEMENT
<!ELEMENT

checkSetArgumentValidvValueItem (#PCDATA)>
checkSetArgumentValidValueDisplayName (#PCDATA)>
checkComparisonDefaults (checkComparisonDefaultOperator?,

checkComparisonDefaultValues) >

<!ELEMENT
<!ATTLIST
<!ATTLIST
<!ELEMENT
<!ELEMENT

checkComparisonDefaultOperator (#PCDATA)>
checkComparisonDefaultOperator not CDATA #IMPLIED>
checkComparisonDefaultOperator caselnsensitive CDATA #IMPLIED>
checkComparisonDefaultValues (checkComparisonDefaultValue+)>
checkComparisonDefaultValue (checkComparisonDefaultValueltem,

checkComparisonDefaultValueDisplayName) >

<!ELEMENT
<!ELEMENT
<!ELEMENT

checkComparisonDefaultValueltem (#PCDATA)>
checkComparisonDefaultValueDisplayName (#PCDATA) >
checkCompareValidvValues (checkCompareValidvalue+) >
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Pluggable Checks

<!ELEMENT checkCompareValidvalue

(checkCompareValidvalueltem,

checkCompareValidvValueDisplayName) >
<!ELEMENT checkCompareValidvalueItem (#PCDATA)>
<!ELEMENT checkCompareValidValueDisplayName (#PCDATA)>

<!ELEMENT checkSuccessExitCodes

<!ELEMENT checkSuccessExitCode

(checkSuccessExitCode+) >
(checkSuccessExitCodeValue,

checkSuccessExitCodeDefaultDescription,
checkSuccessExitCodeDefaultDisplayName) >

<!ELEMENT checkSuccessExitCodeValue (#PCDATA)>

<!ELEMENT checkSuccessExitCodeDefaultDescription (#PCDATA)>
<!ELEMENT checkSuccessExitCodeDefaultDisplayName (#PCDATA)>

The following table describes the elements of the config.xml DTD.

Table 24 DTD Elements and Attributes

Elements

Attributes

checkConfiguration version

Set to 1.0, only change if the Audit and Remediation
framework requires it.

checkName The English name that displays in the SA Client for
the check/rule.
checkGUID A standard GUID, for example,

9500A4AE-EE9E-4383-87F2-BAD7DDC26C59

can be generated using the “guidgen” Windows
utility, downloaded from a web site, or by other
means.

The GUID MUST be unique or the pluggable check
will fail on upload to core. Once a check is uploaded
with its unique GUID, you MUST NOT change the
GUID or it will fail on re-upload with a "Database
Unique Constraint Error" until you delete the
original. Checks are uniquely identified by GUID,
but for upload are solely identified by their name (of
the zip file).

checkDefaultDescription

Displays in the SA Client description box. Honors
hard carriage returns and HTML. With HTML, the
HTML tags need to be converted with &It; and &gt;.

checkRemediationDefaultDescrip
tion

Displays in the SA Client under the Remediation
section of the check/rule.

checkGetScriptName The file name for the get script, for example,
getUsersWithoutPasswordExpiration.sh.

checkGetScriptType The type of code determines the interpreter to be
run. Get and set scripts may be types: SH, VBS, PY,
BAT.

checkSetScriptName The file name for the remediation script.
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Table 24 DTD Elements and Attributes (cont’d)

Elements Attributes

checkSetScriptType The type of code determines interpreter to be run.
Set (remediation) scripts may be of types SH, VBS,
PY, BA.

checkVersion This is based on SA and framework build number,

such as 32b.0-1.0.

checkAllowRemediationOnFailure

Some scripts may fail during the get phase, but you
may be able to correct this condition via the
remediation script. This allows remediation to be
performed even in the event of a script failure. For
example, if the non-existence of a registry key is
undefined, you can create and set it in your set code.

checkReturnType

Permissible values are EXITCODE, STRING, or
NUMBER:

EXITCODE — Standard script return via
Wseript.Quit(), exit, return, etc.

NUMBER — Audit and Remediation framework will
grab from stdout and interpret it as numeric type.

STRING — Audit and Remediation framework will
grab from stdout and interpret as a string type.

checkTestIDs

List of test IDs.

checkTestID

Used to display the CIS, MSFT, NSA or other Policy
standard nomenclature, for example, CIS-RHEL 8.4.
This is a free form field, and displays in the SA
Client, so be consistent in naming it to correspond
with the TON Content.

checkPlatformTypes

List of valid platform types for a check.

checkPlatform

WINDOWS | UNIX (or both as individual elements)

checkExclusivePlatforms

List of exclusive platforms. Audit and Remediation
currently separates things by Windows or Unix by
default, but real world standards as well as
limitations and/or differences across operating
systems do not make this always desirable. You can
limit Audit and Remediation to any platform
specified by a platform ID retrieved from the spin.

This parameter may refer to one of the supported
operating systems listed in the SA Supported
Platforms documentation.

checkExclusivePlatform

Individual platform ID.

checkExcludePlatforms

List of excluded platforms. If the PlatformType
claims UNIX, you can supply platform IDs to exclude
from the UNIX set (all Linux + all Unixes).

checkExcludePlatform

Individual platform ID
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Table 24 DTD Elements and Attributes (cont’d)

Elements Attributes
checkCategory This is the SA Client Category that a check displays
in. Currently, a check can only display in a single
category. If a category does not exist, it will be
created upon upload. The following standard
categories for existing checks should be used where
possible:
Event Logging
File System
Operating System
Operating System | Domain Controller (sub-category)
Operating System | Network (sub-category)
Registry
Services
Users and Groups
checkGetArgument Specifies parameters to the get script.
(checkGetArgumentType,

checkGetArgumentDefaultlLabel,
checkGetArgumentDefaultDescrip
tion,
checkGetArgumentDefaultValue?,
checkGetArgumentValidValues?) >

checkGetArgumentType

NUMBER | STRING

checkGetArgumentDefaultLabel

SA Client tag next to the input box or drop-down.

checkGetArgumentDefaultDescrip
tion

Hover text with further explanation.

checkGetArgumentDefaultValue

Default value for this get parameters.

checkGetArgumentValidValue
(checkGetArgumentValidvValuelte
m,
checkGetArgumentValidValueDisp
layName

checkGetArgumentValidValueltem (#PCDATA)>

checkGetArgumentValidValueDisplayName
(#PCDATA)>

checkGetArgumentValidValues
(checkGetArgumentValidValue+)

(Optional) Useful for limiting the parameters for
example to 0/disable and 1/enable.
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Table 24 DTD Elements and Attributes (cont’d)

Elements

Attributes

checkSetArguments
(checkSetArgument+)

checkSetArgument (checkSetArgumentType,
checkSetArgumentDefaultLabel,
checkSetArgumentDefaultDescription,
checkSetArgumentDefaultValue?,
checkSetArgumentValidValues?)

setArgument elements are identical to the
GetArguments, but for the remediation/set script if it
exists.

The exception is:

checkSetArgument populateFromRule — the set
parameter default should or should not populate
itself from the rule data, versus if any default values
were supplied in config.xml. Generally, this is always
set to true.

checkSetArgumentType

NUMBER | STRING

checkSetArgumentDefaultLabel

SA Client tag next to the input box or drop-down.

checkSetArgumentDefaultDescrip
tion

Hover text with further explanation.

checkSetArgumentDefaultValue

Default value for this set parameter.

checkSetArgumentValidvValues
(checkSetArgumentValidvValue+)

checkSetArgumentValidValue
(checkSetArgumentvValidvValue
Item,
checkSetArgumentValidValue
DisplayName) >

checkSetArgumentValidValueltem (#PCDATA)>

checkSetArgumentValidValueDisplayName
(#PCDATA)> checkSetArgumentValidValueltem
(#PCDATA)>
checkSetArgumentValidValueDisplayName
(#PCDATA)>

checkSetArgumentValidValue
Item

(Optional) Useful for limiting the parameters for
example to 0/disable and 1/enable.

checkSetArgumentValidvValueDisp
layName

<!ELEMENT
checkComparisonDefaults
(checkComparisonDefaultOperato
r?,
checkComparisonDefaultValues) >

checkComparisonDefaultOperator not — negation of
operator specified, TRUE | FALSE

checkComparisonDefaultOperator caseInsensitive —
only valid for STRING types.

<!ELEMENT
checkComparisonDefaultOperator
(#PCDATA) >

List of default values for comparator. Useful for field
or development outside the TON build framework.

checkComparisonDefaultValues
(checkComparisonDefaultValue+)

checkComparisonDefaultValue
(checkComparisonDefaultValueltem,
checkComparisonDefaultValueDisplayName).
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Table 24 DTD Elements and Attributes (cont’d)

Elements

Attributes

checkComparisonDefaultValuelte

Value for default, passed to code.

checkComparisonDefaultValueDis
playName

Display name for the value, seen in the SA Client.

checkCompareValidvalues
(checkComparevalidvalue+) >
checkComparevalidvalue
(checkComparevValidvValueltem,
checkComparevValidvalueDisplayN
ame) >
checkComparevValidvalueIltem
(#PCDATA) >
checkCompareValidvalueDisplayN

ame (#PCDATA) >

checkSuccessExitCodes
(checkSuccessExitCode+)
checkSuccessExitCode
(checkSuccessExitCodeValue,
checkSuccessExitCodeDefaultDes
cription,
checkSuccessExitCodeDefaultDis
playName) >

For a checkReturnType of EXITCODE, you must
define the valid values for proper script operation,
which generally include both the compliant and non-
compliant expected values. Anything returned other
than a value specified here will be seen as a script
failure, which is shown differently in the SA Client,
as well as in reporting.

checkSuccessExitCodeValue

Value for script completion, for example, 0 (for
disabled typically).

checkSuccessExitCodeDefaultDes
cription

Hover text for the DisplayName/Value.

checkSuccessExitCodeDefaultDis
playName

Value or text shown to user for this value, for
example, Disabled.
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A Search Filter Syntax

Filter Grammar

A search filter is a parameter for methods such as findServerRefs. The expression in a
search filter enables you to get references to SA objects (such as servers and folders) according
to the values of the object attributes. The formal syntax for a search filter follows:

<filter>

<expression-junction>

(<expression-junction>) +

<expression-list-open> <junction>

(<expression>)+ <expression-list-close>

<expression>

<expression-open> <attribute>

<general-delimiter> <operator> <general-delimiter>
<value-list> <expression-close>

<attribute>
<vo_member>
<resource field>
<value-list>
(<number>) *

<text>
<number>

<junction>
<intersect-junction>
<union-junction>
<intersect-junction
<expression-list-open>
<expression-list-close>
<expression-open>
<expression-close>
<general-delimiter>
<whitespace>
<double-gquote>
<escape-character>

<operator>

<resource field>

<text>

<text>

(<double-quote> <text> <double-quote>)* |

<union-junction> |

\|I

\&I

\(\

\)I

\(\ | \{\
\(\ | \}l
<whitespace>
\ \

\Y744

\\I

<equal to> |...| <contains or above>

Valid operators for the preceding line:

<equal to>
<not equal to>
<in>

<not in>

= | ‘EQUAL TO’

“I=/ | <>’ | 'NOT EQUAL TO’
N7 | VIN/

VI=/ | <>’ | WNOT IN/
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<greater than>
<less_than>
<greater than or equal>
<less_than or equal>
<begins with>

<ends with>

<contains>

<not contains>

<in or below>

<in or above>

<between>

<not between>

<not begins_ with>

<not ends with>
<is_today>

<is not_ today>
<within last days>
<within last months>
<within next days>
<within next months>
<not within last days>
<not within last months>
<not within next days>
<not within next months>
<contains or below>
<contains or above>

Usage Notes

V> | ‘GREATER THAN’

< | ‘LESS_THAN’

‘>=/ | ‘GREATER THAN OR EQUAL’
‘<=/ | ‘LESS_THAN OR EQUAL’
‘=x/ | ‘BEGINS WITH’

‘*=/ | ‘ENDS WITH’

“*=*’/ | ‘CONTAINS’

“*<>*7 | ‘NOT CONTAINS’

‘IN OR BELOW’

‘IN OR_ABOVE’

‘BETWEEN’

‘NOT BETWEEN’

‘NOT BEGINS WITH’
‘NOT_ENDS_WITH’

‘IS TODAY’

‘IS NOT TODAY’
‘WITHIN LAST DAYS’
‘WITHIN LAST MONTHS’
‘WITHIN NEXT DAYS’
‘WITHIN NEXT MONTHS’
‘NOT WITHIN LAST DAYS’
‘NOT WITHIN LAST MONTHS’
‘NOT WITHIN NEXT DAYS’
‘NOT WITHIN NEXT MONTHS’
‘CONTAINS OR BELOW’
‘CONTAINS OR ABOVE’

The same junction type must be used within each expression junction:

e valid: ((x =vy) & (a =

e invalid: ((x = y) & (a =

A text value needs to have double-quotes surrounding it but a number does not
quote that is part of the value must be escaped with a backslash:

e valid number: 123.456
e valid text: "abc"

e invalid text: abc

e valid text: "ab\"c"
e invalid text: "ab"c"
e invalid text: ab"c

. Any double-

Parentheses must surround groups of expressions which will junction with another group of

expressions:
e valid grouping: ((x = y)

e invalid grouping: (x = vy)
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B Rebuilding the Apache HTTP Server and PHP

This appendix describes how to rebuild the Apache HTTP server and PHP and replace them
in SA. SA includes an Apache HTTP server and PHP so this appendix is only needed if you
need to use a different version of the Apache HTTP server or if you need to compile extra
libraries or modules into PHP.

SA uses the Apache HTTP server and PHP for web Automation Platform Extensions (APX).
For more information, see Creating Automation Platform Extensions (APX) on page 61.

Extending the APX HTTP Environment

This section describes how you can extend the APX HTTP environment by rebuilding the
Apache HTTP server and PHP.

o You must perform these tasks after all core upgrades.

If you have a Multimaster Mesh, these tasks must be performed on each slice in all cores. For
more information on slice component bundles, see the SA Administration Guide.

Rebuilding PHP

Perform the following tasks to rebuild PHP.
1 Download the PHP source from http://www.php.net/.

2  Put the source in a directory on the server where apxproxy is installed, typically under
/opt/opsware/apxproxy.

3 Enter the following commands, replacing the version number if you downloaded a
different version of PHP.

mkdir /build ; cp php-4.4.8.tar.gz /build; cd /build

gzip -dc php-4.4.8.tar.gz | tar xvf -

cd php-4.4.8

./configure --prefix=/opt/opsware/apxphp
--with-pear=/opt/opsware/apxphp/lib/pear
--with-config-file-path=/opt/opsware/apxphp/lib
--with-apxs2=/opt/opsware/apxhttpd/bin/apxs <any other options you>
make clean

make

4  Backup your old copy of 1ibphp4. so:

cp /opt/opsware/apxhttpd/modules/libphp4.so /opt/opsware/apxhttpd/modules/
libphp4.so.backup

161



5 Copy the new 1ibphp4.so file to the apxhhtps directory:

cp libs/libphp4.so /opt/opsware/apxhttpd/modules/libphp4.so
6 Ensure that the complete reference library exists in the tool.list:

1dd ./libs/libphp4.so

For each entry in the output ensure that the file exists in
/etc/opt/opsware/ogfs/tool.list.

If an entry does not exist, add it.
7 Backup the apxphp folder:

mv /opt/opsware/apxphp /opt/opsware/apxphp.orig
8 Install PHP:

make install

9 Reload and relink the OGFS to make sure anything you added to /etc/opt/opsware/
ogfs/tools.list shows up in the OGFS:

/opt/opsware/ogfs/tools/rewink && /opt/opsware/ogfs/
tools/reload

10 Restart apxproxy:

/etc/opt/opsware/startup/apxproxy restart

Rebuilding Apache

Perform the following tasks to rebuild the Apache HTTP server.
1 Download the source code for the Apache HTTP server from http://httpd.apache.org/.

2  Put the source in a directory on the server that hosts the slice component bundle. For
more information on slice component bundles, see the SA Administration Guide.

3 Enter the following commands, replacing the version number if you downloaded a
different version of httpd.

mkdir /build; cp httpd-2.2.8.tar.gz /build; cd /build
gzip -dc httpd-2.2.8.tar.gz | tar xf -
cd httpd-2.2.8

./configure --prefix=/opt/opsware/apxhttpd <any other options you
want>.

SA currently uses:

-—enable-mods-shared="actions alias auth basic auth digest authn file
authz user cgi deflate dir dumpio env expires headers ident logio
log config mime negotiation rewrite userdir vhost alias imagemap status”

-—disable-dav

-—-with-port=8021
-—-with-expat=builtin
--without-pgsql

(On SunOS only) Enter this command:
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perl -pi -e 's/#define HAVE GETADDRINFO 1/#undef HAVE GETADDRINFO/g' ./
srclib/apr/include/arch/unix/apr private.h

make
4  Make a backup of the apxhttp directory:
mv /opt/opsware/apxhttpd /opt/opsware/apxhttpd.orig
5 Install Apache:
make install
6 Reload and relink the new files into the OGFS:
/opt/opsware/ogfs/tools/rewink && /opt/opsware/ogfs/tools/reload

7 The HTTPD and the .so files in the modules directory may reference external libraries.
These libraries must be visible (or winked in) to the OGF'S.

Log in to the OGFS and run LDD on /opt/opsware/apxhttpd/bin/httpd and any .so
file in /opt/opsware/apxhttpd/modules and ensure that all the files listed there exist in
the OGFS. If they do not, add the files to /etc/opt/opsware/ogfs/tool.list (outside
the OGFS) and then re-run step 6 until all files are available to /opt/opsware/
apxhttpd/bin/httpd.

8 You must now rebuild PHP. See Rebuilding PHP on page 161.

Rebuilding the Apache HTTP Server and PHP 163



164 Chapfer B



Index
A 1S020000, 142
audit, 150
M
B mesh, 150
BAT, 143, 145, 146, 153 o
benchmark, 143, 144
OCLI, 150
C
P
CIS, 143, 154
COM, 143 parameter, 143, 147, 148, 155
passwd, 144

compliance, 142, 143, 144

core, 150, 153 platform, 147, 151, 154

D S
DisplayName, 147, 155, 156, 157 Sarbanes-Oxley (SoX), 142
DTD, 151 SAS Client, 139, 150, 151, 153, 154, 155, 156, 157
services, 142, 155
E shadow file, 144
error checking, 144 shell, 143, 145, 146, 148, 149, 150
exit code, 144, 145, 147 SoX (Sarbane-Oxley), 142
stderr, 144, 148
F Stdout, 149
framework, 143, 144, 153, 154, 156 stdout, 144, 147, 148, 154
string, 147, 148, 149, 154, 155, 156
G SunOS§, 150
globally unique ID number (GUID), 136
GUID, 136, 146, 151, 153 ]
GUID (globally unique ID number), 136 Unix Services, 143
H UrlScan, 143
HP Live Network, 143 V

VBS, 143, 145, 146, 153

! Visual Basic, 143, 146

IIS (Internet Information Services), 143

Information Technology Infrastructure Library w

(ITIL), 142 Windows Registry, 143
Internet Information Services (IIS), 143

165



166



	HP Server Automation
	Platform Developer Guide
	Contents
	1 Overview
	Overview of the Server Automation Platform
	Components of the Server Automation Platform
	Benefits of the SA Platform
	SA Platform API Design
	Supported Clients

	2 SA CLI Methods
	Overview of SA CLI Methods
	OCLI Method Tutorial
	Format Specifiers
	Value Representation
	OCLI Method Parameters and Return Values
	Search Filters and OCLI Methods
	Example Scripts
	Getting Usage Information on OCLI Methods

	3 Python API Access with Pytwist
	Overview of Pytwist
	Setup for Pytwist
	Pytwist Examples
	Pytwist Details

	4 Creating Automation Platform Extensions (APX)
	Creating an APX
	Program APXs
	Web APXs
	APX User Roles
	APX Permissions
	APX Structure
	The apxtool Command
	APX Files
	Showing the Progress of an APX
	Tutorial: Creating a Web Application APX
	Tutorial: Creating a Program APX

	5 Agent Tools
	Introduction to Agent Tools
	Installation Requirements
	Installation
	Upgrading Agent Tools
	Agent Tools Scripts
	Sample Agent Tool Scripts

	6 Microsoft Windows PowerShell/SA Integration
	Introduction to Microsoft Windows PowerShell
	Windows PowerShell Integration with SA
	Integrated PowerShell/SA Cmdlets
	Installation Requirements
	Installation
	Microsoft PowerShell Integration with SA Features
	Sample Sessions

	7 Java RMI Clients
	Overview of Java RMI Clients
	Setup for Java RMI Clients
	Java RMI Example

	8 Web Services Clients
	Overview of Web Services Clients
	Perl Web Services Clients
	C# Web Services Clients

	9 Pluggable Checks
	Overview of Pluggable Checks
	Setup for Pluggable Checks
	Pluggable Check Tutorial
	Overview of Audit and Remediation
	Pluggable Check Creation
	Audit Policy Creation
	Document Type Definition (DTD) for config.xml File

	A Search Filter Syntax
	Filter Grammar
	Usage Notes

	B Rebuilding the Apache HTTP Server and PHP
	Extending the APX HTTP Environment

	Index



